July 2, 1985

Dear Developer,

Enclosed is your copy of the final Software Supplement Update (dated May 1985). The

enclosed documentation includes:

Cover Sheet

About the "May 1985" Software Supplement
Macintosh Technical Documentation Order Form
Switcher (Beta Draft)

A Software Developer's Guide to Switcher

Driver Bug in Pre-Release MacWorks XL

Technical Note #0: About Macintosh Technical Notes
Technical Note #16: MacWorks XL

Technical Note #32: Reserved Resource Types
Macintosh Update for End-Users

Trap List (1 cover page +)

Welcome To MAUG ™

FreeTerm

ResEdit: A Macintosh Resource Editor

AppleTalk Information

AppleTalk Peek

AppleTalk Poke

MacinTalk 1.1

The Writeln Window

Low Memory in Alphabetical Order

Low Memory in Numerical Order

Putting Together A Macintosh Application

The Macintosh Hardware

The Printing Manager

Examples of Printing Manager Usage

Some Words of Wisdom About Using QuickDraw While Printing

The March 1985 ImageWriter: Programmers' Notes

Optimizing Code For The LaserWriter

Future Macintosh Architectures

Finders and Foreign Drives

Life After Font/DA Mover--How To Make Sure Your Desk
Accessory Still Works

SANELIib V1.2

SANE Numeric Scanner and Formatter

DIALOG CREATOR Instructions

Fedit: A File And Disk Editor
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Macintosh REdit: A Macintosh Resource Editor

Revision to Workshop User's Guide for the Lisa
Cover Sheet
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The following documents were distributed with previous Supplement Updates but are still relevant;
they are not enclosed:

Commented Call List

Latest "Post-3.0" Lisa Pascal Compiler Enhancements
Macintosh PasLib Release 0.7

MacWorks XL User Manual

The MacDB Debugger

The MacsBug Debuggers

The thirteen disks enclosed with this Supplement Update are labelled:

Workshop 3.9 Update Disk 1
Workshop 3.9 Update Disk 2
5/85 Workshop Supplement 1
5/85 Workshop Supplement 2
5/85 Workshop Supplement 3
5/85 Examples 1

5/85 Examples 2

5/85 MacStuff 1

5/85 MacStuff 2

5/85 MacStuff 3

5/85 MacStuff 4

5/85 Mac Build Disk
MacWorks XL 3.0

If you have questions about missing or damaged materials (disks or documentation), please contact
our mailing facility at:

Apple Computer Mailing Facility/Milestone Group
467 Saratoga Avenue, Suite 621
San Jose, CA 95129

Customer Service:

(408) 988-6009
9:00 AM - 4:00 P.M.,, Pacific Time
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Future Distributions

This is the final update of the Software Supplement. For the last year we have periodically been
distributing updates to the Supplement to all buyers. Inside Macintosh and the software interfaces
and tools were frequently changing and we wanted everyone to have the most up-to-date versions.
The software in this version of the Supplement corresponds to the final version of Inside
Macintosh. As promised, Supplement purchasers will receive a copy of the final bookstore version
of Inside Macintosh when it is available this Fall.

We may periodically offer new development tools and utilities as products which can be ordered
independently. When new products are available, we will let Supplement buyers know how to
obtain them. In addition, many of these new tools and utilities will be available from MAUG "~ via
Compuserve. Anyone with a modem can use download copies. FreeTerm, a communication
program which will allow you to do so, has been included in this Supplement. More information
on these on-line services is included in the enclosed documents titled Welcome To MAUG

and FreeTerm.
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Disks in the Supplement

The Macintosh Software Supplement is a package of tools, libraries, and examples to help you

develop Macintosh software. This final update to the Supplement consists of the following thirteen
disks:

Workshop 3.9 Update Disk 1 Lisa Workshop 3.0 formatted disks.

Workshop 3.9 Update Disk 2 Update Workshop 3.0 to Workshop 3.9.

5/85 Workshop Supplement 1 Lisa Workshop 2.0 formatted disks;

5/85 Workshop Supplement 2 can be used with any version of the Lisa Workshop.

5/85 Workshop Supplement 3

5/85 Examples 1 Macintosh formatted disks. Contain source text of

5/85 Examples 2 example programs. Need Lisa Workshop to build.

5/85 MacStuff 1 Macintosh formatted disks.

5/85 MacStuff 2 Contain tools, utilities and examples which can be

5/85 MacStuff 3 used on any Macintosh.

5/85 MacStuff 4

5/85 Mac Build Disk Macintosh formatted disk. Contains standard system
software. Should be used when building a software
product disk.

MacWorks XL (version) 3.0 Special format--used on a Lisa or Macintosh XL to

run Macintosh applications.

This package contains new versions of all the above disks; we recommend putting aside any older
versions of the Supplement and using these disks exclusively (if you are using Pascal Workshop
2.0 you will need some files from the February 1985 Supplement disks).
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Documentation Accompanving the Software Supplement

The documents listed below have been included with this Software Supplement update. Those
marked with a ~~ are primarily of interest to Lisa users.

The Cover Sheet lists the documents included with this Supplement and the number of pages in
each. It also lists the disks in this Supplement.

About the "May 1985" Software Supplement, the document you are reading now,
describes the contents of this Software Supplement and how to use the various pieces.

The Macintosh Technical Documentation Order Form should be used to order most
Macintosh technical documentation from our mailing house.

The Switcher (Beta Draft) describes switcher 3.0 (a pre-release version) from a user's
point-of-view. A more complete version of this manual will be available from from MAUG™
(via Compuserve) and from Apple dealers when Switcher is released.

A Software Developer's Guide to Switcher describes the Switcher from an application
writer's point-of-view. Updates to this document will be available from MAUG™ (via
Compuserve).

Driver Bug in Pre-Release MacWorks XL describes a serious bug in MacWorks XL

(which has been corrected in MacWorks XL 3.0) and how an application can patch MacWorks to
avoid problems.

Technical Note #0: About Macintosh Technical Notes describes our Technical Notes

service and how to subscribe. It also lists the Technical Notes which have been published to
date.

Technical Note #16: MacWorks XL describes some features of MacWorks XL. Note that
MacWorks XL version 3.0 has been released since this document was written; see Driver Bug
in Pre-Release MacWorks XL for more information.

Technical Note #32: Reserved Resource Types lists the resource type names reserved
for use by Apple. Refer to this list before naming any custom resource types.

Macintosh Update for End-Users describes Finder 4.1, Choose Printer, the Font/Desk
Accessory Mover and the corresponding System file from a user's point-of-view.

The Trap List is a list of traps including: the trap or routine name as it is described from Pascal,
the trap word, the section in Inside Macintosh where it is discussed, how the routine affects the
heap, and a list of what other traps are called by the routine.

Welcome To MAUG " describes how to use MAUG" ", the user's group on Compuserve
through which future Macintosh development tools and utilities will be distributed.

The FreeTerm document describes FreeTerm, the simple terminal emulator tool which can be
used to access Compuserve.

ResEdit: A Macintosh Resource Editor describes release 0.5 of the Macintosh resource
editor ResEdit.

The AppleTalk Information document contains some important information for anyone

writing an application which uses the AppleTalk network. It contains a questionnaire which such
developers should complete and return to Apple.
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AppleTalk Peek describes the Peek utility which can be used to monitor packet traffic on an
AppleTalk network.

AppleTalk Poke describes the poke utility which can be used to create or edit packets and send
them out on AppleTalk.

MacinTalk 1.1 describes the MacinTalk speech synthesizer which can be used by Macintosh
applications. MacinTalk software is included in this Supplement.

* The Writeln Window describes the unit WritelnWindow which can be used for debugging
Macintosh programs written in Lisa Pascal.

Low Memory in Alphabetical Order lists all the low memory equates in alphabetical order.
Low Memory in Numerical Order lists all the low memory equates in numerical order.

* Putting Together A Macintosh Application describes how to build a Macintosh
application from the Lisa Pascal Workshop. This sixth draft, dated 5/5/85, is the final revision of
this manual. Itis no longer a part of Inside Macintosh.

The Macintosh Hardware is the hardware chapter for Inside Macintosh which has not
previously been released. This second draft is dated 2/13/85.

The Printing Manager is the chapter from Inside Macintosh describing how applications can
print. This second draft, date 3/27/85, is significantly improved from the first draft available
previously.

Examples of Printing Manager Usage provides examples of how an application could call
the printing manager.

Some Words of Wisdom About Using QuickDraw While Printing, as the title
suggests, provides some tips on how to best use QuickDraw when printing.

The March 1985 ImageWriter: Programmers' Notes describes how to print using the
ImageWriter driver released in March 1985 and included on the 5/85 Mac Build Disk.

Optimizing Code For The LaserWriter describes how to make your application better at
printing to the LaserWriter printer.

Future Macintosh Architectures lists a number of guidelines that should help ensure that
your software will continue to run on any future Apple Macintosh hardware. All developers
should read this document; those writing in assembly language should read this document
especially carefully.

Finders and Foreign Drives describes the interaction between Finder 4.1 and non-Apple
disk drives.

Life After Font/DA Mover--How To Make Sure Your Desk Accessory Still
Works describes the Font/Desk Accessory Mover from the point of view of a desk accessory
developer.

* The document SANELIib V1.2 describes how to access SANE (Standard Apple Numeric
Environment) floating point libraries from the Lisa Pascal Workshop 3.9.
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SANE Numeric Scanner and Formatter describes SANE's utility routines for conversion
between Decimal records and ASCII strings and how to use these routines from various
development systems.

DIALOG CREATOR Instructions describes the Dialog Creator tool which can be used to
easily create resource definition files for dialogs and alerts.

Fedit: A File And Disk Editor describes Fedit, a "shareware" utility program which allows
somewhat technical users to access Macintosh disks at a low level.

Macintosh REdit: A Macintosh Resource Editor, a booklet which is wrapped separately,
describes the tools REdit and Localizer, which can be used for modifying applications for
international markets. REdit can also be used as a general purpose resource editor.

* Revision to Workshop User's Guide for the Lisa is also wrapped separately. It
updates sections of the Lisa Workshop 3.0 Users's Guide (note that the Workshop 3.9 Update
materials in this Supplement are more recent than these sections). The sections include a Cover
Sheet, Chapter 2: The File Manager, Chapter 4: The Editor, and the Index.

The following documents were distributed with previous updates to the Software Supplements but
are still relevant. They will only be included in this package if this is the first time you have
received the Software Supplement.

The Commented Call List document can be used as a quick reference to the Pascal Interfaces
for the Macintosh. It lists the Procedure and Function calls for most of the Toolbox and OS
managers (notable exclusions include Quickdraw and the Print Manager) grouped by manager.
Within each manager the calls are ordered from the most frequently used calls to dangerous or
obscure calls. The calls are accompanied by brief usage notes.

* The memo Latest " Post-3.0" Lisa Pascal Compiler Enhancements, dated February 8,
1985, describes the Pascal compiler for Workshop 3.9 which is included in this Supplement. It
includes details on the use of SANE from Pascal. Appendix A is no longer accurate and has been
removed from new copies of the document.

* Macintosh PasLib Release V.0.7 describes the latest PasLib library for use from Lisa
Pascal.

* The MacWorks XL User Manual describes MacWorks XL from a user's perspective. The
information in this manual applies to MacWorks XL and MacWorks XL 3.0

The MacDB Debugger, chapter 6 of the Macintosh 68000 Development Svstem User's
Manual. This describes MacDB, the "two-Mac debugger”.

The MacsBug Debuggers, chapter 7 of the Macintosh 68000 Development System User's

Manual. This describes the MacsBug family of debuggers. Updates to this manual can be found
in the Debuggers section of About the "May 1985" Software Supplement.
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Development Using the Lisa Pascal Workshop

In order to develop Macintosh software using the Lisa Workshop you need a Lisa 2/5 or 2/10 (also
known as Macintosh XL) with at least a full megabyte of RAM, this Supplement, and the Lisa

Pascal Workshop, version 2.0 or 3.0. You must install the Pascal Workshop on a hard disk before
attempting to install the Supplement.

If you want to have both the Lisa Office System and the Workshop with Supplement, you'll find
that one five megabyte ProFile isn't enough. You'll need a Lisa 2/10 (Macintosh XL), a ten
megabyte ProFile, or separate five megabyte ProFiles. Of course, you don't need the Lisa Office
System to do Macintosh development.

Pascal Workshop 2.0 users can continue to use the 2. 0only/ files included in the 2/15/85
Supplement. They can use all files on the Workshop Supplement disks that are not prefixed
with 3.90only/. They cannot use the Workshop 3.9 Update disks. Although developers can
continue to use Workshop 2.0 we strongly recommend upgrading to Workshop 3.0.

Pascal Workshop 3.0 users can update their system to Pascal Workshop 3.9 by performing the
Workshop 3.9 Update procedure described on the following page. They can then use all of the
files on the Workshop Supplement disks (except the few that are prefixed with 2.0only/).

Pascal Workshop 3.0 is compatible with all versions of the Lisa 7/7 Office System and allows the
hard disk to be shared with a MacWorks volume. Other improvements over Workshop 2.0
include:

improved Editor

compiler enhancements

many new Workshop utilities

better performance

hierarchical file system (subdirectories)

improved MacCom and RMaker

improved access to SANE floating point

capability for additional enhancements by installing Workshop 3.9
(you'll need 3.0 to install the 3.9 update,
which is included in this Supplement)

Users of Lisa Pascal 2.0 can receive a new copy of Pascal Workshop 3.0 (the full product, not just
upgrade kit) by sending their original Pascal Workshop 2.0 master disk (Pascal 1) and a check for
$150 (plus local sales tax for California residents) to:

Apple Computer, Inc.

3.0 Upgrade

467 Saratoga Ave. Suite 621
San Jose, CA 95129

(408) 988-6009

You should make a copy of your Pascal 1 disk before sending in the original. Please allow
approximately 4 weeks for delivery.

This upgrade offer expires on August 31, 1985. After that date new copies of the Lisa

Pascal Workshop 3.0 (Apple part #A6D0301) will continue to be available through regular Apple
channels.
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Workshop 3.9 Update Disks

The Workshop 3.9 Update is an update to the Pascal Workshop 3.0 release. It contains the latest,
most up-to-date Workshop tools, including a new "Post-3.0" Pascal compiler with supporting
libraries, the latest SANE libraries, and new versions of the Workshop Shell, the linker, the editor,
the assembler, RMaker, and MacCom. The only Workshop 3.0 users who should not install the

entire update are those who are still using the "Old World" SANE floating point described in the
February Supplement.

The Workshop 3.9 Update consists of two disks, Workshop 3.9 Update Disk 1 and

Workshop 3.9 Update Disk 2. These disks have been formatted using the Lisa Pascal
Workshop version 3.0, so they cannot be read from a Lisa running Workshop 2.0 or from a
Macintosh. However, there is nothing on these disks which is useful to anyone who does not have
Pascal Workshop 3.0. The disks contain the following files:

Files on Lisa Workshop 3.0 disk Workshop 3.9 Undate Disk 1:
Assembler.obj

Code.obj

Editor.obj

I0OSPasLib.obj
IUManager.obj

Linker.obj

Mac.boot

MacCom.obj
StartUpdate.text
tmp/ContinueOrAbort .text
tmp/DoUpdate.text
tmp/GetDisk.text
tmp/YesNoFunc.text

Files on Lisa Workshop 3.0 disk Workshop 3.9 Update Disk 2:
intrfc/SANELib.text

obj/SANELib.obj

obj/SANELibAsm.ob]j

OSErrs.Err

Pascal.obj

PasErrs.Err

RMaker.obj

Shell.Workshop

How to install the Workshop 3.9 Update:

An automatic exec update procedure is provided to facilitate the installation of the new software. It
should work on all configurations of Workshop 3.0, even if Lisa 7/7 is installed on the same disk.
Before starting, make sure that you have at least 1000 blocks free on the hard disk that you will be
updating (this is recommended for any work with the Workshop). If necessary, you may be able
to free up some space by booting from another Workshop profile and Scavenging or booting from
Pascal 3.0 disk 1 and choosing "Repair"). Insert the Workshop 3.9 Update disk 1 (note

that the Workshop will not accept write-protected disks) and then invoke the "startUpdate.text"
exec file by using the run command as follows:

R<-lower-StartUpdate
The update exec files will lead you through the rest of the update procedure (including allowing you

to choose which hard disk to update, prompting you to install Workshop 3.9 Update Disk 2
when necessary, deleting the tmp/ files it uses, and finally asking you to reboot).
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The Workshop Supplement disks (formerly called "MacSupplement"” disks) contain interfaces,
equates, exec files, etc. that can be used with the Lisa Pascal Workshop. Workshop 3.0 users
should update to Workshop 3.9 and reboot before installing the Workshop Supplement disks.

Read through the descriptions of the Workshop Supplement files on the following pages and
choose the files you need. To install the Workshop Supplement disks onto your hard disk, start the
Workshop, then insert each of the disks and use the Backup command to copy the desired files
from the Workshop Supplement disk to the hard disk (note that this will automatically replace all
files with the same names as Supplement files, so you may want to look at the list of files on the
Supplement disks before copying them with Backup). If your hard disk is the default volume, the
following command will copy all the files from the currently inserted 3 1/2" disk to your hard disk:

B-lower-=,$
Note that the Workshop will not accept write-protected disks.

This Supplement supports Workshop versions 2.0 and 3.9. The disks are provided in 2.0 format,
which is readable by both versions. Most of the files provided with the Supplement are usable by
both Workshop versions; the only files which are specific to one of the two versions are prefixed
by "2.0only/" or"3.9only/" . After you copy all desired files use the Rename command to strip
the prefix from the files that have one. The command would look like this:

R2.0only/=,=
or
R3.9%only/=,=

Note that some of these files are replacements for files you already have, so the Backup command
will ask if you want to delete the old ones before renaming. You should answer yes to this
question.

Workshop 3.9 users will not need files prefixed with " 2.0only/" on their hard disk.

Workshop 2.0 users will not need files prefixed with " 3.90only/" on their hard disk (this includes
all files on the 5/85 Workshop Supplement 3 disk).

Workshop 2.0 users should note that they still need the 2.0on1y/ files from the February 1985
Software Supplement. Workshop 3.0 users who are using the "Old World" SANE will also need
some of the " 2.0only/" files found in the February Supplement. New owners of the Supplement
should use Workshop 3.0 (and upgrade to Workshop 3.9).

If you need more room on your hard disk, you can delete some files. Appendix I of the Pascal 3.0
Reference Manual (labelled "Lisa Language" on the spine) lists the files that come with the
Workshop and indicates the purpose of each. Those marked E,F, or G are not needed for
Macintosh development (except for Sys2Lib.0Obj, which is needed to run Preferences). Disks 7, 8
and 9 of Pascal 3.0 are completely optional for Macintosh development. In addition, if you're not
doing any assembly language development, you can delete Assembler.Ob3j and all files which begin
with TLasm/ (however, these are needed to build the assembly portion of some sample programs).

About the "May 1985" Software Supplement Page 9



Contents of the Workshop Supplement disks

Files on Lisa Workshop disk 5/85 Workshop Supplement 1:
intrfc/ABPasIntf.text
intrfc/FixMath.text
intrfc/Graf3D.text
intrfc/MacPrint.text
intrfc/MemTypes.text
intrfc/0SIntf.text
intrfc/PackIntf.text
intrfc/PasLibIntf.text
intrfc/QuickDraw.text
intrfc/QuickDraw2. text
intrfc/SpeechIntf.text
intrfc/ToolIntf.text
intrfc/WritelnWindow.text
obj/ABPasCalls.obj
obj/ABPasIntf.obj
obj/FixAsm.obj
obj/FixMath.obj
obj/Graf3D.obj
obj/Graf3DAsm.obj
obj/MacPrint .obj
obj/MemTypes.obj
ob3j/0SIntf.obj
obj/0OSTraps.obj
obj/PackIntf.obj
obj/PackTraps.obj
obj/PasInit.obj
obj/PasLib.obj
obj/PasLibAsm.obj
obj/PasLibIntf.obj
obj/PrLink.obj
obj/PrScreen.obj
obj/QuickDraw.obj
obj/RTLib.obj
obj/SpeechAsm.ob]
obj/SpeechIntf.obj
obj/ToolIntf.obj
obj/ToolTraps.obj
obj/WritelnWindow.ob]j

The 5/85 Workshop Supplement 1 disk contains many intrfc/ files, which are human
readable text versions of the Pascal interfaces the Macintosh Toolbox, OS, Packages, and
QuickDraw units; and ob3j/ files, which are the object files for the Pascal interfaces (used for
compiling and linking). For more information on these files see the section below titled
Workshop Pascal Interfaces. PasLib and WritelnWindow are discussed in separate
documents.

The intrfc/ and obj/ files (except for WriteinWindow) are part of the Pascal Interface version 1.1
(the February Supplement contained beta versions of the 1.1 interfaces); these are the final
versions, corresponding to the forthcoming published edition of Inside Macintosh.
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Files on Lisa Workshop disk 5/85 Workshop Sunplement 2:
2.0only/Convert/Mac2Lisal.text
2.0only/Convert/Mac2Lisa2.text
2.0only/Convert/TextConvert.obj
3.90only/RMaker7.14a.0bj
ATalk/ABPackage.obj
ATalk/ABPackageR.text
intrfc/WritelnWindow2.text
Serial/Async/Mac.obj
Serial/Async/MacXL.obj
Serial/AsyncR.text
source/RFB.text
TLAsm/ATalkEqu.text
TLAsm/FSEqu.text
TLAsm/HardwareEqu. text
TLAsm/PackMacs.text
TLAsm/PrEqu.text
TLAsm/QuickEqu.text
TLAsm/QuickTraps.text
TLAsm/SaneMacs.text
TLAsm/SysEqu.text
TLAsm/SysErr.text
TLAsm/SysTraps.text
TLAsm/ToolEqu.text
TLAsm/ToolTraps.text

The 5/85 Workshop Supplement 2 disk contains the TLAsm/ files, the version 1.1 equate files
for the Lisa assembler. The TLAsm/ files define macros and symbols for assembly language
programs and are equivalent to the MDS Equate files on the 5/85 MacStuff 4 disk. For more
information, see the Assembiy Equates Information section.

The disk also contains a number of specialized files. The 2.0only/Convert/ files convert
Macintosh text files to Lisa Workshop 2.0 text files (MacCom supports this for 3.0 users). This is
described in the Example Programs and Exec Files section. The file
3.9only/RMaker7.14a.obj is only needed by a few users; see the RMaker section of this
document. The ATalk/ files are described in the document AppleTalk Information, included
with this Supplement. The file intrfc/WritelnWindow2.text contains the source for the
WritelnWindow unit (it should be used with intrfc/WritelnWindow.text). The Serial/ files are
needed to include the latest RAM-based serial driver in a resource definition file (see the
RAM-Based Serial Drivers section of this document and the file serial/aAsyncR.text for
more details). The file source/RFB.text is source code to the Resource File Builder, described in
the Resource File Builder (RFB) section of this document.
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Files on Lisa Workshop disk 5/85 Workshop Supplement 3:
.%9only/convert/Mac2Lisa.text *
.9only/DumpObj.obj
.9only/example/ExampleList.text
.9only/example/Exec.text *
.9only/example/ExecAll.text
.9only/example/ExecAll2.text
.9only/example/Graf3DLink.text
.9only/example/MaxLink.text
.9only/example/MinLink.text
.9only/example/PrintLink.text
.9only/example/SANELink.text
.9only/example/SpeechlLink.text
.9only/example/VanillaExec.text
.9only/example/WritelnLink.text
.%9only/Lisa/SANELib.obj
.%9only/Lisa/SANELib.text
.9only/Lisa/SANELibAsm.obj
.9only/ProcNames.Help.text
.9only/ProcNames.ob]j
.%90only/REdit.obj
.%9only/REdit/Userguide.text
.90only/RFB.obj
.%90only/RFB/exec.text
.9only/RMaker.obj *
.9only/ShowInterface.Help.text
.9only/ShowInterface.obj
.90only/SXref.Assembly.text
.9only/XRef .Help.text
.9only/XRef.obj

WWWWWLwWwWwWwWwWwwwWwWwwwwwwwwwwwwwwwww

* = important; of interest to most developers

The 5/85 Workshop Supplement 3 disk contains files for use with Workshop 3.9. Workshop
2.0 owners should note that they will not need any files from this disk. Users of Workshop 3.9
should strip off the 3.90only/ prefix either when copying the files from the disk (using the file
manager backup command B3. 9only/=,=) or by renaming (with the command R3. 9only/=,= ).
Note that only the files marked with a * will be used by most developers; the others are useful in
certain situations; you may wish to only copy those you have a need for onto your hard disk.

This disk contains the latest versions of the following optional Pascal utilities: DumpObj (v. 3.2),
ProcNames (v4. 31), showInterface (v. 1.5), and xref (v. 4.39). These tools now know how

to handle the latest Pascal syntax and the results of partial links (partial linking is described later in
this document in the Linker subsection of the Workshop 3.9--New Features section).

DumpObj has a new "Entry points only" option. These versions of these tools should only be used
after updating to Workshop 3.9. They replace the optional Workshop utilities of the same name
found on disk 7 of Lisa Pascal Workshop 3.0. The files ProcNames.Help.text,
ShowInterface.Help.text, and XRef.Help.text are provided on this disk for your
convenience.

The file 3.90only/convert /Mac2Lisa.text is an exec file which uses MacCom to convert
Macintosh text files to Lisa Workshop text files. The 3.9only/example/ files are exec files and
inputs to the exec files. See the Example Programs and Exec Files section of this document
for more information about all of these.
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The three 3.00nly/Lisa/ files are only required if you plan to write and execute programs
involving floating point numbers under the Lisa Operating System (not just executing them on the
Macintosh). See the document SANELib V1.2 for more information.

3.90only/Redit .obj is a resource editor that's documented in the file Redit /Userguide.text
(additional resource editors that run on the Macintosh can be found on the 5/85 MacStuff 1
disk).

The files 3.90only/RFB.obj and 3.90only/RFB.exec.text are described in the Resource File
Builder (RFB) section of this document.

The file 3. 9only/RMaker.obj is version 7.14b of RMaker, described in the RMaker section of
this document.

The file 3. 9only/SXref .Assembly.text replaces the file sXxref.Assembly.text found on disk
7 of Lisa Pascal Workshop 3.0. It is used by the Workshop utility SXref (which has not changed)
when formatting assembly language source.

For additional information on using the Supplement with the Pascal Workshop, see the 5/5/85

update to Putting Together a Macintosh Application which is included with this
Supplement.
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Workshop Pascal Interfaces

A new release of the interface files needed for Lisa Pascal development for the Macintosh is
included in this supplement. This release is version 1.1 (the February Supplement contained a
beta-release of version 1.1). Not too many changes have been made since the February release.
These files should be the basis for all future Macintosh development in Pascal.

Text Files

These files are for human consumption. They are the interface portions of the various libraries and
include the relevant constants, types, and routine definitions.

intrfc/ABPasIntf.text
intrfc/FixMath.text

intrfc/Graf3D.text

intrfc/MacPrint .text
intrfc/MemTypes.text

intrfc/0SIntf.text

intrfc/PackIntf.text

intrfc/PaslLibIntf.text

intrfc/QuickDraw.text
intrfc/QuickDraw?2.text
intrfc/SANELib.text
intrfc/SpeechIntf.text

intrfc/ToolIntf.text

intrfc/WritelnWindow.text

intrfc/WritelnWindow2.text

About the "May 1985" Software Supplement

AppleTalk Pascal interface
Fixed point math

Three-dimensional graphics routines layered on top of
QuickDraw. Use with FixMath.

Device independent printing
Common types

Operating system routines (Memory Mgr, File Mgr, Sound
Driver, RAM serial driver, ...)

Packages (Standard File, International, Binary-Decimal
conversion, Disk initialization, ...)

PasLib (non built-in) functions dealing with the heap and Writeln
redirection.

Graphics routines

Implementation stub for QuickDraw

Standard Apple Numerics Environment (IEEE floating point).
MacinTalk (speech synthesis)

ToolBox routines (Menu Mgr, Dialog Mgr, Window Mgr, ...)
Debugging window (not for use in products)

Source to debugging window unit
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Object Fil

These files are either for use by the Pascal compiler (indicated by $USE), in which case they
include the interface definition inside the object file, or for use by the linker (indicated by LINK), in
which case they include the actual code to implement the interface, or for both.

obj/ABPasCalls.obj
obj/ABPasIntf.obj

obj/FixAsm.ob]j

obj/FixMath.obj

obj/Graf3D.obj

obj/Graf3DAsm.ob]

obj/MacPrint.obj
obj/MemTypes.ob]j
obj/0SIntf.obj
obj/0STraps.obj
obj/PackIntf.obj
obj/PackTraps.obj

obj/PasInit.ob]j

obj/PasLib.obj
obj/PasLibAsm.obj
obj/PasLibIntf.obj

obj/Prlink.obj

obj/PrScreen.obj

AppleTalk implementation. LINK only.
AppleTalk definition. $USE only.

Fixed point Math implementation (in assembler). Required for
Graf3D. LINK with this.

Fixed point Math definition. Required for Graf3D. $USE only.

Definition for fixed point implementation of Graf3D (requires
FixMath, does not require SANE). $USE and LINK.

Fixed point implementation of Graf3D (written in assembler).
LINK with this.

MacPrint definition. $USE only.
MemTypes definition. $USE only.
OSIntf definition. $USE only.

OSIntf implementation. LINK with this.
PacklIntf definition. $USE only.

PackIntf implementation. LINK with this.

PasLib initialization implementation of ¢ BEGIN, % END and
$_TERM. LINK with this.

PasLib implementation portion in Pascal. LINK with this.
PasLib implementation portion in assembler. LINK with this.
PasLib definition. $USE only (if directly calling PasLib routines).

MacPrint high-level implementation. LINK with this or
obj/PrScreen, but not both; contains the following routines:
PrClose, PrCloseDoc, PrClosePage, PrCtlCall,

PrDrvrClose, PrDrvrOpen, PrError, PrintDefault,
PrJobDialog, PrJobMerge, PrOpen, PrOpenDoc, PrOpenPage,
PrPicFile, PrSetError, PrStlDialog, and Prvalidate.

MacPrint low-level implementation. LINK with this or
obj/PrLink, but not both; contains the following routines:
PrCtlCall, PrDrvrClose, PrDrvrDCE, PrDrvrOpen,
PrDrvrVers, PrError, PrNoPurge, PrPurge, and PrSetError.
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obj/QuickDraw.obj Quickdraw. $USE and LINK.

obj/RTLib.obj PasLib Run Time support--implementation of console I/O. LINK
with this.

obj/SANELib.obj SANE and Elems definition. $USE only.

obj/SANELibAsm.obj SANE and Elems implementation. LINK with this.

ob3j/SpeechAsm.obj MacinTalk (speech synthesis) implementation (written in
assembler). LINK with this.

ob3j/SpeechIntf.obj MacinTalk (speech synthesis) definition. SUSE only.

obj/ToolIntf.obj Toollntf definition. $USE only.

obj/ToolTraps.obj ToolIntf implementation. LINK with this.

obj/WritelnWindow.obj Debugging window (not for use in products). $USE and LINK.
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ges

The following changes were made to the Pascal interfaces since the February Software Supplement:

1) Version numbers have been added to all files. This release is version 1.1, corresponding to the

2)

3)

4)

5)

6)

7)

8)

final release of Inside Macintosh.

Pascal equate swOverrunErr has been corrected. The file system "PB" calls' async bit is now
read correctly.

New equate ranges have been added to the Pascal interface: evtQWhat through eviQMBut, and
nsDrvErr through lastDskErr.

The implementation of several Pascal routines were changed to make them smaller. These
include InitUtil, GetCaretTime, GetDoubleTime, FlushEvents, SetEventMask, MemError, and
TEScrapHandle. These routines are now declared as INLINE $xxxx, $xxxx; rather declared as
external. Since the old interfaces required two words to call the routine in ToolTraps or

0STraps, all of the code required to implement the routine as well as the jump table entry is
saved.

The implementation of several routines has been rewritten because they did not work correctly.
If you reference any PB calls taking an async parameter, SetSoundVol, GetVRefNum,
SetAppBase or MoveHH it is recommended that you relink your program with the new
ob3j/0STraps.obj.

To use Graf3D from Pascal, $USE obj/Graf3D.obj but link with obj/Graf3DaAsm.obj.

RamSDOpen and RamSDClose have been improved; they now arbitrate the serial ports
correctly.

Calling StartSound asynchronously works better than it did previously.

The format of a few calls has been changed:

9) MoveHHi now returns its error via MemError.

10) The call ScreenRes has been added to return the screen's vertical and horizontal resolution in

dots per inch.

11) Text Edit's filter routines clikLoop and wordBreak are now accessed from Pascal by

SetWordBreak and SetClikLoop.

The purpose of AsmClikLoop was to allow a routine written in Pascal to be called while the mouse
button was down. The Pascal routine had to be called pasClikLoop and the clikLoop field of
the text edit record had to be set to @AsmClikLoop.

With the new setClikLoop routine, the Pascal routine no longer has to be called PasClikLoop.
So where before we would have the statement

hTE~".clikLoop := @AsmClikLoop;
we now have

SetClikLoop (@MyClikLoop, hTE);

where the arbitrarily named routine MyClikLoop replaces PasClikLoop. Note that
AsmClikLoop no longer exists.
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Note to developers using MacApp 0.2:

Recompile UTEView2 . text after changing line 194 of that file from
anHTE~”.clikLoop := @AsmClikLoop;

to
SetClikLoop (@PasClikLoop, anHTE);
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Assembler Eauates

This supplement contains a new release of the equate and macro files needed for assembly language
development for the Macintosh. This release is version 1.1 (the February Supplement contained a

beta-release of version 1.1). Not too many changes have been made since the February release.
The files are provided in both Lisa format (TLAsm files) and Macintosh (MDS, Macintosh 68000
Development System) format. The two sets of files are now completely consistent, the TLAsm
files being mechanically produced from the MDS counterparts. These files should be the basis for

all future Macintosh assembly language development.

The equates and macros are commented somewhat within the files themselves. More detailed
documentation can be found in the appropriate sections of Inside Macintosh.

Equate Files
Lisa Workshop Files

TLAsm/ATalkEqu.text

TLAsm/ FSEqu.text

TLAsm/HardwareEqu.text

TLAsm/PackMacs.text
TLAsm/PrEqu.text
TLAsm/QuickEqu.text
TLAsm/QuickTraps.text
TLAsm/SANEMacs.text
TLAsm/SysEqu.text
TLAsm/SysErr.text
TLAsm/SysTraps.text
TLAsm/ToolEqu.text

TLAsm/ToolTraps.text

MDS Files
ATalkEqu.Txt

FixTraps.Txt

FSEqu.Txt

Graf3D.Txt

HardwareEqu.Txt

MacDefs.Txt

MacTraps.Asm
PackMacs .Txt
PrEqu.Txt
QuickEqu.Txt
QuickTraps.Txt
SANEMacs .Txt
SysEqu.Txt
SysErr.Txt
SysTraps.Txt
ToolEqu.Txt

ToolTraps.Txt

Contents
AppleTalk equates and globals

Fix-point math equates and globals
(see FixMath and Graf3D section)

File system equates and globals

Graf3D (3-D graphics) equates and globals
(see FixMath and Graf3D section)

Hardware equates and globals
(for debugging use only)

Macros translating Lisa Workshop
assembler directives into MDS directives

Creates MacTraps . Sym (MDS symbol file)
Package macros

Printing equates and globals
QuickDraw equates and globals
QuickDraw traps

Numerics macros (see SANE section)
Low-level system equates and globals
System error numbers

Low-level system traps

Toolbox equates and globals

Toolbox traps

The files sysEqu, ToolEqu, and QuickEqu start with an equate such as "wholeSystem" which is
used for conditional assembly. If you do not need the less common equates after " . IF
wholeSystem” you can change wholeSystem to 0 and reduce the time and space required for your
assembly. Note that two MDS symbol files are provided for each of these (€.g. SysEqux.D with
wholeSystem on and sysEqu.D with wholeSystem off).
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Changes to Assembler Equate Files

The following changes to the assembly language equates have been made since the February
Software Supplement:

1)

2)

3)
4)
5)

6)
7

8)

9)

Version numbers have been added to all files. This release is version 1.1, corresponding to the
final release of Inside Macintosh.

The following equates correspond to a pre-release version of the Memory Manager, and were
removed: FOnCheck, fChecking, mFulEmr and memTrbBase. The FGZAlways and
FBGZResrv flags were added, which allow additional control when the standard GrowZone

function is called. GZCritical was obsoleted by the May 1984 system update, so it was
removed.

New equates were added for the fonts: Times, Helvetica, Courier, Symbol, and Taliesin.
New equates have been added for sysPatListID, deskPatID, goodBye, and rdVerify.

Some equates have had minor cosmetic work done on them to make them consistent with the
documentation. These include RestProc, renamed ResumeProc, and MrMacHook , renamed
MBarHook. The equates commandMark, checkMark, diamondMark and appleMark were
moved from menu equates to font equates. PrintVars was renamed PrintErr. SFSaveDisk and
iPrSavPFil were added back into the public domain. The file HardwareEqu was beefed up, but
please use this file for debugging only.

Assembly equates for AppleTalk have been added.

Some duplicate equates were removed. CurrPos, absPos, and relPos were removed because
they duplicated fsAtMark, etc.

All instances of resource system references have been removed. These include: resSysRef,
addRefFailed, rmvRefFailed, AddReference and RmveReference. These equates and traps
are being removed because, to our knowledge, no one has found a use for them. If you are
using these features, contact Macintosh Technical Support immediately.

Otherwise, the corresponding code may be omitted from future systems.

The assembly equates dqEILnth, HasBundle, and invisible have been corrected.

10) To support arbitration of the serial ports, equates for ChooserBits, useExtClk, aPortUsed, and

bPortUsed have been added.

11) The fixed point math, three dimensional graphics, speech synthesis, and floating point string

conversion routines are now available for MDS users.

Application writers may find it useful to note that ApplScratch in TLAsm/ToolEqu is a 12 byte
application scratch area in low memory.
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Workshop 3.9--New Features
Worksh hell (v. 3.9)

The shell has been enhanced to provide better support for hierarchical directories. Subdirectory
support is now very solid. The Copy, Backup, and Transfer commands have been modified to
create any needed subdirectories when a copy spills over onto more than one disk. The size of file
names collected by the shell has been increased to prevent overflowing the file name strings when
long file names with long subdirectory names are used. The Equal command in the File
Manager now prints a summary of its comparisons. Exec files are now run with the three levels
of prefixes rather than just the main prefix, which eliminates the need to put copies of common exec
files in all your subdirectories. The NEWER command in the exec processor now works when
files which do not exist are specified (allowing you to eliminate calls to the EXISTS function
which verified that the arguments to NEWER existed, which should simplify your logic and speed
up your exec files). Files which do not exist are assumed to have a date at the beginning of time
(this does what you want). The NEWER function has also been optimized for speed. You can
now call exec functions from the workshop Run command; the function result will be displayed on
the console when the exec completes.

Pascal Compiler (v. 3.76) and Code Generator (v. 3.65)

A few additional bug fixes have been added to the "Post-3.0" compiler described in the memo titled
Latest " Post-3.0" Lisa Pascal Compiler Enhancements dated Feb. 8, 1985 (included

with the February 1985 Software Supplement). Note that the SANE interface in Appendix A of
that document is out of date (and has been omitted on new copies); see the file
intrfc/SANELib.text on the 5/85 Workshop Supplement disk for the latest interface.

If you are using an exec file other than the new example/exec file provided with this Supplement,
please note the following: If you have Workshop 2.0 you should give the $M+ option to the code
generator. If you have Workshop 3.0 or 3.9 you should give the $M+ option to the Pascal
compiler and/or include it in your source code. If you are using Workshop 2.0 or an old version of
the Workshop 3.0 Pascal compiler, make sure you also give the $X- option to the compiler (this is
optional when using $M+ in the new Workshop 3.9 compiler included in this Supplement).

Linker (v, 0.9.3.1)

This linker supports all the functions necessary for development of Macintosh applications and
drivers.

Using the Lisa Workshop linker, it is possible to "“pre-link" a group of object files into a single
object file for later linking convenience. Partial linking on the Lisa Workshop Linker is limited
since the units being linked may not have any unit globals. To invoke this option, specify:

+R modulename

as an option to the linker. This tells the linker that it will not find a main program in its set of input
files and will cause it to generate a "raw" object file as output. If modulename is specified, then
any procedures which are not called by modulename or anything that it calls will not be included in
the link. Such code is considered to be "dead code" and will be stripped. If modulename is not
specified, then no "dead code" will be stripped.

Once partial linking is done, all the code is collapsed into a single module with many entry points;

since "dead code" stripping is done on a module basis, a library which has been partially
linked will either be included in its entirety or not at all.
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Note that when doing a partial link, the linker expects unresolved external references to be resolved
in a later link; therefore no warnings for unresolved external references are given during partial
links. Rcmember that if you are preparing an object file for RMaker there will be no later link.

Possible uses of partial linking include:

1.  Writing code that will be input to RMaker as a raw object file (e.g. a desk accessory
which must be a DRVR resource) in Pascal called by assembly language.

2.  Building very large programs contained in too many files for the linker to handle.

3.  Reducing link time by partially linking stable modules of an application and later
linking only with changed modules.

If you have Workshop 3.0 or 3.9, please also note that your exec files should always give the +X
option to the linker. This option is required for generating Macintosh code but it wasn't recognized

by some linkers we've distributed in the distant past so you may have removed it from your exec
files.

SANELib (v. 1.2)

SANELIb includes a regular unit called SANE that complements the extended-precision IEEE
Standard arithmetic built into the new Pascal compiler described above. It also includes
compile-time and run-time floating point support for that compiler. SANELIib version 1.2 fixes a
few minor bugs associated with version 0.9 (which was distributed with the February Software
Supplement). For details see the release note titled SANELib V1.2 included with this
Supplement.

MacCom (v. 3.11)

The MacCom.obj file on the Workshop 3.9 Update Disk 1 is MacCom version 3.11. That
version includes support for Macintosh/Lisa shared hard disks. This is provided through the
command AltDevice. The A command can be used to tell Maccom to look on an alternate device
(lower, paraport, upper) for the Macintosh directory. You can then move files to or from the
specified Macintosh directory.

Maccom also supports conversion between Lisa and Macintosh text file formats. The command
Settings displays a second command line:

FinderInfo, RemoveSlashes, Tabs, ConvertText, MatchTypes, Status, Help, Quit
FinderInfo and RemoveSlashes have the same effect as on the main command line (they were left in

the main command line for exec file compatibility). FinderInfo here also allows you to change the
defaults for the Finder type, creator, and bundle bit settings .

The ConvertText command allows for Lisa .TEXT file conversion. It asks you whether to convert
to or from Lisa .TEXT files and what pathname extension (it need not be .TEXT) to use. This
extension will be used to qualify filename searches when converting in either direction.

The Tabs command allows you to remove tabs (Macintosh to Lisa) or compress runs of blanks into
tabs (Lisa to Macintosh) when processing text files with the ConvertText option.

The MatchTypes command allows you to qualify searches on Macintosh filenames by specifying a
list of Finder types.

The Status command displays the current settings. Help displays help. Quit returns to the main
command line.
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RMaker (v. 7.14h)

RMaker is the resource compiler for the Lisa Workshop. The format of RMaker input files
(resource definition files) is described fully in the latest version of Putting Together a
Macintosh Application (dated 5/5/85), which included with this Supplement.

This Supplement contains several versions of RMaker for users of Workshop 3.0 and 3.9.
Running the Workshop 3.9 Update will install RMaker version 7.13b on your hard disk. The file
3.9only/RMaker7.14a.o0bj can be found on the 5/85 Workshop Supplement 2 disk; the file
3.9only/RMaker.obj on the 5/85 Workshop Supplement 3 disk is version 7.14b.

The latest versions are 7.14a and 7.14b. Both support larger resource files than earlier versions.
RMaker version 7.14b will support even larger files than 7.14a, but at the expense of a smaller

limit on the size of an item list (e.g. String Lists, DITLs, Pattern Lists, and Icon Lists). Version 7.14a
will allow item lists which take up to 4K bytes of memory in RMaker; version 7.14b allows lists which take up to 2K bytes (enough

for most applications). We recommend starting with version 7.14b and if the RMaker error "Fatal
error. Data block overflow (item list too large)." is encountered, switching to version
7.14a (which should compile any resource definition files which worked with RMakers distributed
with earlier Supplements).

Other enhancements to all of these versions of RMaker include:
Several bugs have been fixed.
Users may specify a meta-character as part of a menu item's text by repeating the
meta-character twice; i.e., to put a left-parenthesis in a menu item, you should put (( in your
resource definition file.
The processing of CODE resources has been optimized.
RMaker will capitalize any of Apple's "reserved resource type names” (e.g. ALRT, BNDL,

and CODE) as listed in Technical Note #32: Reserved Resource Types (included
with this Supplement) but will leave all other resource type names in their original case.
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Workshop Editor (Editor.obi dated 4/1/85)

The following enhancements have been made to the Workshop Editor:

Prompts: Prompts that require typed input now display default responses. You can get the
default by typing <Return>. Typing <Clear> aborts the prompt.

Markers: The default response to Set Markers is now the first fourteen characters of the
current selection. (Fourteen characters is the maximum length of a marker name). If the
current selection matches the selection for any marker in the file, then that marker is the default
response to Delete Marker.

Find: The default Find... target string is based on the current selection. If Search is
Tokenized then the first token (delimited by spaces) is the default; otherwise, the defaults is the
entire first line of the current selection.

File Menu: The default prompts for the File menu items (e.g. "Save a Copy in...",
"Open...") are based on the current selection.

Configurable Menus & Search Options: When the editor first starts up it reads the file

—#boot-edit .menus .text to get the menu items. Users can edit this file but they should first back
it up--major changes to this file could prevent the editor from functioning.

Changing this file (such as menu tiles and menu items) will take effect the next time the editor
is started after it has been killed (either with the System Manager's Manage Process command
or by exiting the Workshop).

Users who want to add new command-key equivalents to frequently used menus can do so by
appending a menu item name with "/x" for some character x (e.g. "Throw Away Window/T"
will make Apple-T equivalent to the Throw Away Window menu item).

Users who don't want the editor to start in "Search is Tokenized" mode can change the initial
settings of the search options (Tokenized, Case Sensitive, and Wraparound). The editor now
assumes that the search option menu items toggle between "Search is <Option>" and "Search is
Not <Option>"; the presence of "Not" in the menu item name determines the startup
configuration.

Miscellaneous Editor enhancements: Typing Apple-Period aborts printing. Markers are

deleted with Cut (previously they were just hidden, now they are removed from the Marker list).
The next event after cursor movement now works correctly.
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Assembler (v. 3.77):

The following enhancements have been made to to the Lisa Workshop assembler (version 3.77):

1) .SYM symbol files

2) .OUT output redirection

3) .CASEOQUT case-sensitive linker symbols
4) .REF32 Directive

S) .REFAS Directive

1) .SYM files

A mechanism similar to the Macintosh 68000 Development System assembler symbols file
mechanism has been implemented in the Lisa Workshop assembler. This allows you to create a
.SYM file containing the compressed definition of your symbols (i.e. Macintosh system equates)
and then rapidly read these into your assembly.

To create the .SYM file: set up a separate assembly containing all definitions you want to include,
then the dump statement. Format of dump statement is

.DUMP filename

where filename is the name of the .SYM file (SYM is automatically appended). Comments may
occur on this line as well. A typical assembly is

.INCLUDE TLASM/SYSEQU

. INCLUDE TLASM/SYSERR
.INCLUDE TLASM/SYSTRAPS

. INCLUDE TLASM/TOOLEQU
.INCLUDE TLASM/TOOLTRAPS
. DUMP TLASM/EQUATES
.END

This creates the file TLASM/EQUATES . sYM, which is a compressed symbol file containing all the
symbols defined in the listed files. Local labels are not included in the file. Forward references
remain unresolved and should be avoided.

To use the .SYM file: Replace the corresponding definitions with an include of a .SYM file as
follows:

.INCLUDE TLASM/EQUATES.SYM

Note that the format is the same as the include of text files. For this reason, the .SYM suffix must
be included in the name. (If the file is not found, the text file <name>.TEXT will be searched for.)

The effect of INCLUDE ...SYM is to load the symbol table with the symbols previously defined.
The upper/lower case characteristics are as defined at DUMP time. The INCLUDE statement does
not cause checking for duplicate names or backpatching of values.

2) .OUT Output Redirection

The .OUT construct lets you change the assembler's output file between .PROC's or .FUNC's.
This lets you create more than one output file from a single assembly; each file will contain a
linker-legal object format with an integral number of assembly procs. The primary purpose of this
feature is to combine assemblies that have common front ends, reducing assembly time.
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Format:

.QUT "filename"
or

.OUT 'filename'

where filename is the name of the new .OBJ file. The .OBJ suffix is automatically appended when
not supplied. The .OUT command takes effect at the beginning of the next .PROC, .FUNC, or
MAIN, closing the existing output file and opening the new one (overwriting any previous file of
the same name). Note that errors in opening the file may not get reported until the bottom of the
next .PROC, due to the vagaries of the object file mechanism.

An '=' may be used as a wildcard in the file name. It stands for the original output file's volume

and file name without extension. Therefore, if the first output file is -Vvolname - Temp.Obj, the
command

will switch the output to the file -Volname-Temp2.0bj (a handy feature if you want to assemble
to various volumes or subdirectories).

3) .CASEOUT case-sensitive linker symbols

The .CASEOUT directive causes ensuing newly defined symbols to be sent to the linker in their
original case. It does NOT cause case-sensitivity during the assembly. This feature is intended to
be used in linking assemblies to other case-sensitive languages, such as C.

Format:

.CASEQUT
.NOCASEOUT

All symbols that are newly defined after .CASEOUT and up to a NOCASEOUT will be sent in
their original case to the linker. Typically, there is only a .CASEOUT at the beginning of the entire
assembly. Note that CASEOUT applies to all symbols , including procs and funcs, defs and refs,
and so on, although only some of the symbols are actually sent to the linker.

4 & S5) REF32 and .REFAS Directives

The assembler now offers symbolic access to UNIT global data from Workshop Pascal and
EXTERNAL global data from Workshop C. It is now possible to reference data areas generated
by high level languages and rely on the Linker to allocate and resolve the references. However, it
is not possible to create new data areas or to specify initialization values. The assembler supports
symbolic access with the directives . REF32 and . REFAS.

4) REF32 Di .
.REF32 NAMEX,NAMEY,NAMEZ

indicates to the assembler that NAMEX,NAMEY, and NAMEZ are the names of global data areas
that will be based accessed via 32-bit (immediate) addresses. This should not be used with

Workshop Pascal; it should only be of interest to users of Workshop C writing code to be executed
on the Lisa. REF32 does not work in code executed on the Macintosh.
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5) .REFAS Directive
.REFA5 NAMEA, NAMEB, NAMEC

indicates to the assembler that NAMEA, NAMEB, and NAMEC are the names of global data areas

that will be based on register AS. For example, assume the following Pascal Unit interface (and
implementation VARSs):

unit NAMEA;

interface
var

i: integer;

Ll : longint;
procedure PascalAl;
procedure writed;

implementation
var

L2: longint;

One set of definitions to access variables i, L1, and L2 would be:

.REFAS5 NAMEA
i .EQU -2 ; 0 minus sizeof i
L1 .EQU -6 ; start of i minus sizeof L1
L2 .EQU -10 ; start of L1 minus sizeof L2

A more easily maintained set of definitions might be :

.REFAS NAMEA
FIRSTA .EQU 0
i .EQU FIRSTA-2 integer
Ll .EQU i-4 longint
L2 .EQU L1l-4 longint

Notice that Unit variables are allocated in the negative direction from 0. Both INTERFACE and
IMPLEMENTATION variables are accessible, although good programming practice would limit the
references to only the INTERFACE variables.

Instructions to modify the variables i, L1, and L2 might be:

MOVE .W #2,NAMEA+1 = 2;
MOVEQ #22,D0

MOVE .L DO, NAMEA+L1 Ll = 22;
MOVE . W $#222,D0

EXT.L DO

MOVE .L DO, NAMEA+L2 L2 := 222

NOTES: when using symbols that have been declared REFAS, do not attempt to use the ...(AS)
notation. (If you do, error numbers 21 and 72 will be reported by the assembler). The ...(A5)
notation is still used for doing non-relocatable A5 references, e.g. when AS is saved and some other
value is loaded.

REFAS with negative offsets works properly with Workshop Pascal (for code to be executed on the
Macintosh or Lisa); it is not designed to work with Workshop C.
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.REFAS Example Code Fragments

program SAMPLE;
uses {$SU NAMEA.OBJ} NAMEA;

procedure ASMA; External ;

begin
Pascal A;
Writed;
AsmA;
WriteA;
end.

.PROC ASMA
.REFAS5 NAMEA
FIRSTA .EQU 0

i .EQU FIRSTA-2 ; integer
Ll .EQU i-4 ;  longint
12 .EQU L1-4 ; longint

MOVE.W #2,NAMEA+i ;1 =2

MOVEQ #22,DO0
MOVE.L DO,NAMEA+Ll1 ; L1 :=
MOVE.W #222,D0

EXT.L DO

MOVE.L DO,NAMEA+L2 ; L2 =
RTS

END

unit NAMEA;
interface

var i: integer;
Ll: longint;

procedure Pascall;
procedure writed;

implementation
var L2: longint;

procedure PascalA;

begin
i :=1;
L1 := 11;
L2 := 111;
end;

procedure writea;
begin
writeln (° i = “,i:1,” L1 = “,L1:1, °~ L2
end;

Yy L2:1);

end.
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Resource File Builder (REFB)

Introduction

RFB is a Resource File Builder tool for the Lisa Workshop. A version of RFB for Workshop 3.9
can be found in the file 3. 90only/RFB.obj on the 5/85 Workshop Supplement 3 disk. The
source for the RFB tool (including a Workshop 3.9 exec file) can be found in source/RFB.text on
the 5/85 Workshop Supplement 2 disk (see that file for more information). Workshop 2.0

users might be able to modify the source to make it work on their system.

In the course of development of "Please” (Hayes' database management package) for the
Macintosh, it became apparent that a lot of time could be saved by avoiding RMaker resource
compiles as much as possible. Further, as the program grew it was decided that it should be split
into separate files, to allow the user to have only those resources on online disks that were
necessary to perform the desired functions. None of the programs distributed with the Lisa Pascal
Workshop proved sufficient to the task, so Toby Nixon, Software Analyst at Hayes, wrote the
Resource File Builder (RFB) program.

RFB runs on the Lisa. It allows the developer to produce a Macintosh resource file on the Lisa
from one or more other existing resource files. There are several specific advantages gained by
using the program, including:

- Non-CODE resources, such as STR#s, ALRTs, DLOGs, CTRLSs,etc., can be placed in an
RMaker input file and compiled once. A separate RMaker input file can be prepared which
specifies ONLY the CODE resources. After each Link, only the CODE resource file must be

reprocessed by RMaker. RFB combines the two resource files to produce the file that is
MacCom'ed.

- Resources such as FONTSs and PICTs, which are extremely difficult to produce in the
Workshop, can be produced on the Mac (or Lisa under MacWorks), MacCom'ed onto the

Workshop disk, and combined with other resources with RFB to produce the final Mac
resource file.

- RFB allows an application to be easily split into separate resource files, such as a main file,
utility file, and help file. The application running on the Mac can open the auxiliary files
when necessary (usually because the user initiated a function that requires CODE or other
resources from that file) using OpenResFile. The Mac Resource Manager automatically
searches all open resources files, so no special code is needed in the application to find the
resources once the files are open.

- When several programmers or other personnel (such as technical writers working on help
text) are involved in the creation of non-CODE resources, they can separately process their
work through RMaker, and distribute their files to the others. Each would run RFB to
produce the executable version of the program, without having to wait for RMaker to process
all of the other team members' work.

Running RFB

After renaming 3.9only/RFB.obj to RFB.obj, execute RFB by using the Workshop "R" (run)
command. RFB is most often run from an exec file which includes all of the RFB input to produce
the desired output. RFB requests the name of the output file to be produced. It does not check to
see if the file already exists. It does not currently append any default extension, so the entire file
name must be given. If a null entry is made, the program terminates.
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RFB then requests the name of the input resource file to read. The entire file name must be entered.
If the file is not found, an appropriate error message is displayed. If the file is found, it is opened
and the resource map is read into memory. If no entry is made, the output resource file map is

written, and the output file is closed. RFB then returns to allow the specification of another output
file.

RFB then requests the resource type to be copied. If a null entry is made, RFB closes the input file
and requests a new input file name. If "*" is entered, then all resources of all types are copied from
the input file to the output file. Otherwise, the type code entered is search for the the input file map,
and an appropriate error message is displayed if it is not found. If it is found, an entry is made in
the output file map for that type, and processing continues.

If the type specified is CODE, RFB asks if you want to specify code segments by name rather than
number. This is very useful if the program is under active development, with frequent addition and
deletion of code segments. If YES is specified, RFB then asks for the name of the linkmap file
associated with the current input file. The linkmap file is opened and scanned, and the names and
associated numbers of all code segments are tabulated.

After the type is entered, RFB requests the resource ID numbers to copy. If a null entry is made,
RFB returns to request the next type (if no resources have been copied for the type, the type entry
is removed from the output map). If "*" is entered, all resources of the current type are copied to
the output file. If CODE segments are being specified by name, the name is translated to the CODE
resource ID number (segment number) for copying. If the specified resource is already in the
output map, an error message is displayed.

While specifying CODE segments by name, it is still possible to specify by number. When a
CODE segment name is requested, simply enter '#' followed by the number desired. This is
necessary when requesting the jump table (#0) and the blank segment (#1). Resources of type
VERS are handled a special way. When RFB starts, it gets the system date and time. When a
VERS resource is copied, the resource data from the input file is replaced by the 10-byte system
date-time stamp. All VERS resources written during a single run of RFB will have exactly the
same time stamp data. This allows the application at run time to insure that auxiliary files are of the
same version as the main program resource file, by simply doing a byte-by-byte comparision of the
VERS resources in the files.

RFB Limits
RFB is currently limited by static array bounds to:
25 resource types in the output file.
128 references to any one type.
6144 bytes maximum input resource map size.
256 CODE segments in an input link map.

RFB files included on the 5/85 Workshop Supplement 2 and 3 disks:

source/RFB.text Source code for RFB
3.90nly/RFB.obj Object code for RFB
3.9only/RFB/exec.text The procedure file used to build Please on the Macintosh,

included as an example of an RFB exec file.

Questions can be address to Toby Nixon of Hayes Microcomputer Products at (404) 449-8791.
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Example Programs and Exec Files

The files included on the 5/85 Examples 1 and 2 disks are example programs designed for use
with the Lisa Workshop. These disks are in Macintosh format and the files are text-only files, so
anyone with a Macintosh editor or word processor can read the source code (all but the largest can
be read using the File editor example provided on the 5/85 MacStuff 2 disk). However the Lisa
Pascal Workshop is required to compile the examples, most of which are written in Lisa Pascal.

If you plan to read the Examples disks from a Macintosh, note that they have no System folder so
they cannot be used to boot a Macintosh; to use them you must boot another disk first. It may
prove convenient to build disks with a copy of the System Folder from the 5/85 Mac Build

Disk, your editor, and files from the Examples disks that you want to read.

Macintosh 68000 Development Svstem (MDS) users can assemble the DefProc (definition
procedure) files. The INCLUDE statements must be modified, as described in the files. MDS may
return minor wamnings which may be ignored. Additional MDS examples can be found on the
5/85 MacStuff 4 disk.

Workshop exec files are provided to translate the Macintosh text only files to Lisa text files and
copy them from Macintosh disks to a Lisa hard disk. Users who do not wish to copy all the
examples (which require 1640 blocks of disk space) should move selected files onto another
Macintosh disk or modify the exec files appropriately.

Workshop 3.0 or 3.9 users should copy the exec file 3.9only/example/convert /Mac2Lisa.text
from the 5/85 Workshop Supplement 3 disk to their hard disk, stripping off the "3.0only/"
prefix. Invoke the file as follows:

R<convert/Mac2Lisa

The exec file will prompt the user for the two example disks and will invoke MacCom to copy and
convert the files.

Workshop 2.0 users should copy the three 2.0only/ files from the 5/85 Workshop
Supplement 2 disk to their hard disk, stripping off the " 2.0only/" prefix. Then for each
example disk invoke the exec file Convert /Mac2Lisal.text as follows:

R<convert/Mac2Lisal
This exec file takes several minutes to execute because after it copies the files using MacCom it
must translate Macintosh text files to Lisa format (by invoking Convert /Mac2Lisa2.text which
calls the program Convert/TextConvert). If you want to convert just a few files, see the exec files
for more information; better yet, upgrade to Workshop 3.0.

Workshop 2.0 users should note that a few of the example programs will not compile and link on
Workshop 2.0 without modification. These include: 3.90only/example/UNamAcc (requires partial
linking found in Workshop 3.9), 3. 9only/example/Soundlab (requires "Post-3.0 SANE" found
in Workshop 3.9--Workshop 2.0 users should use 2. 0only/example/Soundlab from the February
1985 Software Supplement), skel (contains an optional $USES SANE statement which can be
removed), example/BoxSphere (uses BitSR function found in the Workshop 3.9 compiler), and
Example/Event Tutor (must be renamed without the blank to be used with Workshop 2.0 tools,
and its source contains two uses of the Workshop 3.9 compiler features). The

fragment /AppleTalk.. files also must be renamed without a blank to be read from the Workshop
2.0 editor.
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The example disks contain the following files:

Files on Mac disk 5/85 Examples 1:

Desk Accessory Example Sources 3.9only/example/UNamAcc.text
3.%only/example/UNamAccAsm.text
3.9%only/example/UNamAccR.text
3.9only/example/UNamAccX.text
example/ADeskAcc.text
example/ADeskAccR.text

Application Example Sources 3.9%only/example/SoundLab.text
3.9%only/example/SoundLabR.text
example/Boxes.text
example/BoxesR.text
example/BoxSphere.text
example/BoxSphereR.text
example/Control.text
example/ControlR.text
example/DebugWindow.text
example/DebugWindowR.text
example/Event Tutor.text
example/Event TutorR.text
example/File.text
example/FileAsm.text
example/FileR.text
example/Grow.text
example/GrowR.text
example/Menu.text
example/MenuR.text
example/Modal.text
example/ModalR.text
example/Modall.text
example/ModallR.text
example/Modal2.text
example/Modal2R.text
example/Modeless.text
example/ModelessR.text
example/PicScrap.text
example/PicScrapR.text

Source Fragments fragment/AppleTalk 1l.text
fragment/AppleTalk 2.text
fragment/AppleTalk 3.text
fragment/AppleTalk 4.text
fragment/ZoomRect .text
ImageWriter/ResDef.text
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Files on Mac disk 5/85 Examples 2:
Application Example Sources

DefProc Sources
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example/Print.text
example/PrintR.text
example/QDSample.text
example/QDSampleR.text
example/Samp.text
example/SampR.text
example/Scroll.text
example/ScrollR.text
example/Scroll.C.text
example/SFSample.text
example/SFSampleR.text
example/ShowPaint.text
example/ShowPaintR.text
example/SineGrid.text
example/SineGridR.text
example/Skel.text
example/SkelR.text
example/SpeakFile.text
example/SpeakFileR.text
example/TextEdit.text
example/TextEditR.text
example/Window.text
example/WindowR.text

defProcs/ButCDef.text
defProcs/MDef.text
defProcs/RDocWDef.text
defProcs/SBarCDhef.text
defProcs/Whef.text
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The files on these disks are example programs (how to use controls, windows, dialogs, etc.),
example exec files, definition procedures, and sample desk accessories.

example/ADeskAcc.text

Uriah, a sample desk accessory written in assembly language
example/ADeskAccR.text

this resource definition file explains how to build it
(there is no exec file)
MDS users--see UriahMac.Asm on 5/85 MacStuff 4 instead

example/Boxes.text
example/BoxesR.text

exanmple/BoxSphere.text
example/BoxSphereR.text

example/Control.text
example/ControlR.text

example/DebugWindow.text
example/DebugWindowR. text

example/Event Tutor.text
example/Event TutorR.text

example/File.text
example/FileAsm.text
example/FileR.text

example/Grow.text
example/GrowR.text

example/Menu.text
example/MenuR.text

example/Modal.text
example/ModalR.text

example/Modall.text
example/ModallR.text

example/Modal2.text
example/Modal2R.text

example/Modeless.text
example/ModelessR.text

example/PicScrap.text
example/PicScrapR.text

example/Print.text
example/PrintR.text

example/QDSample.text
example/QDSampleR.text

example/Samp.text
example/SampR.text

example/Scroll.text
example/ScrollR.text

example/SFSample.text
example/SFSampleR.text

example/ShowPaint .text
example/ShowPaintR.text

example/SineGrid.text
example/SineGridR.text

example/Skel.text
example/SkelR.text

a Graf3D example
another Graf3D example
a Control example

a WritelnWindow example

a tool from Dartmouth to teach programmers about
it is worth looking at

events; the resulting application

the File example, a text processor, has lots of stuff in it

an assembly module for File

(note: File has been cleaned up since the Feb. Supplement)

a Window example

a Menu Manager example

a Modal Dialog example

another Modal Dialog example

and another Modal Dialog example

a Modeless Dialog example

an example of how to get pictures from the
scrapbook

a Print Manager Example

a QuickDraw example

the Samp example from Inside Macintosh
a Control Manager example--scrolling

an example which displays a dialog that looks
like Standard File (e.g. SFGetFile)

how to unpack a MacPaint document

another Graf3D example

a skeleton program from Dartmouth-
definitely worth looking at
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example/SoundLab.text a Sound Driver example--uses SANE floating point in
example/SoundLabR.text Pascal Workshop 3.9; may blow up on a Macintosh XL
(better written sound software would not blow up)

example/SpeakFile.text a MacinTalk (speech synthesis) example
example/SpeakFileR.text

example/TextEdit .text a Text Edit example
example/TextEditR.text

example/Window.text a Window Manager example
example/WindowR.text

We have also included an example of how to write a desk accessory in Pascal. It's called UNamAcc.
You need to have the new Workshop 3.9 partial linker to compile and link this.

3.9only/example/UNamAcc. text the Pascal source
3.9only/example/UNamAccAsm. text an assembly language portion
3.9%only/example/UNamAccR.text RMaker source (resource definition file)
3.9only/example/UNamAccX.text the exec file for UNamAcc

There are several exec files for use with these examples on the 5/85 Workshop Supplement 3

disk. These exec files are designed to work with the 3.0 or 3.9 Workshops. If you are still running on
the 2.0 Workshop then use the old 2. 0only/ files. Note that not all of the above Pascal source files
contain the $M+ code generator option; that option must be included in the source and/or the exec file.
We include it in our exec files.

The file 3. 9only/example/Exec.text i a general purpose, semi-smart exec file that checks to see if
the files you give it exist, and whether the files have changed since the last time you compiled or
assembled. It sets the bundle bit in RMaker if (and only if) you give it a creator. To invoke it (after you
rename 3. 9only/= to =) you would type:

R<example/Exec (Pascal file, assembly file, resource file, creator, link file,
source volume)

All of the items in the parentheses are optional. The default file is example/Window. The assembly file
is assumed to be appended by 'Asm', and the resource file is assumed to be appended by 'R, like this:

Pascal Source example/file.text
Assembly source . example/fileAsm.text
RMaker source (resource definition) example/fileR.text

The link file is a file that contains the names of the files needed to link your program with. The
default file name is example/MinLink.

3.9only/example/VanillaExec.text is an exec for those who would rather build without
worrying about the details of whether the file has a creator or what files to link with. It assumes that
the files are named using the conventions described above. It doesn't assemble. It links with
everything. All of the files linked are commented as to when you would need them. It deletes the
Desktop file when you run MacCom and it sets the bundle bit in RMaker whether you have a
creator or not. To run it you enter:

R<example/VanillaExec (filename, creator)

There are also a set of files that allow you to build all of the examples at one time. They compile,

link, make the resource file, and run MacCom to build each example and load it onto a Macintosh
disk. They do not eject the disk until all the applications have been built. They do not work with

the desk accessory examples.

3.9only/example/ExecAll.text this is the main exec--type R<example/ExecAll to run it

3.9only/example/ExecAll2.text This is very much like example/Exec, with some
modifications

3.9only/example/ExampleList .text This file has a list of each example filename, creator, and
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link file if there is one. ExecAll reads this to determine
what to exec.

Note that ExecAll can be invoked with any list of files in the format of ExampleList as follows:

R<example/ExecAll(MyExampleList.text)

There are also a number of LINK files. These contain filesnames that are fed into the linker during
the exec process.

3.9only/example/MinLink.text The minimum of files needed to link.
3.9only/example/MaxLink.text The maximum of files—everythina.
3.9only/example/WritelnLink.text The files needed for the WntelnWindow unit.
3.9%only/example/Graf3DLink.text The files needed for Graf3D.
3.9only/example/PrintLink.text The files needed for printing.
3.9only/example/SANELink.text The files needed for SANE.
3.9only/example/SpeechLink.text The files needed for MacinTalk (speech synthesis).

Other files on the Examples disks include fragment/ files, defProcs/ files,
example/Scroll.C.text and ImageWriter/ResDef.text. The fragment/ files are Lisa Pascal
source fragments; these include the four Pascal AppleTalk example fragments from the final Inside
Macintosh (better examples will appear in a future Technical Note) and a code fragment which
draws the "zooming" rectangles which the Finder uses when opening and closing windows. The
defProcs/ files are the assembly language definition procedures for the standard buttons, menus,
scroll bars, windows, and round-cornered windows, included here in case you need to write your
own custom definitions. The file example/Scroll.cC.text is the Pascal program
example/Scroll.text rewritten in a vanilla version of the language C (it may need modification
before it can be compiled with a particular C compiler). The file ImageWriter/ResDef .text is the
resource definition file fragment described in the enclosed document titled The March 1985
ImageWriter: Programmers' Notes.
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MacWorks™ XT,

The MacWorks XL 3.0 disk allows you start up any Macintosh XL or Lisa 2 system so it will
run Macintosh software. The MacWorks XL disk included in the Supplement is version 3.0, the
new version which Apple is releasing in July 1985. Any disks you received earlier may be
pre-releases; make sure you test your software with version 3.0. Version 3.0 can be recognized
because while it is being booted it displays the following:

MACWORKS XL 3.0
COPYRIGHT 1985 - APPLE COMPUTER

MacWorks XL 3.0 allows direct startup from the hard disk and fixes numerous bugs that occurred
with older versions of MacWorks. Version 2.0 of the Hard Disk Install tool (included in the
Supplement) will allow you to format all or part of a built-in hard disk or one connected to the
built-in parallel port. If you run Hard Disk Install and copy System and Finder to the hard disk,
MacWorks will look for the hard disk automatically after starting up from the MacWorks disk. If
you format your hard disk as a MacWorks-only disk (by choosing the "Don't Share" button) Hard
Disk Install 2.0 will allow you to install or update MacWorks on your hard disk so that you can
boot MacWorks without using any diskettes. To force MacWorks XL to start from a Macintosh

3 1/2" disk, hold down the Option key while you start your machine with MacWorks. Hard Disk
Install and Parallel Printer Install can be found in the MacXL Tools folder on the 5/85
MacStuff 3 disk. For more information see the MacWorks XL User Manual and the

enclosed documents Technical Note #16 : MacWorks XL and Driver Bug in

Pre-Release MacWorks XL..
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Mac Build Disk

The Macintosh-formatted 5/85 Mac Build Disk contains the System Folder that you should ship
with your application. That folder contains the system file, the Finder (version 4.1), the
ImageWriter driver, the Note Pad File, the Scrapbook File,and the Clipboard File. The first
four of these are identical to the files on the 5/85 System Update Disk. The first three contain
proprietary information and may not be distributed without specific written permission of Apple
Computer, Inc. Licenses which permit distributing any or all of these are available for $50
annually. Contact Apple's Software Licensing Department at (408) 973-4667 for more
information.

This System file on this disk contains new printing software glue and a desk accessory called
Choose Printer (version 1.3). These make it easy for users to choose which port (printer or
modem) and printer (e.g. ImageWriter or LaserWriter) to use for printing. It will only display
printers for which there is a print driver file on the startup disk; in addition, for printers connected
over AppleTalk (e.g. LaserWriter) it will only display printers actually on the network.

This System file also contains new versions of Package 3 (Standard File), Package 4 (SANE
Floating Point Numerics), and Package 5 (Transcendental Functions). Changes enhance

performance and fix bugs (e.g. Package 5 no longer leaves itself locked) but will not affect
applications.

The System version string (STR resource 0) has been changed to "Version 2.0 08-Apr-85".

The System file contains the following desk accessories: Alarm Clock, Calculator, Choose Printer,
Control Panel, Key Caps, Note Pad, Puzzle, and Scrapbook. It also contains the following fonts:
Chicago 12, Geneva 9, Geneva 12, and Monaco 9 (the minimum set of fonts required to run
Macintosh software) and Monaco 12, New York 9, and New York 12. The above license entitles
you to include other Apple fonts in your System file. Fonts and desk accessories can be added to
or removed from the System file by use of the Font/Desk Accessory Mover (Font /DA Mover,
which can be found on the 5/85 MacStuff 3 disk).

Note that the Mac Build Disk no longer includes an empty folder. Finder 4.1 has a New Folder
menu item which allows users to create an empty folder when desired. You may still include an
empty folder on your disk.

Also note that users could recreate the Note Pad File and Scrapbook File using the desk
accessories provided. The clipboard File can be created by applications or desk accessories.
However, if no version of these files is distributed in the System Folder then the files will be
created on the disk but not stored in any folder.

Directorv of Macintosh formatted disk §/85 Mac Build Disk

System Folder System 80K Mon, Apr 8, 1985
Finder 47K Mon, Apr 8, 1985
Imagewriter 25K Wed, Mar 6, 1985
Note Pad File 2K Sat, Apr 21, 1984
Scrapbook File 1K Tue, Apr 16, 1985
Clipboard File OK Wed, 2Apr 10, 1985
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MacStuff Disks

The four Macintosh-formatted MacStuff disks contain various examples and tools that you can use
on a Macintosh. Many of the files on the MacStuff disks have notes in their "Get Info" boxes
which you can display by choosing Get Info from the Finder's File menu. Note that none of these
disks contain the Finder (Finder 4.1 can be found on the 5/85 Mac Build Disk). MacStuff
disks 1, 2, and 3 have a MiniFinder (described in the Macintosh Update for End-Users
document) and a System file which has been stripped of most fonts and desk accessories.
Applications can be launched from the MiniFinder using the Open and Open Other buttons. The
5/85 MacStuff 4 disk cannot be used to boot a Macintosh; to use it you must boot another disk
first. It may prove convenient to build disks with a copy of the system Folder from the 5/85
Mac Build Disk and copies of the files from the MacStuff and Examples disks that you use
frequently.

Files on Mac disk 5/85 MacStuff 1.

System Folder System
MiniFinder
Imagewriter

Tools ResEdit
REdit
Localizer
Dialog Creator
EXAMPLE
FreeTerm 1.6
Boot Configure
Screen Maker
DivJoin
Printer

The 5/85 MacStuff 1 disk contains a number of tools and utilities of interest to Macintosh
developers. Icons for all of these are displayed in the MiniFinder. Additional tools can be found
on MacStuff disks 2 and 3.

ResEdit.REdit. and Dialog Creator are various flavors of resource editors. With these programs
you can create and modify all kinds of resources including window templates, menus, dialogs,
alerts, fonts, icons, bundles, and many more. ResEdit was written for programmers and provides
many ways to modify resources The Supplement contains ResEdit version 0.5 (this is a pre-release
version, which means that you should use it with caution; back up a disk before attempting to
modify it); a later version should be available from MAUG ~ (via Compuserve) by the time you
read this. REdit was written primarily for translators so not all modifications are allowed;
however, it is very easy to use for certain modifications (e.g. changing the contents and size of a
dialog box). Dialog Creator is useful when creating or editing RMaker resource definition
functions for dialog and alert boxes. ResEdit is described in ResEdit: A Macintosh Resource
Editor. ReEdit and Localizer are described in the booklet Macintosh REdit: A Macintosh

Resource Editor. pialog Creator and its example file EXaMPLE are described in DIALOG
CREATOR Instructions.

FreeTerm 1.6 is a terminal emulator which, with a modem, will allow you to access services such
as Compuserve (which hosts the users group MAUG 7). It is described in the FreeTerm
document. Note that FreeTerm 1.6 does not work correctly on pre-release versions of MacWorks
XL; it will run on MacWorks XL 3.0 (which is included with this Supplement) but you may be
forced to reboot to select a new serial port. FreeTerm 1.7 should work well on all version of
MacWorks and should be available from MAUG ™ (via Compuserve) by the time you read this.

BootConfigure allows you to display and set the contents of boot blocks on a 3 1/2" disk.
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ScreenMaker converts the top left corer of a MacPaint document to a screen image (for use as a
start up screen--a file named StartupScreen will be displayed when a disk is booted).

Printer is an old application which can be used to print files which have been spooled to disk or to
set up the environment for printing in some other application.

DivJoin is a new application which allows you to divide a file that is larger than a diskette in size
so that it can be moved from a hard disk onto multiple 3 1/2" diskettes. IT ONLY DIVIDES
THE DATA FORK OF THE FILE. For example, if you have large text-only files on a hard
disk, DivJoin can be used for moving them to other hard disks or backing them up onto diskettes.

To use DivJoin, open the file using the Open item in the File menu. This will bring up a window
for that file. Select Divide this File from the Div/Join menu. DivJoin will then take your
original file and divide it into sub-files, each the size of a diskette. If the original file is named foo,
it will divide the original file into sub-files named 1.foo, 2.foo, 3.foo, etc. It will create as
many sub-files as needed When DivJoin is finished dividing the file the window will disappear.

Take each sub-file and put it on a diskette. The last sub-file will probably be smaller than a full
diskette. Later, when you want to recreate the original file, place all of the sub-files on the same
hard disk volume. Start up DivJoin and Open 1.foo. Choose Join this File from the Div/Join
menu. DivJoin will create the file foo on the same volume. DivJoin does not support
automatically feeding in diskettes for copying.

Tools Which Have Been Removed

Some old tools which were included in previous Supplements have been omitted. They have been
replaced by more reliable tools which are also more functional. The tools which were removed
include: Resource Mover and IconEditor (replaced by ResEdit), Alert/Dialog Editor (replaced
by REdit;Dialog Creator or ResEdit could also be used), and Examine File, Set File, and Hex
Dump (replaced by FEdit on the 5/85 MacStuff 2 disk).
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Files on Mac disk 5/85 MacStuff 2:

System Folder System
MiniFinder
Imagewriter

Executable Examples Boxes
BoxSphere
Control
DebugWindow
Event Tutor
File
Instructions
More Info
Grow
Life
Menu
Modal
Modall
Modalz2
Modeless
PicScrap
Print
QDSample
Samp
Scroll
SFSample
SineGrid
ShowPaint
MacPic
Skel
Bone
SoundLab
TextEdit
Window

Disk Tools Fedit
Disk Utility

Switcher Folder Switcher 3.0

MacDB & Nubs MacDB
MacNub A
MacNub B
WorksNub

The 5/85 MacStuff 2 disk has a folder of Executable Examples which are the result of building
the example programs found on the 5/85 Examples 1 and 2 disks. The MiniFinder displays
icons for a selection of these examples including Event Tutor, which is designed to help
programmers to understand Macintosh events, and File, asimple text editor that can read multiple
text files of up to 32K characters. Instructions and More Info are two File-readable text files
which describe File; other data files for the examples which are found in the folder include MacPic
(a MacPaint picture used by the SshowPaint tool), and Bone (an empty data file for skel). The
Executable Examples folder also contains the game Life (the source for which is not distributed).
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The pisk Tools folder contains Disk Utilitv. an old tool that allows operations on 3 1/2" disks
(it may not always work when running from a write protected disk), and Fedit. a file and disk edit
utility program for the Macintosh patterned after the ZAP type programs available on many
systems. Fedit is a powerful utility for use by average to highly technical users. It is not intended
for the uninitiated user. The program allows the user low level, direct access to several types of
disk volumes for both reading and updating. More information can be found in Fedit: A File
and Disk Editor. Unlike most other programs on the Software Supplement, Fedit was not
developed at Apple, but is shareware. If you find this program useful, we ask that you pay for it as
requested by the author on the first screen of the program and on page 2 of its documentation.

The switcher Folder contains Switcher 3.0, described in Switcher (B8eta Draft) and A
Software Developer's Guide to Switcher. Later versions of Switcher will be available from
MAUG " (via Compuserve) and, when released, through Apple dealers.

The MacDB & Nubs folder contains the latest version of the two-Macintosh debugger described in

the chapter The MacDB Debugger distributed with a previous Software Supplement. For more
information see that document or the Debuggers section of this document.
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Files on Mac disk 5/885 MacStuff 3:

System Folder

AppleTalk Tools

MacXL Tools

MacinTalk V1.1

Font Stuff

System
MiniFinder

Peek
Installer
Poke

Poke Packets

Hard Disk Install
Parallel Printer Install

MacinTalk
ExceptionEdit
SpeechlLab
SpeakFile
TextToSpeak

Font /DA Mover
Fonts

The 5/85 MacStuff 3 disk has a System file with AppleTalk installed, to support the AppleTalk
Poke tool. The AppleTalk Tools folder contains the tools Peek, Installer, and Poke and the Poke
data file Poke Packets. For more information please refer to the enclosed documents AppleTalk

Information, AppleTalk Peek, and AppleTalk Poke.

The MacXL Tools folder contains utilities that can be run under MacWorks X1L.. These utilities are
described in the MacWorks XL User Manual (distributed with the February 1985 Supplement
Update) and the MacWorks XL section of this document.

The MacinTalk V1.1 folder contains the MacinTalk driver file, the tools ExceptionEdit and
SpeechLab, and the executable version of the example program speakFile with its data file
TextToSpeak. MacinTalk is speech synthesis software for the Macintosh. For more information

see the enclosed document titled MacinTalk 1.1.

The Font stuff folder contains Font /DA Mover, the Font/Desk Accessory Mover tool, and Fonts,
a corresponding data file; these can also be found on the May 1985 System Disk. The Font/Da
Mover is described in the enclosed Macintosh Update for End-Users document.
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Files on Mac disk 5/88 MacStuff 4:
MDS Stuff
.D Files

Trap Files

Equ Files

.Rel Files

Graf3D Example

UriahMac Desk Accessory Example

Resource Files

About the "May 1985" Software Supplement

FSEqu.D
Graf3D.D
MacTraps.D
QuickEqu.D
QuickEquX.D
SysEqu.D
SysEquX.D
ToolEqu.D
ToolEquX.D

FixTraps.Txt
MacTraps.Asm
QuickTraps.Txt
SysTraps.Txt
ToolTraps.Txt

ATalkEqu.Txt
FSEqu.Txt
Graf3D.Txt
HardwareEqu.Txt
MacDefs.Txt
PackMacs.Txt
PrEqu.Txt
QuickEqu.Txt
SANEMacs.Txt
SysEqu.Txt
SysErr.Txt
ToolEqu.Txt

FixMath.Rel
Graf3D.Rel
PrLink.Rel
SpeechAsm.Rel
DEC2STR.Rel
STR2DEC.Rel
SDOpen.Rel

BoxSphere.Asm
BoxSphere.Job
BoxSphere
BoxSphere.Link
BoxSphere.Rel

UriahMac.Asm
UriahMac.R
UriahMac.Link
UriahMac

SERD
ATalk/ABPackage
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MacsBug Folder Midibug
Maxbug
MacXLbug
TermbugA
TermbugB

Font file Taliesin Font

Desk Accessory Examples User Name Acc
ADeskAcc (Uriah)

The 5/85 MacStuff 4 disk has no System Folder (so that it could include a large number of
files). Therefore it is not a bootable disk; to use it you must boot another disk first.

That disk contains a number of files of interest to users of the Macintosh 68000 Development
System (MDS); some are also of use to developers using other compilers with the MDS linker.
These files for MDS are organized in six folders which are contained in the Mps stuff folder.

The .p Files, Trap Files, and Equ Files folders correspond to the folders of the same name
on the MDS2 disk (part of the MDS product). The folders on the 5/85 MacStuff 4 disk have
the latest (version 1.1) assembly language equates (including ATalkEqu.Txt for AppleTalk),
corresponding to the TLAsm/ files on the 5/85 Workshop Supplement 2 disk. See the
Assembler Equates section of this document and the Macintosh 68000 Development

System User's Manual for more information.

The .Rel Files folder contains assembled .Rel files which can be linked with the MDS linker.
Many of these files provide access to functions previously available only from the Lisa Workshop.

The files FixMath.Rel and Gra£3D.Rel support fixed point math and three-dimensional
Quickdraw graphics; they are described in the FixMath and Graf3D section of this
document.

The file PrLink.Rel contains the implementation of the high level printing routines; see the
Object Files subsection of the Workshop Pascal Interfaces section of this
document for more detailed information on PrLink.

The file speechAsm.Rel is the interface to the MacinTalk speech synthesis driver described
in the document MacinTalk 1.1.

The files DEC2STR .Rel and STR2DEC.Rel are the numeric formatter and scanner (for
conversion between decimal records and ASCII strings) described in the enclosed SANE
Numeric Scanner and Formatter document.

The file sDOpen.Rel contains the routines RAMSDOpen and RAMSDClose described in
the RAM-Based Serial Drivers section of this document.

The Graf3D Example folder contains BoxSphere, an example program written with MDS which
uses the Graf3D (three-dimensional graphics) routines. See the FixMath and Graf3D section of
this document for more information.

The UriahMac Desk Accessory Example folder contains source to Uriah, the example desk
accessory, slightly modified to assemble with MDS on a Macintosh (the original Lisa assembler
source can be found in the file example/ADeskAcc.text on the 5/85 Examples 1 disk).
UriahMac, the file containing the resulting desk accessory, can be installed in a System file with the
Font /DA Mover on the 5/85 MacStuff 3 disk.
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The Resource Files folder contains two files containing resources which can be moved into an
application's resource file using ResEdit. The resource file SERD is described in the RAM-Based
Serial Drivers section of this document. The resource file ATalk/ABPackage is described in the
enclosed AppleTalk Information document.

The debuggers in the MacsBug Folder are documented briefly in their Get Info boxes and
extensively in the Debuggers section of this document and the chapter The MacsBug
Debuggers distributed with an earlier Supplement.

The Font File folder contains the new Taliesin Font, a pictoral font which appeared on the May
1985 System Update disk. It can be installed in a System file with the Font/DA Mover.

The Desk Accessory Examples folder contains the desk accessories produced from the two desk
accessory examples whose source code appeared on the 5/85 Examples 1 disk. They can also
be installed in a System file with the Font/DA Mover.
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FixMath and Graf3D

The Graf3D unit simulates three-dimensional graphics by making calls to QuickDraw. It can now
be used from the Lisa Workshop, MDS, and other languages on the Macintosh which use the
MBDS linker. The version provided in this supplement uses fixed point arithmetic (which is smaller
and faster than the floating point arithmetic used in some very old versions of Graf3D).

Programs written in Lisa Pascal using Graf3D must $USE obj/FixMath and obj/Graf3D; they must
link with obj/FixAsmand obj/Graf3DAsm (note that the files to link with are different than with the
February Supplement). The file 3.9only/example/Graf3DLink.text on the 5/85 Workshop
Supplement 3 disk contains the file names needed for this link.

Three Lisa Pascal example programs which use Graf3D are provided on the disks 5/85

Examples 1 and 2: Boxes, BoxSphere, and sineGrid. Executable versions of these programs
appear on the 5/85 MacStuff 2 disk.

Graf3D programs written on the Macintosh using MDS must Include FixTraps . Txt and
Graf3D.Txt and be linked with FixMath.Rel and Graf3D.Rel. FixTraps.Txt is in the Trap
Files folder, Graf3D.Txt is in the Equ Files folder, and FixMath.Rel and Graf3D.Rel are in the
.Rel Files folder. BoxSphere.Asm, an assembly language version of the BoxSphere example, can
be found in the Graf3D Example folder. That folder contains all the files needed to build the
example using MDS as well as the resulting executable application. All of these folders are
contained in the MDs stuff folder on the 5/85 MacStuff 4 disk.

SANE

SANE, the Standard Apple Numeric Environment, is embodied on the Macintosh in the
Floating-Point Arithmetic Package (pack 4) and the Transcendental Functions Package (pack 5).
These provide facilities for extended-precision floating-point arithmetic and advanced numerical
applications programming. SANE is designed in strict accordance with IEEE Standard 754 for
Binary Floating-Point Arithmetic.

Users of Lisa Pascal should not need to make calls to SANE directly; the SANELib V1.2
document describes how the Workshop 3.9 Pascal compiler interacts with SANE.

To define the macros used by SANE, assembly language programmers must Include the file
TLAsm/SANEMacs . text for the Lisa Workshop assembler or saNEMacs . Txt for the MDS assembler.

If you are using assembly language or a language without built-in support for SANE, you'll need
to be familiar with the Apple Numerics Manual. This is the standard reference guide to SANE, and
describes in detail how to call the Floating-Point Arithmetic and Transcendental Functions routines
from assembly language. The Apple Numerics Manual is included in the Promotional ("phone
book") Edition of Inside Macintosh and also in Apple // Assemblv I.anguage SANE (Apple product
#A2W-0015).

Dec2Str and Str2Dec, SANE's numeric formatter and scanner (for conversion between decimal
records and ASCII strings), are described in the enclosed SANE Numeric Scanner and
Formatter document.
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RAM-Based Serial Drivers

For those who need the extra functionality of the RAM Serial Driver, the following two routines are
supplied in intrfc/0sInt £ (corresponding to obj/0SIntf and obj/OSTraps) :

Function RAMSDOpen(whichport: SPortSel):OSErr;
Procedure RAMSDClose(whichport: SPortSel);

where SPortSel=(SPortA,SPortB)

These interfaces have not changed since the February 1985 Software Supplement, but the routines'
implementations have been improved so that they now arbitrate serial ports (e.g. to prevent a conflict
with AppleTalk). You should recompile any programs which use these calls.

The RAM Serial Driver can now be used from Lisa Pascal or assembler or the Macintosh 68000
Development System (MDS) assembler. When developing using the Lisa Workshop, copy the
serial/ files from the 5/85 MacSupplement 2 disk and move the text of serial/AsyncR.text
into your resource definition file. When developing on a Macintosh using the MDS linker, link with
sDOpen .Rel (on the 5/85 MacStuff 4 disk in the .Rel Files folder) and move the two SERD
resources from the seRrb file (on the 5/85 MacStuff 4 disk in the Resource Files folder) into your
resource file (using the MDS RMaker or a resource editor).

Assembly language programmers should use the following code to bring in the RAM Serial Driver:

SPORTA EQU $0000 ;".EQU" for Lisa assembler
SPORTB EQU $0100
XREF RAMSDOpen ; ".REF" for Lisa assembler
CLR.W -(SP) ; reserve space for function result
MOVE.W #SPORTB,-(SP) ; to select port B
; (use #SPORTA for port A)
JSR RAMSDOpen
MOVEW (SP)+, DO ; get the function result

Use the following code to close the driver:
XREF RAMSDClose ; ".REF" for Lisa assembler

MOVE.W #SPORTB,-(SP)
JSR RAMSDClose

RAMSDOpen loads and installs the Mac or MacXL RAM serial driver (resource type SERD, ID=1
for Mac, ID=2 for MacXL) if the system driver is version 0. The driver is then opened for both input
and output. RAMSDClose must be called before the program ends to remove the RAM driver.

Possible errors from RAMSDOpen include:

-21...-23 - device manager error

-97 PortInUse - some other driver is currently using this port
-98 PortNotCf - parameter RAM is set for some other type use
-192 ResNotFound - appropriate SERD resource not found

-108 MemFullErr - not enough memory to load driver
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Debuggers

MacsBug Debuggers

The MacsBug Folder contains five new versions of MacsBug (named Midibug, Maxbug,
MacXLbug, Termbugh, and TermbugB). To use one of them, make a copy, rename it MacsBug,
and reboot. Basic information about the MacsBug family of debuggers can be found in chapter 7

of the Macintosh 68000 Development System Users's Manual titled The MacsBug Debuggers
which was distributed with an earlier Software Supplement. The information below describes
changes to the debuggers since that manual was written.

* LisaBug is now called MacXLbug.

* xMacsbug is now called Midibug.

* MacXLbug (formerly LisaBug) is usable. No more bombing on mouse movement, etc. You can
even interrupt during AT and HS commands .

* There are two new commands:
EA -- Exit to application...re-launch the current application.
DX -- Toggle debugger entry. Normally, if either the $A9FF or SABFF A-trap is executed
(two forms of the $1FF debugger trap), program execution halts and the debugger is activated.
DX allows you to control whether or not program execution halts. Note that the $ABFF trap
will still print a string; thus with debugger entry disabled, this causes an effect similar to the AT
command (i.e. the Mac screen alternates between the debugger and the program).

* There are two other commands not mentioned in the MDS documentation.

SC -- Stack crawl. Assumes that LINK/UNLK A6 has been religiously performed at the
beginning/end of each procedure/function (ala Pascal). The output format is as follows:

>SC
SF @<stack frame location> <address of call to procedure>

For example,

>SC
SF @OD633C ProcName+3A

means that the currently executing procedure/function has its local stack frame at $D633C and
was called from ProcName+$3A (which is not the return address!).
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AR -- A-trap record. The command has the same parameter format as AB (i.e. AR trap range,
PC address range, DO range). Whenever the parameter constraints are satisfied by an A-trap
call, information about the call is recorded. The trap name, PC, A0Q, DO, and time are always
saved. If the call was for an OS trap, 32 bytes pointed at by AO are recorded, otherwise 32
bytes pointed at by A7 (stack ptr) are saved. To display the current saved information, type
AR with no arguments. This command is especially useful for tracking down crashes in the
Macintosh ROM. For example,

>AR 0 1000 @2AA @114

records traps O through 1000 (all traps) from ApplZone ($2AA) through HeapEnd ($114), so it
will record the last trap call made from anywhere in the application heap (the application's
code).

+ A final feature is the ability to IL or BR on a procedure name. For example,
>IL ProcName+58

will disassemble code starting at 58 bytes (hex) into the procedure called 'ProcName', and
>BR ProcName+58

will set a breakpoint at the same location (this also works for GT, ST, DM, etc.). Note that the
$D+ option must be specified in the Pascal source (the PX command in MacsBug can be used to
disable/enable Pascal symbol display).

MacDB

MacDB (the"two Mac debugger") can be used on one Macintosh to debug programs running on
another Macintosh. MacDB and MacNubs can be found in the MacDB & Nubs folder of the 5/85
MacStuff 2 disk. This Supplement contains the versions of these files that were shipped with the
Macintosh 68000 Development System product. One known bug is that MacDB indicates the target
machine is a 128K Macintosh regardless of how much memory it actually has; this is relatively
minor because MacDB can still reference all memory on the target machine. Information about
MacDB can be found in chapter 6 of the Macintosh 68000 Development Svstem Users's Manual
titled The MacDB Debugger which was distributed with an earlier Software Supplement.
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Macintosh Product Availabilitv List

The challenge of software distribution is faced by every developer: How to get information about
your product to potential buyers and, more importantly, how to get your product through the
distribution system and into the hands of the customer.

To help in this effort, the Apple Developers Group is constantly seeking better ways to "get the
word out" on products that are available for the Macintosh. One very popular tool is our
Macintosh Product Availability List. Published on a regular basis, it is distributed to over
7000 locations including our complete dealer base.

The folks at Menu.International, an International Software DataBase and fulfillment service, have
been in the business of tracking software for some time. They currently have 20,000 products
listed on their database and have shipping and purchasing arrangements for at least 3900 of these
products.

Menu has created a special business unit to address the Macintosh market. We were so impressed
with Menu's on-line service that we made arrangements for them to produce an enhanced version
(including price and two-line product descriptions) of our Availability List to distribute to our
dealers.

If you have a product that is shipping, call and confirm that Patti Barrus in the Developer
Co-Marketing Group knows about you and your product. Patti's number is (408) 973-2972.
Also, let the folks at Menu know so they can include you on the regular updates of the now famous
Availability List. They can be reached at (303) 482-5000 or (800) Mac-Menu.

Macintosh Pascal

Macintosh Pascal (the Pascal interpreter) has an undocumented copy protection scheme that causes
an ExitToShell after 100 mouse clicks. If you've been running MacPascal off of a copy of your
master disk, you've no doubt experienced this problem.

To rectify this problem, simple run off of one of your master disks (two were shipped in the
package).
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MacApp

Apple is developing an object-oriented library called MacApp™, The Expandable Application™.
MacApp implements the standard features common to most Macintosh programs. To write an
application, you specify the differences between your particular product and MacApp. MacApp
provides a substantial portion of a Macintosh Application, including standard objects like
windows, menus, scroll bars, and documents, and standard operations like scrolling, resizing,
printing, and text editing. It facilitates the implementation of Open, Save, and Undo, as well as
multiple views of the same data. It makes it easy to conform with the user interface guidelines.

To benefit from MacApp a programmer should know Pascal and be just starting to develop a new

Macintosh application. Using MacApp, such a programmer should be able to complete a Macintosh
application in much less time than it would otherwise require.

At present, MacApp--and programs written to use it--must be written in Object Pascal, an
object-oriented extension of Pascal. We currently have an "alpha" version of the Object Pascal
compiler which runs on the Lisa Workshop 3.9 and generates code for the Macintosh. MacApp is
also in an alpha-test state. To develop an application using the alpha Workshop version of MacApp
you would need to have:

(1) A Lisa (Macintosh XL) with at least 1 MB of memory
and 5 MB of hard disk storage (10 MB recommended)
(2) Lisa Pascal Workshop version 3.9 (Workshop 3.0 + 3.9 Update --> Workshop 3.9)
(3) Inside Macintosh
(4) The May 1985 Macintosh Software Supplement
(5) A 512K Macintosh or a Macintosh XL with MacWorks XL 3.0
(MacWorks XL 3.0 is included with the May Software Supplement)

If you have the hardware and software listed above and are interested in using MacApp, write to us
at the address below; we will notify you when a released version of MacApp is available.

We would also like volunteers to test the alpha Workshop version of MacApp. Any Pascal
programmer who will soon be starting to write a new application and would like to be an
"alpha-tester" should submit a proposal of approximately three pages explaining the type of
development planned and the reason (s)he would be a good tester. We will select a small number of
alpha-testers.

Please send requests for notification and alpha-test proposals to:
MacApp Request
c/o Eileen Crombie
Apple Computer

20525 Mariani Avenue
Cupertino, CA 95014

Licenses to ship products built with MacApp will soon be available for a low annual fee.

MacApp and The Expandable Application are trademarks of Apple Computer, Inc.
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Smalltalk

We are currently developing a version of Smalltalk tailored to the Macintosh computer. In the
meantime, in response to requests from several universities, we have released a "pre-product”
version of the Smalltalk-80™ programming system running on the Macintosh and Macintosh XL
computers. This is a fairly complete implementation of the Smalltalk-80 system, which we believe
to be suitable for student projects and other preliminary experiments with Smalltalk.

Our current system is based on version 1 of the Xerox Smalltalk-80 system, and is
language-compatible with the current (version 2) Xerox release. Our system generally follows the
two Smalltalk-80 books by Goldberg and Robson. Several features will be found to be different or
missing. We only provide enough documentation to get you started. If you are not already familiar
with the Smalltalk-80 system, you will need further documentation not provided by Apple, such as
the Goldberg and Robson books.

This pre-product release supplants an earlier March release that only ran on the Macintosh XL.
Various options support stand-alone operation on the 512K Macintosh computer (minimal system),
enhanced source-code access with hard disk or file server, and full system (32K objects) on
machines with 1IMB or more of memory, such as the Macintosh XL..

If you wish to try out Smalltalk, you may request an order form from the address below. We will
include a more complete description of the products, pricing information, and an optional site license
which permits the system to be installed and used throughout (but only within) your institution.
Apple cannot provide support or documentation for this pre-product release. We are charging only
enough to cover our costs of duplication and handling.

Smalitalk Request

c/o Eileen Crombie

Apple Computer, Inc.

20525 Mariani Avenue CSNet: MacST@Apple.CSNET
Cupertino, CA 95014 UUCP: {dual,nsc,voder,ios }!apple!MacST

Smalltalk-80 is a trademark of Xerox Corporation.
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Addresses

If you have technical comments regarding the Supplement, please write to us at:

Macintosh Technical Support
Apple Computer

Mail Stop 4-T

20525 Mariani Avenue
Cupertino, CA 95014

If you have questions about missing or damaged materials (disks or documentation), please contact
our mailing facility at:

Apple Computer Mailing Facility/Milestone Group
467 Saratoga Avenue, Suite 621
San Jose, CA 95129

Customer Service:

(408) 988-6009
9:00 A.M - 4:00 P.M,, Pacific Time
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|Apple Computer, Inc.
Macintosh Technical Documentation|
Order Form

Inside Macintosh

This document is the complete Macintosh development manual currently available in
draft form only. It contains 1200 pages of detailed technical documentationand is a one-
volume set.

Macintosh Software Sunnlement

The Supplement includes Macintosh and Lisa Workshop disks containing many useful developer
utilities, examples programs, and interfaces. These are required for Macintosh development using
the Lisa Pascal workshop and strongly recommended for development using only a Macintosh. $100.00
The Supplement also contains a copy of MacWorks XL and --when you order this in addition to
Inside Macintosh above-- you will receive the final bookstore version of Inside Macintosh

when published.

Inside A alk

This document contains detailed hardware and software information on the AppleTalk
network. It also contains software necessary to undertake AppleTalk development.

Inside LaserWriter

This document contains information for advanced developers working with the
LaserWriter.

Purchased orders accepted with payment only. Subtota!

Orders shipped via U.P.S. and not deliverable
to a P.O. Box. Federal Express (Optional) _—J

My Federal Express billing number is:

(CA. RESIDENTS ONLY)

Total Enclosed

Name:

Company:

StreetAddress:

City: State: Zip:

Phone:

Please send your company check to our processing facility
Apple Computer, Inc.
467 Saratoga Avenue Suite 621
San Jose , Ca 95129







CSwitcher (Beta Draft)

June 4, 1985

About This Document

This is the Beta draft of the documentation aimed at not-so-naive users. This draft
corresponds with Switcher version 3.0.

About Switcher

Switcher is a unique environment for the Apple Macintosh™ computer that allows you to use
two or more applications at once. Switcher and the power of Macintosh 512 provide you
with an environment where you create your own custom "integrated" applications and switch
between them instantly. Switcher divides available memory; you allocate portions of it to
different applications. You can work on a diagram in MacDraw, switch instantly to
MacWrite when you get an inspiration for your report, then switch back to MacDraw and
continue with your sketch. And you never need return to the Finder. In fact, you can even
have the best of both worlds. With the Finder as one of your applications, you can do all
your housekeeping (copying and removing documents) without ever leaving Switcher or
quitting an application.

Switcher is powerful, flexible, and a great timesaver. You'll only need to set up a particular
combination of applications once. After you've installed the applications you want and
changed any options, you can save that information in a Switcher document. Opening a
Switcher document from the Finder tells Switcher to automatically start those applications.
‘What could be faster and easier?

About This Manual

This manual gives you the information you need to use Switcher to create an infinite number
of combinations of your favorite applications.

Hardware Requirements

Switcher was designed for the Macintosh 512K. An external disk drive is strongly
recommended to hold additional applications and documents. Switcher also works well with
the Macintosh XL and third-party hard disks.

Software Requirements

Switcher works with all Apple Macintosh software; MacWrite, MacPaint, MacDraw,
MacProject, MacTerminal, Macintosh Pascal and most third-party software designed for
Macintosh 128K. Some software designed exclusively for the Macintosh 512K may not
work with Switcher. Contact specific third-party publishers or ask your dealer to let you try
out any software you intend to use with Switcher before you buy.
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Switcher's Limitations

Although Apple has tested Switcher and is satisfied with its performance and reliability,
Apple cannot guarantee the reliability of any particular application or combination of
applications used with Switcher. Apple makes no warranty with respect to the quality,
performance, or fitness for a particular purpose of Switcher or any software being used with
it. As aresult, the Switcher is sold "as is" and you, the purchaser, are assuming the entire
risk as to its quality and performance. The manual gives you information for maximizing the

reliability of applications by identifying potential problem areas and suggesting safe
configurations.

How to Use Switcher

You'll find working with your usual applications under Switcher is easy. This section tells
you how to use Switcher, how to use an application running under Switcher, and how to
create a Switcher document--your own custom set of applications.

Configuring Your Disks

Assuming you have two disk drives available, here is the recommended way to configure
your disks. You should only have system files on one disk. Remember that some
applications (including MacDraw and MacWrite) require the printing resource (a file in the
System folder with the same name as the printer such as Imagewriter or LaserWriter) to be
on the same disk as the application.

Startup Disk (Internal Drive) Application Disk (External drive)
System Folder & files Applications
Switcher Documents
Switcher Documents Switcher Documents
Applications (if room) No system files (except a printing
Documents (if room) resource if necessary)
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Starting Switcher

Start Switcher like any other application by double-clicking the Switcher icon or choosing
Open from the File menu. You'll see the Switcher screen:

[ & File tdit Switcher

Application Switcher

R

Double-click here to launch an application...

Double-click here to launch an application...

Double-click here to launch an application...

Double-click here to launch an application...

Installing Applications

The first thing to do after you start Switcher is to install the applications you want to use.
You can install all the applications you want to use at the outset, or install one, start working,
and add or remove others later.

Select a Switcher slot by double-clicking anywhere in it. A dialog box presents all
applications on the Switcher startup disk. Select the application you wish to install and click
Open, or click the Drive or Eject buttons to get applications on another disk. Switcher
installs the selected application, starts it, and returns you to the Switcher screen. You can
now repeat the process to install another application.
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Using Applications With Switcher

Once you have installed and started the applications you want to use, you're ready to take full
advantage of Switcher. With Switcher you can work within any one of your applications as
you normally would, then switch to another almost instantly.

Switching To Other Applications

When you click either side of the arrow, Switcher moves you to the next or previous
application, depending upon whether you click the right or left arrow. You can begin
working immediately with the application.

_

g:
&
i

it seeas

You can also use a keyboard shortcut to switch: Typing Command-[ switches you to the
right. Typing Command-] switches you to the left.

Returning to the Switcher Screen

There are several ways you can return to the Switcher screen from an application. Use the
technique you like best.

1. Click the center of the switching arrow. You return immediately to the Switcher screen.
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2. Choose Switcher from the Apple menu. Whenever you're in an application, you'll notice

a new command at the bottom, Switcher. Choose Switcher and you'll return to the
Switcher screen.

File Edit Search Format Font Style
About Maclrite. Untitled

Scrapbook
Note Pad
Puzzle

3. Type Command-\. Hold down the Command key (icon) and the back slash key (located
directly below the Backspace key).

Transfering Information Between Applications

In Switcher's preset state, you won't be able to copy information into one application's
clipboard and then paste that information into another application. To copy information
between applications, you can use the Scrapbook or you can tell Switcher to convert the
Clipboard. Hold down the Option key as you click the switching arrow to convert the
Clipboard.

You can have Switcher automatically convert the Clipboard with every switch. See page XX.
Quitting Applications

You quit an application in Switcher as you normally would; save your changes and choose
Quit from the File menu. Depending upon what options are in effect, you return to the
Switcher screen or to a neighboring application in the set. After you quit an application, that
application is removed from the Switcher environment and its Switcher slot becomes free.
To quit the Finder, see "Using the Finder With Switcher."

Installing Additional Applications

Return to the Switcher screen and repeat the steps for installing an application. Depending
on how much memory is available, you can install up to three applications with 128K
memory each, using Switcher's preset options. To install more than three requires some
memory conservation tricks and probably a hard disk to hold all the applications you'll want
to have available.
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Creating a Switcher Document

Switcher provides you with a fast way to load your favorite combination of applications,
settings, and options. The state of Switcher: its options and active applications at a given
moment in time, is called a set. You can recreate a set at any time by saving information
about the set as a Switcher document. A Switcher document contains information to
start Switcher and load all the applications and options that comprise the set.

To create a Switcher document, start Switcher and install all the applications you want to use.
If you want the set to open with a particular document, use the Attach Document command.
(See below.) Select any Switcher option changes you want (Switcher menu). When you're
satisfied with the configuration, choose Save Set from the File menu. You'll be asked to
name the set.

Starting Switcher From a Switcher Document

To start Switcher with a set of predetermined applications, just open a Switcher document
from the Finder or, from within Switcher, and choose Load Set from the Switcher's File
menu.

After you've saved a set or loaded a new set, any changes you make to the set such as adding
or removing applications or documents doesn't affect the contents of the saved set in the
Switcher document.

Quitting Switcher

In order quit Switcher, you must first switch to each application, save, and quit. Then return
to the Switcher screen and choose Quit from the File menu, or click the close box in the
Application Switcher window. If you want to start another application, simply quit one
application then start another from the Switcher screen.

You'll be allowed to quit Switcher if just one application is still installed. If you haven't
saved, you'll be asked to save any changes from the last application.

It is important to quit each application individually. Never just switch the Macintosh off.
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Customizing Switcher

Switcher's preset options are designed so that you'll probably never need to change them.
But Switcher was designed to be flexible, allowing you to control the settings, options, and
aesthetics of the Switcher environment.

Memory Allocation

Switcher automatically allocates 128K of memory for most applications, or more, if specific
Switcher options are in effect. Future applications containing a SizeRsc variable will be able
to request specific amounts of memory from Switcher. However, you may be able to
allocate more or less memory than an application normally requires. If you are working with
memory based applications such as MacDraw document, you may want to allocate more
memory to MacDraw so you can work with larger documents. Switcher not only allows you
to specify the memory configuration of each application but also provides you with graphic
information to help you decide on the optimal memory configuration for each application.
The Configure Then Install command from the Switcher menu lets you determine the amount
of memory you allocate to an application.

Memory can only be allocated before an application is installed. Many applications may not
run or may have problems if any amount other than 128K is assigned. For instance, an
application may assume that if more than 128K is available, it must therefore be on a 512K
machine and demands all 512K of memory. It is also difficult to determine how little
memory an application needs to operate. (We know the Finder will work with 95K, but no
less.) The safest course is to assign 128K. If you wish to assign a different amount, please
experiment with nonessential information first!

Switcher Options

You can tailor Switcher to suit your particular needs and preferences. From the Switcher
screen, choose Options from the Switcher menu.

«[2] Application Switcher Options

[ Switcher in Rotation

] Always Convert Clipboard
(X Switching Animation

X Back after Launch

[J Ssame One Twice

[[] Reverse Switch Direction

[[JRoom For LaserlWriter
[ 0K | ([ Cancel |

You can check or uncheck various options to suit your needs.
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Switcher in Rotation. The Switcher screen itself is included in your set of applications.
As you click the switching arrow, one of the applications you switch to is the Switcher
screen.

Always Convert Clipboard. When you are using Switcher, each application maintains its
own private clipboard. If you copy a piece of text in MacWrite and then switch to MacDraw,
the text you copied won't appear in MacDraw's clipboard. Choosing Always Convert
Clipboard tells Switcher to always transfer the Clipboard from the current application to the
next application. When this option is in effect, you'll notice it takes longer to switch between
applications.

You can override the current state of Always Convert Clipboard by holding down the Option
key as you switch to the next application. For example, if Always Convert Clipboard is
unchecked, then switching while holding down the Option key will convert the Clipboard
contents for that particular switch. If Always Convert Clipboard is checked, then switching
while holding down the Option key will not convert the Clipboard contents for that particular
switch. We recommend you not check Always Convert Clipboard and use the Option key
only when you need to copy the Clipboard to the next application.

Switching Animation When this box is checked, animation is in effect; applications
appear to "roll by" on the screen. If this box is unchecked, animation is not in effect; the
next application simply appears. Although this is strictly a matter of personal preference,
using animation does take a little more time.

Back After Launch When this option is checked, you return to the Switcher screen after

you install and start a new application. When it's not checked, you remain in the application
you installed.

Same One Twice 1If this option is checked, you'll be able to run the same application
more than once. If it is not checked, Switcher will only allow you to start the application
once. Note that some applications create special temporary files or may not be designed to
handle events "happening behind their backs.” Therefore it may not be safe to run multiple
copies of most applications. Use this option at your own risk.

Reverse Switch Direction This is purely an aesthetic feature. When you click the right
arrow, which application do you want to switch to? The one to the "right” or to the "left"?
You decide the direction you want.

Room for LaserWriter An application can't print correctly on the LaserWriter with less
than 144K of allocated memory. This option changes the preferred memory size to 144K or
adds 16K if the preferred memory size is greater than 128K. If your LaserWriter output
contains gibberish (a LaserWriter symptom of not enough memory), check to see if this
option is turned on.

When this option is checked, Configure Then Install presents 144K as the preferred memory
size. Room for LaserWriter only takes effect at the time the application is started; it has no
effect on active applications. You'll need to quit any active applications and reinstall them in
order to increase the memory allocation.

Note: this feature will not appear in the released version of Switcher.
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Configuring Applications

The Configure Then Install command (Switcher menu) allows you to allocate a different
amount of memory to the application you're installing and gives several other options.

«[3| MacDraw Configuration

Preferred Memory Size

Minimum Memory Size 128

[J Save Screen

(Permanent| (Temporary) ( Cancel |

Preferred Memory Size. The amount of memory Switcher first attempts to allocate to the
application. 128K, a previously configured amount, or the amount an application requests is

displayed as the preset memory size. If you've chosen Room for LaserWriter, 16K is added
to the amount.

Minimum Memory Size. The smallest amount of memory Switcher attempts to allocate to
an application. Usually, 128K or a previously configured amount is displayed as the preset
memory size. For example, if you've configured MacPaint with a preferred memory size of
128K and a minimum memory size of 80K, Switcher looks at the minimum memory size and
compares it to available memory. If the available memory is 100K, Switcher will allocate
100K to MacPaint. If the available memory is less than 80K, Switcher will inform you there
is not enough memory to start MacPaint. Switcher will not allow you to allocate less than
64K.

Save Screen. This option keeps the screen contents in memory as you switch from this
application to another, allowing you to see this application's screen almost instantly when
you switch to it again. Unchecking Save Screen turns this option off: Switcher must look
for a "memory map" of the application's screen and recreate it on the screen. When Switcher
saves the contents of the screen, you'll notice switching between applications seems faster.
When Save Screen is turned off, you'll notice the screen is redrawn each time you switch to
the application.

Save Screen consumes 22K of memory per application. If you choose not to save screens,
you'll free up additional memory. However, your switching time will increase and some
applications will not be able to redraw the screen accurately.

This option does not save your work each time you switch. You'll need to save from within
each application.
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Permanent . The Permanent button installs the application in a slot and makes the
Configure Then Install options apply to all future Switcher sessions for that particular
application. You can install the application by double-clicking a slot and the options will be
in effect every time you install that application. If you wish to change the configuration later,
quit the application and choose Configure Then Install again.

Temporary. Clicking the Temporary button installs the application and makes the changes
for this session only. The Permanent settings remain unchanged.

Cancel . Returns you to the Switcher screen without installing the application.

After you've finished configuring an application by clicking the Permanent or Temporary
buttons, you return to the Switcher screen. The application appears in a slot with the word
"Configure" to show that the application has not yet been started. To start the application,
double-click its slot. The application is started. If Back After Launch is in effect, you'll
return to the Switcher screen. Once you've started an application, you cannot change its
memory allocation. You must quit the application and choose Configure Then Install again.

Removing a Nonactive Application

A nonactive application is an application that has been installed in a Switcher slot using the
Configure Then Install command, but has not yet been started. The word "Configure"
appears in its Switcher slot.

MacWrite —
(SwitcherHints) 128K

|

MacDraw (configure) —
128K

Remove a nonactive application by returning to the Switcher screen, selecting the application
you wish to remove by clicking in its slot, and choosing Remove Application from the File
menu. You cannot remove an active application in this manner. After you remove an
application, its Switcher slot becomes free.

Speed, Memory, and Safety

Most of Switcher's features have tradeoffs between speed, memory consumption, or safety.
While these tradeoffs are listed with each option, this section gives you ideas on how to
optimize Switcher for one of these factors. Speed refers to the amount of time it takes to
switch between applications. Memory refers to options that consume memory. Because
Switcher cannot predict how a particular application is designed, some options may be more
likely to cause problems. Therefore, safety refers to the safest configuration for most
applications.
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Speedy Options

To switch quickly between applications, choose Options from the Switcher menu. Turn off
(uncheck) Always Convert Clipboard and Switching Animation. Also, turn Save Screen on
for each application.

To start Switcher quickly, save your favorite configurations as Switcher documents. From
the Finder, simply open a Switcher document. See "Saving Your Configuration."

You can also designate Switcher as the startup application. This means when you turn on
your Macintosh and insert the Switcher disk, Switcher is started automatically. To set
Switcher as the startup application, go to the Finder, select the Switcher application icon, and
choose Set Startup from the Special menu. When Switcher is the startup application, you
can designate a startup Switcher document by naming the document "Switcher.startup".
Switcher will startup automatically and load the set from the document.

Saving Memory

One way to conserve memory is to allocate as little memory as possible to an application.
Another way is to not use memory-consuming options. Always Convert Clipboard, Room
for LaserWriter, and Save Screen consume memory when they are in use. Save Screen uses
22K per application. You can turn save screen off with the Configure Then Install command
(see page XX) or after an application is installed, with the Application Switcher window
itself:

Applicatinn Switeher

Save Screen o

MacWrite

Save Screen ot

MacDraw

7 N Save Screen o

i <& MacPaint

128K

By clicking the screen of the Macintosh icon in an application's slot, you can turn Save
Screen on or off. In the example above, the MacDraw and MacPaint screens are saved
between switches, but the MacWrite screen is not saved (indicated by the "No!" symbol).

Caution: Once you turn Save Screen off, you may not always have enough memory to turn

it back on, depending on what you've done in the interim. Switcher will beep if you attempt
to turn Save Screen on and you don't have enough memory.
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Safety

We consider the following options to be the safest settings for an application. Settings that
aren't listed here have no effect on safety.

Configure Then Install:

Preferred Memory Size 128
Minimum Memory Size 128
Save Screen On

Options:

Always Convert Clipboard Off
Same One Twice Off
Room for LaserWriter Off
Maximum # of Applications (512K) 3
Maximum # of Applications

(Macintosh XL, 1 megabyte) 7

Switcher Menus

You'll see four menus on the Switcher screen: Apple, File, Edit, and Switcher. When you
are in an application, the Apple menu includes a return-to-Switcher command at the bottom.
The Edit menu is unavailable unless you choose a desk accessory from the Apple menu.

The File Menu

ffl £dit  Switcher
Load Set... 8L
Save Set... E 3
Attach Document... %A

Show Info Window

Quit

Load Set. This command lets you choose a Switcher document to load. You should first
quit any active applications to leave room for the applications in the set. Otherwise, Switcher
will load only as many applications as it has memory available.

Save Set. This command saves the current set of applications, options, and settings as a
Switcher document that can later be recreated with the Load Set command.
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Attach Document. When you start or load a Switcher document, this command causes an
application to open a specific document. To attach a document, select an active application
slot from the Switcher screen and choose Attach Document from the File menu. If MacWrite
is the selected application, a box appears with a list of all MacWrite documents. You may
then select the specific MacWrite document you wish to work with when the application is
started.

Show Info Window. This command presents the Switcher Information window which
provides you with a graphic snapshot of the memory allocation and usage of the current set
of applications. You can use this information to help you configure your Switcher
environment.

Switcher Information

Memory Usage

v MacWrite —_— 128K
finder —_— 128K
MacPaint 144K
Free Memory 21K

Acisrgruphigmi
Dkl ey

————___—_ﬁ

The bar following each application represents how much memory has been allocated. The
dark gray area shows how much memory is actually being used; the light gray area shows
how much additional memory is available to the application. The actual amount of memory
allocated to the application is shown at right. The application that is currently selected in the
Application Switcher window is checked and visually represented. If the Switcher
Information window shows that a particular application has been allocated substantially more
memory than is actually being used, you may wish to quit the application, return to the
Switcher screen, and change the preferred memory size for the application.

You can leave the Switcher Information window on your desktop and switch between it and
the Application Switcher window. Clicking the miniature screen switches you to that
application. A miniature screen won't be displayed if Save Screen is off for a particular
application.

Quit. Exits Switcher. You won't be allowed to quit Switcher until you've quit all but one
active applications. You can accomplish the same thing by clicking the Switcher window's
close box. See also "Using the Finder."
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The Switcher Menu

Install Application... %I
Remove Application 38R
Configure then Install...

Open 30
Switch Left |
Switch Right 8]
Options...

Install Application, Remove Application, Configure Then Install, and Open all operate on the
selected slot.

Install Application Allows you to select an application for installation in a Switcher slot.
It's the same as double-clicking one of the slots in the Application Switcher window. If you
haven't selected a slot, Switcher selects the next available slot.

Remove Application Lets you remove a selected nonactive application from the current
set. A nonactive application has the word "Configure" in its Switcher slot. An active
application is removed by switching to it and choosing Quit from the File menu.

Configure Then Install Allows you to select an application to install and presents the
Configure window. If you haven't selected a slot, Switcher selects the next available slot.
See "Configuring Applications."

Open Starts a selected nonactive application or switches you to the selected application.
Switch Left The same as clicking the switching arrow that points left.
Switch Right The same as clicking the switching arrow that points right.

Options Presents the Options window. See page X.

Switcher Cookbook

This section gives information on specific Switcher situations.
Using Four 128K Applications at Once

You can have four 128K applications running at a time with Switcher. To do so, you'll need
to turn off all Switcher options that use memory. In the Options window, turn off Switcher
in Rotation, Always Convert Clipboard, and Room for LaserWriter. Then install each
application using Configure Then Install. Change Preferred and Minimum memory size to
128K or less and uncheck Save Screen. Use the Info Window to monitor your memory
usage as you configure.
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Using Less Than 128K of Memory

Some applications (including MacPaint and MacWrite) can run with less than 128K memory.
Try different memory allocations with the Configure Then Install command. Most
applications will tell you immediately if they won't work.

The document size of many applications is limited by the amount of memory available. If
you create a document using 128K memory or more, you may not be able to open that
document under Switcher if you've allocated less memory to an application.

Using 512K Applications

Applications designed to work on a 512K Macintosh may be able to work with Switcher
with less than 512K memory allocated. Install the application with Configure Then Install
using different amounts of memory. The application should tell you if it will run or not.

Using Switcher With a Hard Disk

Switcher works well on a hard disk. Just copy Switcher to the hard disk. Be sure to start
Switcher from the hard disk.

Using Switcher With AppleTalk

Switcher works well with AppleTalk, although specific applications that use the network
may not function properly. If you're using LaserWriter over an AppleTalk network, be sure
to check the Room for LaserWriter option before you install applications.

The Finder as One of Your Applications

Having the Finder as one of your set of applications gives you the speed and flexibility of
Switcher as well as all the utilities of the Finder, with no lost time returning to the Finder.
Then Finder should be installed in the first Switcher slot. Simply start the Finder in Switcher
as you would any other application. If you use Configure Then Install, you can change the
Finder's preferred memory size to as small as 96K for Macintosh 512K (you'll need 102K in
order to open a maximum of eight windows at once) and 128K for Macintosh XL..

To quit the Finder from within Switcher, switch to the Finder and start another application.
To quit Switcher when the Finder is one of the applications, quit any other active
applications, then quit Switcher. Another way to quit is to use the Finder's Shut Down
command. Shut Down ejects any disks and then restarts the Macintosh. On a Macintosh
XL, choosing Shut Down turns the power off, but not on again. This is not recommended
unless you first save or quit all other applications.

Don't start a Switcher document from the Finder.
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Emergency Exit

If one of your applications should "hang" or "crash” (you receive a dialog box with a bomb
icon), don't click restart or turn your Macintosh off and back on. You may be able to
recover by exiting the application and returning to the Switcher screen without affecting any
other applications in Switcher. If you encounter such a situation, try holding down the
Option, Command, Shift, and period (.) keys. Depending on the type of problem the
application encountered, you could return to the Switcher screen, without affecting the other
applications.

Extras

Switcher gives you control of the power of Macintosh 512 by providing an environment
where you create your own "integrated"” applications. Switcher lets you instantly switch
between different applications by dividing available memory. You determine your own
optimum configurations by deciding which combinations of applications and options you
need. And with the Finder as one of your applications, you can do all your housekeeping
(copying and removing documents) without leaving Switcher.

You need to set up any particular combination of applications only once. After you've
loaded the applications you want and changed any options, you can save that information in a

Switcher document. Opening a Switcher document automatically starts all the applications
you've designated.

Returning to the Switcher screen: From within an application, look at the Apple menu;

you'll notice a new command at the bottom, Switcher. Choose Switcher and you'll return to
the Switcher screen.
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Installing additional applications: Return to the Switcher screen and repeat the steps for
adding an application. Depending on how much memory is available, you can install up to
three applications with 128K memory each, using Switcher's preset options. To install more

than three requires some memory conservation tricks and probably a hard disk to hold all the
applications you'll want to have available.
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A Software Developer's Guide to Switcher
Andy Hertzfeld 9 Apr 85

Editor’s Notes: Inside Switcher. additional information on the internal workings of Switcher, will
soon be available from MAUG ™ (via Compuserve). Switcher 3.0 is a pre-release version and
may not be licensed or distributed with commercially available products ; a later version will be
licensable in the near future.

The Macintosh Application Switcher creates a dynamic new software environment for the
512K (or larger) Macintosh, allowing multiple application programs to reside simultaneously in
memory and providing a way to switch between them very quickly. The Switcher tries to support
every Macintosh application, but the interface between a program and its environment is very
complex, and Switcher necessarily disturbs this delicate balance, so some programs are not
compatible with it. This document is intended for an audience of Macintosh software developers
and will provide suggestions and hints that will help your application to get the most out of the
Switcher environment.

The most recent version of the Switcher is version 3.0. It can be used with the versions of
the MacsBug debuggers included with the May Software Supplement. Some earlier versions of
MacsBug had a bug that made them not work with Switcher, so be sure to use these new versions
when testing your applications out with Switcher. When you find that your application doesn't
work properly with Switcher, please try to pinpoint the difficulty as precisely as possible when

reporting the bug; bugs can be reported to Apple or to me on MAUG/Compuserve (my number is
70167,3430).

One source of developer confusion is caused by the way the Switcher fudges memory size
statistics. It turns out you have to allocate a 96K partition for an application to have approximately
the same amount of memory it has on a 128K Mac. To avoid confusion for the typical user, the
Switcher adds 32K to the size of a partition before displaying it. Thus partition sizes are
"normalized"” to the well-known 128K Mac; for example, a partition that's displayed as 256K
actually only has 224K allocated to it.

The Switcher knows how much memory to allocate to a given program by inspecting the
"SIZE -1" resource attached to the program file. The Switcher is capable of generating its own
SIZE blocks using the Configure command, but it would be very nice if new applications could
come "pre-configured” for their own unique memory requirements and other properties. The size
block is 10 bytes long; there is a flags word followed by 2 long integers. The first long integer is
the recommended size of the partition, followed by the minimum size. The values are 32K less
than the virtual partition size (i.e. 96K for a 128K partition). Currently, only the high two bits of
the flags word are defined. Bit 15 means "save screen” and bit 14 means "suspend/resume” events
(see below). Unassigned bits should be kept O for future compatibility.

While working at Apple, I had the opportunity to watch a number of fairly complicated
Macintosh applications go through their final debugging cycles. The most time-consuming and
difficult part of this process is what you might call "memory tuning", which is dealing with various
out-of-memory situations and with memory fragmentation. Typically, an application is tested and
tuned to run on both 128K and 512K Macintoshes. However, the Switcher environment supports
variable-sized partitions, so many more memory situations become possible (i.e., a 256K Mac).
The biggest problem most applications have working smoothly with the Switcher is that they were
tuned for 128K or 512K, and sometimes are freaked out by something in between, because they
make decisions like "it's not 128 so it must be 512". Switcher-friendly applications should test
memory to see how much is available and be able to deal with a wide range of memory sizes. The
best way to size memory initially is to grow the heapZone out to its maximum size by requesting an
enormous block, and then execute a "FreeMem" or "MaxMem'" call (Lisa Pascal users can
alternatively use the "MaxApplZone" call). After initialization, the best way to determine if a certain
amount of memory is currently available is to use the "ReserveMem" call. Switcher also sets up the
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low-memory location "MemTop" with the size of the current partition normalized to a 128K Mac,
but it is not recommeded that memory-sizing decisions be based on that. Make sure you never
make any assumptions about how much memory is available by looking at absolute addresses, as
you don't know where you are going to be loaded.

Many applications have a need to create temporary disk files using a filename generated by
the application like "Edit.Scratch” or "Paint1". Since the Switcher environment supports running
the same application twice, file name conflicts are possible. A Switcher-friendly application should
never used a hard-wired name for a temp file; instead, it should make up one using a random
number or the time of day clock, so the names will not conflict if its running concurrently in two
different partitions. For example, instead of using "Paint1", use "Paint03:12:35".

Switcher switches contexts only when an application executes a "GetNextEvent" call, so
applications never have to fear being suspended when they are engaged in some time-critical
activity. To be compatible with Switcher, your application must call GetNextEvent periodically, as
most applications do. To be able to cut and paste under Switcher, your application must support
desk accessories by maintaining an Apple menu, and supportmg cuttmg and pasting with desk
accesories. This is because Switcher fools your application into coercing the clipBoard into global
format by making think its cutting or pasting into a desk accessory. Watch out for an entry in the
desk accessory menu that isn't really a desk accessory. See the discussion below on
suspend/resume events for further information on the "desk-accessory charade”.

To make most effective use of memory, the Switcher supports an option where it will not
save the bits of an application's screen when it switches. If this option is in effect, the program
must be able to respond to update events to regenerate the screen. Thus, switcher-friendly
programs should be prepared to handle update events.

Another class of Switcher incompatibilities is caused by asynchronous I/O. It is possible for
a suspended application to receive control via a completion routine after its been switched out .
Completion routines must be very careful about referencing low memory and globals, as they
might have been swapped out and AS is probably different. One technique for performing
Switcher-friendly async I/O is to pass A5 at the end of the I/O parameter block, so your completion
routine (which is passed the parameter block) can reference globals. This is only relevant to
non-file I/O, as the Switcher refuses to switch if the file system is busy. Also, the Switcher
suspends any vertical retrace tasks executing in a given partition when the main application is
suspended, so your vertical retrace tasks don't have to worry about this.

Another potential danger area for Switcher compatibility involves timing. In the Switcher
environment, it is possible for an application to be suspended for an indefinite period. Some
applications use "Ticks" for relative timing; they must be careful to use 32-bit compares and
arithmetic as Switcher makes it possible for more than 64K ticks to have elapsed since the last time
you looked at it.

Even though the Switcher is intended to work "behind the back" of most applications, it
includes some features that allow newly written programs to perform very smoothly with it. For
example, if an application knew it was about to be suspended, it could clean up its act by killing I/O
tasks, etc. To deal with this, the Switcher provides optional "suspend/resume" events. A suspend
event means that the next time you call GetNextEvent, you will be suspended. A resume event is
the first event you get back after you've been re-activated following a suspension. Suspend and
resume events are both reported as event 15 (formerly an application-defined event). The high
byte of the message field is set to 01 to indicate that its a suspend/resume event (eventually event 15
will be used for other purposes as well). The lowest bit of the message field (bit 0) is clear if its a
suspend event and set if its a resume event. The next bit up (bit 1) is set if clipboard coercion is
required. The Switcher uses bit 14 of the flags word in the SIZE record to indicate if a program
should receive suspend/resume events. If this bit is set, the Switcher won't put on the desk
accessory charade for clipboard coercion, as it assumes that the application is converting the
clipboard when requested to in the suspend/rcsume event.
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An even more exciting area is that of "interlocking" applications that run fine by themselves
but are ultra-integrated when run together under the Switcher. Applications can find out the global
picture by inspecting Switcher globals. Switcher globals are accessed through a low-memory
pointer kept at address $282. If the pointer kept there is -1 or 0, it means that the application is not
currently running under the Switcher. Otherwise, its a pointer to a public table of Switcher global
variables. The first 8 longWords in the table is a list of pointers to the base of all currently active
applications, or zero if no application is present in a given slot. By inspecting this table,
applications can determine what other applications they are coexisting with and where they are
located. Apple will eventually provide complete documentation on effectively using this "world"
table, as well as detailing some other useful Switcher globals.

All in all, it is amazing to me how many programs do run properly under the Switcher. Most
developers should not have to worry or understand all of the stuff discussed here; ordinary
applications usually run just fine. It has been fun working on the Switcher. To diagnose various
crashes, I had to trace through the guts of lots of very different applications. Countless features
and strategy shifts were implemented to support this or that application. As a designer of the Mac
system, I'm one of the very few who never had the experience of trying to learn how it works. In
a way, developing the Switcher was the application programmer's revenge for that experience. It
certainly gave me a new appreciation for our strange and wonderful software base.
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Driver Bua in Pre-Release MacWorks XL

This note describes a problem with some pre-released versions of MacWorks XL (a
number of copies of which have been distributed). The problem has been corrected in
version 3.0, the official released version of MacWorks XL, which displays

"MACWORKS XL 3.0 COPYRIGHT 1985 - APPLE COMPUTER" while it is being
booted. Note that the ROM version number of version 3.0 is $82FF (not $81FF as listed
in Technical Note #16).

The problem involves the way MacWorks detects that a particular call is directed at the
hard disk. It looks at each incoming I/O parameter block, looking for a "4" in the
ioVRefnum field.

This works fine for calls to the disk drivers, but not when a call is made to another
driver (e.g. serial driver, sound driver, print driver, etc.). In this case, ioVRefnum has no
meaning. Unfortunately, ioVRefnum is checked anyway; if it happens to be "4", the call
is intercepted as a disk driver call.

For driver authors, this means that your driver may miss |/O operations intended for it.
But for users, it means that the hard disk driver can erroneously write garbage to the
hard disk, corrupting data. This is why the patch is so important.

This patch checks the MacWorks version number to see if the patch is necessary, then
checks to see if the patch has been made already. If necessary and not installed, it
installs the patch. Once the patch has been installed, it should be left in place (just in
case another application is run which doesn't know about this problem).

The patch is not necessary starting with MacWorks XL version 3.0, the version which is
included in the May 1985 Software Supplement. If you ship an application without this

patch your users who have a Macintosh XL will need to use MacWorks 3.0 (which may
not be widely available before September 1985).

You can include this patch verbatim in your application source code; call it once at
application startup, before you open any driver.
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The patch source appears below in Lisa Workshop Assembler format.

MacWorks driver bug patch
Installs JSR and patch routine for checking IO parameter block
TLAsm/Sysequ.TEXT

TLAsm/Systraps.TEXT

TLAsm/Toolequ.TEXT

TLAsm/Tooltraps.TEXT

TLAsm/Quickequ.TEXT

TLAsm/Quicktraps.TEXT

- INCLUDE
. INCLUDE
. INCLUDE
. INCLUDE
. INCLUDE
. INCLUDE

; local equates
SysID .EQU
RevCID .EQU
ReadTrap .EQU

$400008
$81FF
$0002
18

$410880
$4EB9Y
$0C68

Ne Ns We Mo We Ve wg “e

PatchlIt,0
Installlt

location of ROM (MacWorks) id

id we're looking for

read trap

byte offset from start of read routine
to the offending code

use free RAM space for patch

JSR (goes to patch routine)
instruction to replace (CMPI)

go to install routine

#4, IODrvNum (A0) it drive number 4 request?

@9

ReadOfst .EQU
PatchArea .EQU
Patch .EQU
BadGuy .EQU
.PROC
BRA.S
; the new routine for checking
PatchRtn
CMPI.W
BNE.S
CMPI.W

@9 RTS
PatchLnth .EQU

; the install patch
InstallIt

no, skip problem check

#SFFFB, IORefNum (A0) incorrectly directed at Sony driver?

*~PatchRtn

routine

MOVE.W  SysID,DO
CMP.W #RevCID, DO
BHI.S Exit
MOVEQ #ReadTrap, D0
_GetTrapAddress
ADD.L #ReadOfst, A0
CMPI.W  #BadGuy, (A0)
BNE.S Exit
MOVE.W #Patch, (AQ) +
MOVE.L #PatchArea, Al
MOVE.L Al, (A0)
LEA PatchRtn, A0
MOVE.W #PatchLnth,D0
@1 MOVE.B (A0) +, (ALl) +
SUBQ.W #1,D0
BNE.S @1
Exit RTS
.END

return with condition code set
length in bytes of patch

get MacWorks id

is this the bad version?

skip if not

else get address of read trap
gets returned in A0

bump address to offending code
is this the culprit ?

skip if not (may already be patched)
else install patch

get address of patch area

and install

next install new instructions
get patch length

install it

W e Ne Ns % e We wg Ve Ve Ne Ne we N

loop until done
and away we go

The following code will call the above patch from an application written in Lisa Pascal:

Procedure Patchlt: External:

PatchlIt;
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Macintosh™ Technical Notes G

#0: About Macintosh Technical Notes

Written by: Scott Knaster 2/10/85
Last Modified: 6/18/85

The first release of Technical Notes has been distributed; it included the following notes.
Those marked with a star (*) have been included with the May Software Supplement.

Number Title

0o* About Macintosh Technical Notes

1 Desk Accessories and System Resources
4 Error Returns from GetNewDialog

5 Using Modeless Dialogs from Desk Accessories
11 Memory Based MacWrite File Format

12 Disk Based MacWrite File Format

13 MacWrite Clipboard Format

15 Finder Update

16 * MacWorks XL

18 Text Edit Conversion Utility

20 Data Servers on AppleTalk

21 Quickdraw's Internal Picture Definition
32" Reserved Resource Types

Obviously, we're working on lots of other Notes (the numbering is consecutive!). If there

are any subjects which you would like to see treated in a technical note, please send us
a note at the address below.

We want Technical Notes to be distributed as widely as possible. The surest way to get
them is to subscribe, directly from Apple, for $20 per year. However, we're also going to
distribute Technical Notes to user groups and upload them to various electronic bulletin
board systems, and we're placing no restrictions on copying them (except that they may
not be resold). Also, Macintosh Registered Developers (i.e. people who have paid for
Macintosh technical support) will receive Technical Notes as part of their registration
fee.

To receive Macintosh Technical Notes for one year (12 packages, each package
containing approximately 10 notes), send $20 to

Macintosh Technical Notes
Apple Computer, Inc.
20525 Mariani Ave MS 4-T
Cupertino, CA 95014
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Remember that we're distributing our Technical Notes widely and we're encouraging
people to copy them, so you'll be able to obtain them from other sources as well;
subscribing ensures that you'll get them directly from Apple when they're published.

We hope that Macintosh Technical Notes will provide you with lots of valuable
information while you're developing Macintosh software.

Macintosh is a trademark licensed to Apple Computer, Inc.
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#16: MacWorks XL
See also: MacWorks XL Owner's Manual

Written by: Harvey Alcabes 14-May-85
Mark Baumwell

Apple is releasing MacWorks™ XL. This note describes some features of
this new version of MacWorks.

MacWorks XL

MacWorks is the software which allows a Macintosh XL (formerly called the Lisa 2/10)

or any other Lisa 2 system to run Macintosh software. Here's a quick summary of the
features of MacWorks XL:

Direct startup from the hard disk. If a Macintosh XL, Lisa 2/5, or Lisa 2/10 has a
hard disk dedicated to Macintosh software, the system boots up directly from power on.

For those Lisa systems with a shared disk, the Macintosh environment can now
be started with one diskette, like the other Macintoshes.

Support of AppleTalk™ Personal Network and the LaserWriter, in addition to
future Macintosh Office products.

Support of the parallel version of the Apple Dot Matrix Printer, for those Lisa
customers interested in using their printer with the Macintosh environment.

Upgrade Program

A copy of the released version of MacWorks XL will be included in the final update to
the Software Supplement in May. Supplement purchasers received a MacWorks XL
pre-release dated 12/10/84 in the December Software Supplement mailing.

Owners of the existing MacWorks product can upgrade to MacWorks XL by sending
one of the original MacWorks disk (Apple part number 682-0087B appears on the
label), $29 (California residents must add sales tax), and their name and address to:

Apple Computer Processing Center
Attn: MacWorks XL Upgrade Program
P.O. Box 6272

San Jose, CA 95150
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Macintosh XL Screen Modification

Users of graphics-oriented applications who are concerned about the aspect ratio of
the Macintosh XL screen (which currently displays 364 rows of 720 rectangular
pixels) may chose to purchase the Macintosh XL Screen Modification Kit (Apple part
number A6G0001). This kit is expected to be available through Apple dealers in June
and will include a copy of MacWorks XL along with parts for a modification to the
Macintosh XL hardware. A Macintosh XL with the modified hardware and MacWorks
XL software will display square pixels, producing the same aspect ratio as the 128K
and 512K Macintoshes. The 32 KBytes of Macintosh XL screen memory will be used
to display 431 rows of 608 square pixels.

A Macintosh XL modified in this way will no longer be able to run Lisa software
such as the Workshop development system or the Lisa 7/7 Office System. Also, it will
no longer have an imbedded serial number. The hardware modification will be
an option only available through dealers. The MacWorks XL software should work
properly on modified and unmodified machines.

Reading Machine Information

The word at location $400008 contains a ROM version number. On a 128K or 512K
Macintosh it contains $0069. The version number of MacWorks 1.0 (the version
released in 1984) is $70. The version number of MacWorks XL is $81 (note that the
December pre-release had the version number $80. Lisa Pascal users can identify the
machine and ROM version number by calling the following routine (found in
intrfc/OSIntf):

PROCEDURE Environs (VAR rom, machine: INTEGER);
where machine will be one of the constants macMachine Or macXLMachine.
An application should not assume anything about the screen size or aspect ratio based
on the hardware on which it is running. If aspect ratio information is needed the
program should use the words in low memory at ScrVRes ($102) and ScrHRes ($104),
which contain the screen dots per inch vertically and horizontally. A Lisa Pascal routine

will be included in the May Software Supplement to return these values. It will be
declared as follows:

PROCEDURE ScreenRes (VAR ScrVRes, ScrHRes: INTEGER);
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Screen Resolution Summary

The following table summarizes the information above; note that values preceded by a
"$" are hexadecimal, other values are decimal.

Macintosh 128
Macintosh 512

MacWorks (1.0)
MacWorks XL
unmodified hardware
modified hardware

Technical Note # 16

ROM
version
number
($400008)

$0069
$0069

$70FF

$81FF
$81FF

Dots perinch

Vertical
(ScrVRes)
($102)

72
72

60

60
72

page 3 of 3

Horizontal
(ScrHRes)
($104)

72
72

90

90
72

Pixels on screen

Vertical

342
342

364

364
431

Horizontal

512
512

720

720
608

MacWorks XL






Macintosh Technical Notes

#32: Reserved Resource Types
See also: Resource Manager: A Programmer's Guide

Written by:  Scott Knaster 5/13/85

Your applications and desk accessories can create their own resource types. To avoid
using type names which have been or will be used the system, Apple has reserved all
resource type names which consist entirely of lower-case ASCII characters ($61
through $7A) and "international" characters (greater than $7F).

In addition, Apple has reserved the following resource types which contain upper-case
characters and the # character:

ALRT BNDL CDEF CNTL CODE CURS
DITL DLOG DRVR DSAT FCMT FKEY
FOBJ FONT FREF FRSV FWID ICN#
ICON INIT INTL MACS MBAR MDEF
MENU MINI NBPC PACK PAPA PAT
PAT# PDEF PICT PREC SERD STR
STR# WDEF WIND

Note that most of these have been around for some time and should be familiar to you
already. This doesn't mean, of course, that you can't create your own resources of
these types; obviously, you will have your own CODE, MENU, WIND, and so on. This
list provides names which you should not use for new, custom resource types.
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C‘:Macintosh Update for End-Users

What's Included in This Document

This document has been extracted from the document titled Macintosh Update in the file named
What's New on the May 1985 System Update disk available to all Macintosh owners from Apple
dealers. It describes the new versions of the Finder and other system files. It also describes
ChoosePrinter desk accessory and the new Font/Desk Accessory Mover which lets you move
both fonts and desk accessories among disks.

Updating Your Existing Disks

The original Macintosh Update document described the System Update application. That
application does not always work properly when updating a System file that had been previously
modified. Instead of using System Update we recommend updating your disks by dragging the
System folder from the 5/85 Mac Build Disk to the disk you want to update and then reinstalling
any non-standard fonts or desk accessories. The new System folder contains Finder 4.1, a new
system file which includes the Choose Printer desk accessory, and a new Imagewriter file. If
you're using a hard disk with your Macintosh, be sure to update both the hard disk and any other
disk you use with it to start up your Macintosh.

About the New Finder

The Finder is the application you use to manage your Macintosh desktop. The new Finder
(version 4.1) is faster than the old version and it works better with hard disks. It also has some
added features such as the MiniFinder, which lets you move quickly between the applications and
documents you use most often. The new Finder works with any existing applications and
documents without your having to make any changes to them.

Full Capabilities in Any View

With the old Finder you could duplicate, move, rename, or discard documents, folders, and
applications only when directory windows were arranged by icon. With the new Finder you can
do any of your desktop work with your directories in any arrangement—by icon, name, date,
size, or kind. In any of the text views (any view other than by icon), a small icon appears to the
left of the document name. Click, double-click, drag, or Shift-click this icon just as you would
its counterpart in an icon view of the directory.

To rename a document when a directory isn't arranged by icon, select the name and edit it just as
you edit icon names in an icon view or on the desktop.

Directories in text views also indicate (with a small padlock on the right) which of your

documents are locked. If you lock a folder or if you physically lock the disk, the padlock
appears in the top left comer just below the title bar.
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& File Edit

View

Special

[ Update
Name Size Kind Last Modified
v i ot menmves g 30K document Mon, Apr 8, 1985
Font/DA Mover 25K application Mon, Apr 8, 1985
D Fonts 9K Font/DA Mover do... Mon, Apr 8, 1985
(O System Folder 166K folder Mon, Apr 8, 1985
D system Update 99K application Mon, Apr 8, 1985

Dragging Icons

In the past, you couldn't drag an icon to a "hollow" icon; you had to drag to the icon's directory

window. Now you can drag an icon either to a directory window or to the hollow icon that
remains behind when you open an icon. If you drag to a directory window, you can place the
icon wherever you want it; if you drag to a hollow icon, the Finder will place it in the next

available spot.
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Naming Icons

In the past, typing renamed any selected icon, whether you had explicitly clicked it or not. Now
you click explicitly on an icon or icon name to edit its name, even if the icon is already selected.
This means you're less likely to rename disks accidentally. There are a couple of exceptions:
When you create a new folder by choosing New Folder, or when you duplicate or move a
document, folder, or application, typing renames what's selected, without your having to click it
first. (This is true in text views as well.)

If you give an icon a name that's the same as an icon you just dragged to the Trash, the Trash is
automatically emptied, so you can use the name again.

Ejecting Disks

Now choosing Eject always ejects a disk (if one's inserted and it isn't a hard disk), even if none
is selected. The Finder looks for any inserted disk to eject. Choosing Eject again ejects any
other inserted disk.

If you want your Macintosh to forget about a disk (and not ask for it again), drag the disk to the
Trash. This doesn't erase the disk; it just ejects it and removes the icon from the desktop. You
can't drag the current startup disk to the Trash.

You can't edit an ejected disk's comment box (in the Get Info window) or that of any of the
documents on that disk.

The Apple Menu

About the Finder...

Choose Printer
Scrapbook
Alarm Clock
Note Pad
Calculator

Key Caps
Control Panel
Puzzile

The About the Finder Command

The About the Finder command in the Apple menu now tells you the memory size of the
Macintosh you're using. (Memory used for MacWorks is subtracted on a Macintosh XL.)

The Choose Printer Desk Accessory
The Choose Printer Desk Accessory is available in the Apple menu both in the Finder and in any

application you start using an updated startup disk. See "About the Choose Printer Desk
Accessory."
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The File Menu

ENta-ul Folder 3N

Bpea
Print

Close
Infp & ¢
Buplicate KR ]
Page Setup
Print Catalog
Eject XE
The New Folder Command

There's a new command —New Folder—in the File menu. Choosing this command creates a
new folder (so you no longer have to duplicate an existing folder). You can rename the folder
immediately after you create it, by typing the name you want. Rename it any other time by
selecting the name or icon and editing it in the usual way.

New folders appear in the frontmost window on the desktop. The command is dimmed if no
windows are open.

The Page Setup Command

The Page Setup command lets you set up the orientation and size of directories you print using
the Print Catalog command. In the Finder, this command works only with the Print Catalog
command; a document's page setup is controlled by the Page Setup command in the application.
Note that Close All and Put Back have been removed from the File menu.

The Print Catalog Command

There's a new Print Catalog command in the File menu that prints the contents of the active
directory window—in whatever view you have the directory arranged.
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The Special Menu

‘Cleaﬁp
Empty Trash
Frase Bisk
Set Startup
Use MiniFinder...

Shut Down

The Use MiniFinder Command

To move quickly between applications, you can now place the applications and documents you
use most often in the MiniFinder. Here's how to use the MiniFinder:

. In the Finder, select what you want to place in the MiniFinder.

You can select up to a total of twelve mixed or matched documents and applications. You might,
for example, select the applications you use most often, the documents you're currently working
on, or both. (You can easily change what's in the MiniFinder whenever you want.)

The documents and/or applications you select must all be in the same directory window. Drag
them there before you select them if necessary. Any application you need to work on your
MiniFinder documents must be on the same disk as the documents. You can move between
disks in the MiniFinder.

. Choose Use MiniFinder from the Special menu.

. Click Install.

The next time you start your Macintosh using this disk or quit an application on this disk, the
MiniFinder will appear instead of the usual desktop. (The spatial order of the applications and
documents in the MiniFinder corresponds to their order in the Finder.)

. Open an application or document that's installed in the MiniFinder by
selecting it and clicking the Open button or double-clicking the icon.

You can also click any of the other buttons on the right. Clicking Finder (or pressing the Enter
key) takes you back to the Finder. Open Other opens applications that aren't installed in the
MiniFinder (as well as those that are installed), whether they're on the same or other disks.
Clicking Shut Down ejects any inserted disks and restarts the Macintosh.

. To change what's in the MiniFinder, click the Finder button to return to
the Finder, select the applications and documents you want in the MiniFinder,
choose Use MiniFinder, and click Install.

. To stop using the MiniFinder, return to the Finder, choose Use
MiniFinder, and click Remove.

Dragging the MiniFinder icon to the Trash also removes the MiniFinder.
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You can install the MiniFinder on any of your disks that contain applications, even if they're not
startup disks. When you start up your Macintosh, it uses any MiniFinder it can find, even if it's
not on the startup disk.

The Shut Down Command

There's also a new command in the Special menu. Choosing Shut Down ejects any inserted
disks (first saving any necessary information) and then restarts the Macintosh. This is a shortcut
for when you want to restart the Macintosh using a different startup disk. On a Macintosh XL,
choosing Shut Down turns the power off, but not on again.

Lost Folders

If the Finder has an error and can't reconstruct your folders exactly as they were, the top level of
the folder hierarchy will be remembered (although the names will be lost and the folders will be
renamed Unnamed #1, #2, and so forth).

The Open... Dialog Box

When you choose Open within an application, a list of files appears for you to select from. In the
past, you could type a character to select the first document starting with that character (or the
first document to follow in alphabetical order). Now as you continue to type additional
characters, any file that matches the characters you type is found and selected. If you pause
while typing, the Finder considers the next character to be a new request, rather than a
continuation of your first request. The keyboard touch (which you set in the Control Panel)
determines how long the Finder waits for additional characters in a single request.

e e &

Ann Rev 2 | Open | Update
Ann Rev 3

Joe's Schedule | Eject |
Mail to Louella

Projects [ cancel | i | Drive |
Thanks to Sandy [

About the Choose Printer Desk Accessory

The Choose Printer desk accessory lets you print from any attached printer for which there is a
printing resource file on the current startup disk. (A printing resource file is a system file that
usually has the same name as the printer itself.)

If you're using an Imagewriter, you probably won't use the Choose Printer desk accessory. The
Macintosh is preset to print documents on an Imagewriter connected to the Printer port (Serial
port B on a Macintosh XL). You'll use Choose Printer only if you connect AppleTalk or another
piece of hardware to the Printer port and want to designate the Modem port for the Imagewriter.
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Port:

-

Q Cannec
@ Bisconnetind

( ok ] [ cancel | s

AppleTalk

Printers other than the Imagewriter, such as the LaserWriter, include disks containing a Printer
Install application that installs the printing resource file (sometimes called a "driver") for that
printer. Once you install the printer on a disk, it appears as a possible printer to use when you
choose Choose Printer.

About the Font and Desk Accessory Mover

As new fonts and desk accessories become available, you may want to add some of them to your
startup disks. But fonts and desk accessories can take up a fair amount of space on a disk, so
you probably won't want your complete set on every startup disk. The Font and Desk Accessory
Mover (Font/DA Mover) is an application for copying fonts and desk accessories among disks or
removing them from disks.

The Apple and Fonts menus in any application always contain the desk accessories and fonts in
the current startup disk's System file (a file in the System Folder). You can also store collections
of fonts and accessories in special font and desk accessory files the Macintosh uses just for that
purpose. When you want to use the fonts or accessories in those files with an application, you
use Font/DA Mover to add them to the System file of the startup disk you'll be using with that
application.

Using the Font/DA Mover to Add or Remove Fonts or Desk Accessories

. Open Font/DA Mover.

Select the icon and choose Open from the File menu, or just double-click the icon. Opening any
font or desk accessory file also opens Font/DA Mover automatically.

Font/DA Mover is included on the Update disk; you can open it there or copy it to any other disk.

See "Copying a Document, Folder, or Application to a Different Disk" in Macintosh, the owner's
guide.
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(o) Font
O Desk Accessory Mover
Chicago 12 [ fopy | ay
Geneva 9
Geneva 12 | Remoue |
Monaco 9
Monaco 12
New York 9
New York 12 Y 5
System
on Update [ Help ]
58K free
|  Close | ([ ouit | [ open... ]
. Click either the Font or the Desk Accessory button, depending on which

you want to add or remove.

The list on the left includes all fonts or desk accessories in the System file on the current startup
disk (whether it's in the internal or the external disk drive). The list on the right includes fonts
and desk accessories in the System file on any other inserted startup disk.

. Use the Open buttons to present lists of any other font and desk accessory
files on any inserted disk.

If necessary, first click Close to close the file currently displayed. Each Open button lets you

control what's displayed in its list. Both the file you're looking at and the disk it's on are shown
below each list.

Whenever you click an Open button, a dialog box with a list of files appears.

Use the Eject or Drive buttons to look at font and accessory files on other disks or other files on
the same disk. The name of the disk you're looking at is always shown in the top right.

If you have a one-drive system, clicking the Open button on the right side automatically presents

a list of font and accessory files on the same disk. If you want to look at another disk, click Eject
and insert the disk you want to work with.
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. Open the file you want to look at by selecting its name and then clicking
Open.

Sgstém [ Upen.rj Update

([ New | i Eject |

| Cancel | i | Drive |

You can look at and work with any existing System, font, or desk accessory files. The Taliesin
Font file on the Update disk contains a pictorial font you may want to add to some of your disks.

Or create a new file for your own collection of fonts or accessories by
clicking New, naming the file, and clicking Create.

New Font File Name: Update
Carol's |

E | Eject |
| Create | | Cancel | | Drive |

Select the fonts or desk accessories you want to copy or remove.

Chicago 12 O [ << Copy << | B
Geneva 9
Geneva 12 [ Remove |
Monaco 9
Monaco 12
New York 9 8074 bytes
New York 12 I selected o
System Fonts
on Paint [ Help ]! on Update
90K free 50K free
[ Close | ([ aquit |: [ Close |

Taliesin 18: Ee ® Mr—p—
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You can select from either list. Click to select a single font or accessory, hold down the Shift key
while you click additional single fonts or accessories, or drag to select a group. Shift-click to
deselect a selected file. The number of bytes selected is displayed as well as the amount of space
available on the disk. Both the name of the current file and the name of the disk it's on are
displayed below each list.

When a single font is selected, the name, size, and a sample of the font are shown at the bottom
of the window; when more than one font is selected, or when an accessory is selected, nothing is
displayed there.

. Click Copy to copy the selected fonts or accessories in the direction the
arrows point, or click Remove to remove the selected fonts or accessories.

This copies the fonts or desk accessories to the opposite file, or removes the fonts or accessories
from the file you opened. If you remove all fonts or accessories from a file, the file itself will be
gone the next time you click Open.

Only fonts and desk accessories in the current startup disk's System file are available to
applications you use with that disk.

. Click Quit.

In the Finder, you can drag any font or accessory files you no longer need to the Trash, or copy
or move these files between disks. See "Copying a Document, Folder, or Application toa
Different Disk" or "Moving a Document, Folder, or Application to a Different Disk" in
Macintosh, the owner's guide. Opening any font or accessory file automatically opens Font/DA
Mover.

-
1]l

Carol's

You can have only as many fonts available at one time in an application as will fit in the
application's Font menu. (This number varies, depending on the application.) You're limited to
15 desk accessories in a disk's System file.

You can use Font/DA Mover to create an auxiliary set of fonts or accessories. Later you can
move the current System file fonts or accessories to another font or accessory file you create, and
then copy your auxiliary file to your System file. You can alternate between the two fonts files
(or any others you create) whenever you want.
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Trap List

June 14, 1985

The attached document, Trap List. is an update of the February 18 list. Minor changes were made in
order to make the list more accurate. It is a list of traps including the following:

* The trap or routine name as it is described from Pascal. (the exception is the low level File
Manager calls which are shown in pascal form, with the actual trap name.)

* The trap word where it applies.
* The section in Inside Macintosh where it is discussed.

* The "x" shows whether the routine allocates or moves objects on the heap. This means it
eventually invokes one of the following traps: MoreMasters, NewHandle, SetHandleSize,
ReallocHandle, NewPtr, SetPtrSize. What this means is the following:

> If a handle has been dereferenced, as in a WITH statement, and you call one of these

routines, the handle may become invalid. THE HANDLE SHOULD BE LOCKED
before dereferencing it.

>If you are using a dereferenced handle for the result of a function, like
MyRecHndlM. width := TextWidth(textbuf,firstbyte,count). The expression on the right is
evaluated (dereferenced) first, then the function is called. Since TextWidth can cause an

allocation of memory, the handle may become invalid. THE HANDLE SHOULD BE
LOCKED before dereferencing it.

>If you pass a dereferenced handle to a procedure in the same segment, as in
Foo(MyRecHndI*, width,stuff), and that procedure calls on of these routines, the handle
can become invalid. THE HANDLE SHOULD BE LOCKED before
dereferencing it. Also, if you pass a dereferenced handle to a procedure in a different
segment and the Segment Loader has to load that segment, the handle can become invalid.
Lock it before dereferencing.

> Finally, if you pass a dereferenced variable to one of these routines, it can become invalid.
THE HANDLE SHOULD BE LOCKED before dereferencing it.

This column does not indicate whether the routine allocates objects on the stack, like
DrawString. (By the way, if you received the previous version of this list, please notice that the
list no longer specifies whether a routine deallocates space on the heap.)

* Finally, it includes a list of what other traps are called by the routine, and what circumstances
under which they are called. I tried to be as accurate as possible.

If there are any questions or comments please write to us at

Macintosh Technical Support
Apple Computer
10525 Mariani Ave. MS-4T
Cupertino, CA 95014






Name
AddDrive
AddPt
AddReference
AddResMenu

AddResource
Alert

Allocate
AngleFromSlope
AppendMenu
ApplicZone
AsmClikLoop
AsmWordBreak
ATPAddRsp

ATPCloseSocket
ATPGetRequest

ATPLoad

ATPOpenSocket
ATPReqCancel

ATPRequest
ATPResponse
ATPRspCancel
ATPSndRequest

ATPSndRsp

ATPUnload
BackColor
BackPat
BeginUpdate
BitAnd
BitClr
BitNot
BitOr

BitSet
BitShift
BitTst
BitXOr
BlockMove
BringToFront

Button

Trap List

Trap
AO4E
A8TE
A9AC
A94D

A9AB
A985

ABC4
A933

AB63
AR7C
A922
AB8S8
A8SF
ABS5A
A85B
A8SE
AB5C
A85D
AB859
AG2E
A920

A974

Doc

QD

AT
AT

AT

2 5242232235663

Trap List

Traps Called

Enqueue

none
GetHandleSize,SetHandleSize,GetHandleSize,GetEOF,SetEOF
SetResLoad,CountResources,GetIndResource,NewHandle,
EmptyHandle,GetResInfo,NewHandle,EmptyHandle,
GetResInfo,AppendMenu,GetHandleSize,SetHandleSize,
CalcMenuSize

none
GetResource,FlushEvents,NewDialog,GetPort,SetPort,Getlcon,
PlotIcon,GetDItem,PenSize, InsetRect, FrameRoundRect,InsetRect,
ModalDialog,SetPort,DisposeDialog

Allocate

none

GetHandleSize,SetHandleSize,CalcMenuSize

none

none

none
CountResources,GetIndResource,DisposeHandle,HLock,Control,
HUnlock
CountResources,GetIndResource,DisposeHandle,Control
CountResources,GetIndResource,DisposeHandle, HUnlock,HLock,
HUnlock,PostEvent,HUnlock,Control
CountResources,GetIndResource,DisposeHandle,Open,Open
CountResources,GetIndResource,DisposeHandle,Control
CountResources,GetIndResource,DisposeHandle, HUnlock,HLock,
HUnlock,PostEvent,HUnlock,Control,Control
CountResources,GetIndResource,DisposeHandle, HUnlock,HLock,
HUnlock,HUnlock,DisposeHandle
CountResources,GetIndResource,DisposeHandle, HLock,HUnlock,
DisposeHandle,HUnlock
CountResources,GetIndResource,DisposeHandle, HLock,HUnlock,
PostEvent,HUnlock,Control,Control,
CountResources,GetIndResource,DisposeHandle, HUnlock,HLock,
HUnlock,HUnlock,PostEvent, HUnlock,Control,Control
CountResources,GetIndResource,DisposeHandle, HUnlock,HLock,
HUnlock,HUnlock,PostEvent, HUnlock,Control,Control, HUnlock,
HUnlock,PostEvent,HUnlock
CountResources,GetIndResource,DisposeHandle,Close

none

none

OffsetRgn,CopyRgn,SectRgn,OffsetRgn,SetEmptyRgn

none

none

none

none

none

none

none

none

none

NewRgn,OffsetRgn,DiffRgn,UnionRgn,CalcVis,DisposeRgn,SetPort,

window is already in front then only SetPort
none, Control if journaling
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CalcMenuSize

CalcVis
CalcVisBehind
CautionAlert

Chain

ChangedResource
CharWidth
Checkltem
CheckUpdate

ClearMenuBar
ClipAbove
ClipRect
CloseDeskAcc
CloseDialog
CloseDriver
ClosePicture
ClosePoly
ClosePort
CloseResFile

CloseRgn
CloseWindow

ClrAppFiles
ColorBit
CompactMem
Control
CopyBits
CopyRgn
CouldAlert

CouldDialog

CountAppFiles
CountMItems
CountResources
CountTypes
Create
CreateResFile

CurResFile
Date2Secs
DDPCloseSocket
DDPOpenSocket

DDPRdCancel

Trap List

A948

AS0A
A988

ASF3

A9AA
A88D
A9%45
A911

A934
A90B
A87B
A9B7
A982

ABF4

ABCC
AB7D
AS9A

A8SDB
A92D

AB64
A04C

ABEC
A8DC
A989
A979
A950
A99C
AS9E
A9B1

A99%4
A9C7

DL

SL

QD

QD
DS

DL

DM
QD
QD
QD

QD

SL
QD
DM
QD
QD
DL

DL

AT

AT

o

oM o

EL I I

L

E I I T B

LoadResource, then calls menu def. proc. for ea. menu item
(GetPort,SetPort, TextFace,StringWidth, TextFace,SetPort)
SectRgn,OffsetRgn, SetEmptyRgn (if window invisible)

CalcVis, SectRect if more than 1 window in list
GetResource,FlushEvents,NewDialog,GetPort,SetPort,GetIcon,
Ploticon,GetDItem,PenSize,InsetRect,FrameRoundRect,InsetRect,
ModalDialog,SetPort,DisposeDialog

BlockMove,if current app then CloseResFile,BlockMove,InitApplZone,
NewHandle,BlockMove,RDrvrlnstall, then OpenResFile,SysError if bad
open,GetResource,BlockMove,ReleaseResource
GetHandleSize,SetHandleSize,GetEOF,SetEOF

TextWidth

SetItemMark

GetPort, if more than 1 port then EmptyRgn,SetPort,NewRgn,
GetClip,RectRgn, if picture assoc. w/window needs update
BeginUpdate,DrawPicture, EndUpdate, then SetClip,DisposeRgn,
SetPort

none

SectRgn

RectRgn

Close
SetEmptyRgn,GetPort,SetPort,LoadResource,DisposeHandle,Close Window
Close
StdPutPic,SetHandleSize,DisposeRgn,DisposeHandle,ShowPen
SetHandleSize,ShowPen

DisposeRgn (2 for clip & vis rgns)
UpdateResFile,ReleaseResource,Close,DisposeHandle,SetGrowZone,
LodeScrap,SetVol

ShowPen,SetHandleSize,DisposeHandle
FrontWindow,KillControls,LoadResource,ShowHide,DiposeHandle,
DisposeRgn(3),ClosePort,KillPicture,SetPort, FrontWindow,
HiliteWindow,SetPort

GetHandleSize

none

BlockMove

BlockMove,Control

ShieldCursor,StdBits,ShowCursor

SetHandleSize

GetResource(dialog),GetResource(itemn list),LoadResource(for each
item in the list),GetResource(defprocs)
GetResource(dialog),GetResource(item list),LoadResource,
GetResource

GetHandleSize

none

none

none

Create,GetFileInfo,SetFileInfo

OpenREF to see if the file exists,Create,OpenRF,GetEOF, Write,Close
if errors

none

none

CountResources,GetIndResources,DisposeHandle,Control,
HUnlock,HUnlock
CountResources,GetIndResources,DisposeHandle,HUnlock,
PostEvent,HUnlock,Control
CountResources,GetIndResources,DisposeHandle, HUnlock,DisposeHandle
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DDPRead
DDPWrite

Delay
DeleteMenu
DeltaPoint
Dequeue
DetachResource
DialogSelect

DiBadMount
DiffRgn

DIFormat
DILoad
Disableltem
DiskEject
DisposDialog
DisposeControl

DisposeMenu
DisposeRgn
DisposeWindow
DisposHandle
DisposPtr
DIUnLoad
DIVerify
DIZero
DlgCopy
DlgCut
DigDelete
DlgPaste
DragControl

DragGrayRgn

DragWindow

DrawChar
DrawControls

DrawDialog

DrawGrowlcon
DrawMenuBar

Trap List

AO03B
A936
A94F
A96E
A992
A980

ABE6

A93A

A983
A955

A932
A8D9
A914

A023
AOQ1F

A967
A926

A925

AB83

A969

A981

A904
A937

AT
AT

OS

oS

DL

QD

DL

E

bbbt opd D Dd D4 Mo p R M M

>

CountResources,GetIndResources,DisposeHandle, HUnlock,
NewHandle,HLock,HLock,HUnlock
CountResources,GetIndResources,DisposeHandle,HUnlock,
NewHandle,HLock,Control, HUnlock,PostEvent, HUnlock

none

none

none

none

none

GetResource,FrontWindow,(BegininWind),BlockMove,if mouse event
then GlobalToLocal,For each item LoadResource,PtInRect,if control
FindControl, TrackControl,if not TEClick, If it was an update then
BeginUpdate,DrawDialog,EndUpdate,if activate event then SetPort,
TEActivate if edit field & active, TEDeactivate if not, if KeyDown
event then TEKey, if it was a TAB then TEDeactivate, TECalText,
TEActivate,If event really didn't do anything then TEIdle, then
finally SetPort

Pack 2
EqualRgn,CopyRgn,SetEmptyRgn,RectRgn,NewHandle,SetHandleSize,
DisposeHandle

Pack 2

Pack 2

none

Eject,Control

CloseDialog,DisposeHandle,DisposePtr
GetPort,SetPort,NewRgn,LoadResource,SetPort,EraseRgn,InvalR gn,
DisposeRgn,GetPort,SetPort,LoadResource,SetPort

DisposeHandle

DisposeHandle

CloseWindow,DisposePtr

Syserror if failed, none otherwise

Syserror if failed, none otherwise

Pack 2

Pack 2

Pack 2

TECopy

TECut

TEDelete

TEPaste
GetPort,SetPort,GetPort,SetPort,LoadResource,SetPort, NewRgn,
DragTheRgn,DisposeRgn,MoveControl,SetPort
GetPenState,PenPat,PenMode,NewRgn,CopyRgn,InsetRgn,DiffRgn,
DisposeRgn,PaintR gn,GetMouse,PtInRect,PaintRgn,WaitMouse,
PaintRgn,SetPenState,PtInRect, MoveWindow,DisposeRgn,SetPort
WaitMouse,SetClip,GetKeys,NewRgn,CopyRgn,DragGreyRgn,
MoveWindow,DisplayRgn,SetPort

StdText

GetPort,SetPort,GetPenState, PenNormal,GetPort,SetPort, then calls
appropriate Control def. proc for each control in the list,and

finally SetPort,SetPenState,SetPort

GetPort,SetPort,locks item list,LoadResource,TECalText,
DrawControls,L.oadResource,DisposeHandle,DisposeControl,HandToHar
HLock,Munger,GetHandleSize, TextBox,DisposeHandle,PenSize,
InsetRect,FrameRoundRect,SetPort
SetPort,CopyBits,MoveTo,LineTo,MoveTo,LineTo,LineTo
SetRecRgn,EraseRountRect,MoveTo,LineTo,ClipRect,then MoveTo &
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DrawNew

DrawPicture
DrawString
DrawText
DriveStatus
Drvrlnstall
DrviRemove
Eject
EmptyHandle
EmptyRect
EmptyRgn
Enableltem
EndUpdate
Enqueue
Environs
EqualPt
EqualRect
EqualRgn
EqualString
EraseArc
EraseOval
ErasePoly
EraseRect
EraseRgn

EraseRoundRect

ErrorSound
EventAvail

ExitToShell
FillArc
FillOval
FillPoly
FillRect
FillRgn
FillRoundRect
FindControl

FindWindow
FixMul
FixRatio
FixRound
FlashMenuBar

FlushEvents
FlushVol
FMSwapFont

ForeColor
FrameArc

FrameOval
FramePoly

Trap List

ASOF

ABF6
AB84
AB8S5

A03D
AO3E

A02B
ABEA
ABE2
A939
A923
A96F

A881

ABA6
A8E3
A03C
ABCO
A8B9
ABC8
ABA3
A8DA4
A8B2
A98C
A971

A9F4
A8C2
ABBB
ABCA
ABAS
ABD6
ABB4
A96C

A92C
AB68
A869
AB6C
A94C

A032
A901
A862
ABBE

A8B7
ABC6

QD
QD
QD
DD

PO e M

L T T I

2

SL «x
QD «x
QD «x
Qb «x
QDb «x
QD x
QD «x
CM «x
WM
TU
TU
TU
MN x
OSEM
FL X
FM x
QD
QD «x
Qb «x
QD «x

DrawString for each menu,SetPort, if a menu item is disabled it
calls PenMode,PenPat,PaintRect,PenNormal, and if it is hilited
InvertRect
UnionRgn,PaintOne,PaintBehind,CalcVBehind,DisposeRgn, XOrRgn if
invisible

See page 16 for complete list.

StdText

StdText

Status,BlockMove

NewHandle

ReleaseResource,DisposeHandle

Eject

none

none

EmptyRect

none

OffsetRgn,CopyRgn,SetEmptyRgn

none

none

none

none

none

CmpString

StdArc

StdOval

StdPoly

StdRect

StdRgn

StdRRect

none

If Event in queue then OSEventAvail (if window activated or
deactivated),GetOSEvent,SystemEvent, If no Event then GetOSEvent,
CheckUpdate,GetMouse

Launch on Finder

StdArc

StdOval

StdPoly

StdRect

StdRgn

StdRRect

GetPort,SetPort,then PtInRect & TestControl for each control in
the list, then SetPort

PtnRgn

LongMul

none

none
HandToHand,SetClip,SetRectRgn,InvertRoundRect,InvertRect (if menu
item inverted),SetPort,CopyRgn,DisposeRgn

none

FlushVol
FixRatio,FixMul,FixRound,GetResource,FixRatio,FixMul,BlockMove,
Status(if device changed)

none

StdArc

StdOval

StdPoly
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FrameRect A8A1 QD x StdRect

FrameRgn A8D2 QD x StdRgn

FrameRoundRect ABB0 QD x StdRRect

FreeAlert A9BA DL x foritem list & alert GetResource,unlocks it,GetResAttrs(to make
purgeable),LoadResource,DisposeHandle,DisposeControl, HandToHand,
HLock,Munger,GetHandleSize, TextBox,DisposeHandle,PenSize,
InsetRect,FrameRoundRect

FreeDialog A97A DL x  GetResource(the dialog),GetResAttrs(make purgeable),GetResource
(the item list),GetResAttrs(make purgeable)

FreeMem A0IC MM none

FrontWindow A924 WM none

FSClose FL Close

FSDelete FL Delete

FSOpen FL Open

FSRead FL Read

FSWrite FL Read,Write

GetAlrtStage DL none

GetAppFiles SL GetHandleSize,BlockMove

GetApplLimit none

GetAppParms A9F5 SL BlockMove

GetCaretTime EM none

GetClip A87A QD x CopyRgn

GetCRefCon A95A CM none

GetCTitle A9SE CM BlockMove

GetCtlAction A9%A CM none

GetCtlMax A9%2 CM none

GetCtlMin A9%61 ™M none

GetCtlValue A9%0 CM none

GetCursor A9B9 TU x GetResource

GetDateTime oS none

GetDblTime EM none

GetDCtEntry x Status

GetDItem A98D DL x GetPort,SetPort,LoadResource,SetPort

GetDrvQHdr FL none

GetEOF FL GetEOF

GetEvQHdr 0S none

GetFInfo FL GetFilelnfo,BlockMove

GetFNum A0 FM x  GetNamedResource,GetResInfo

GetFontInfo A88B FM x StdTxMeas

GetFontName ABFF FM x  GetResource,GetResInfo

GetFPos FL GetFPos

GetFSQHdr FL none

GetHandleSize A025 MM none

Getlcon A9BB TU x GetResource

GetIndPattern TU x  GetResource,BlockMove

GetIndResource A9%9D RM x ReadNewHandle,Read Read

GetIndString TU x  GetResource,BlockMove

GetIndType A%F RM none

Getltem A%46 MN BlockMove

GetltemIcon A93F MN none

GetltemMark A%43 MN none

GetltemStyle A941 MN none

GetIText A990 DL GetHandleSize,BlockMove

GetKeys A976 EM x none, Control if journaling

GetMenu A9BF MN x GetResource,CalcMenuSize

GetMenuBar A93B MN x NewHandle,BlockMove
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GetMHandle
GetMouse

GetNamedResource

GetNewControl
GetNewDialog
GetNewMBar

GetNewWindow
GetNextEvent

GetNodeAddress
GetOSEvent
GetPattern
GetPen
GetPenState
GetPicture
GetPixel
GetPort
GetPurSize
GetResAttrs
GetResFileAttrs
GetResInfo
GetResource

GetScrap
GetSoundVol
GetString
GetSysPPtr
GetTime
GetTrapAddress
GetVBLQHdr
GetVCBQHdr
GetVInfo
GetVol
GetVRefNum
GetWindowPic
GetWMgrPort
GetWRefCon
GetWTitle
GetZone
GlobalToLocal
GrafDevice
GrowWindow

GZCritical
GZSaveHnd
HandAndHand
HandleZone
HandToHand

HideControl

HideCursor
HidePen

Trap List

A949
A972
A9A1
A9BE
A97C
A9CO

ASBD
A970

A031
A9B8
AB9A
AB98
A9BC
A865
A874
A021
ASBA6
A9F6
AOAS
A9AQ

A9FD

A9BA

A046

A92F
A910
A917

A919
AO1A
A871

ABT72
A92B

A9E4
A026
A8El

A958

ABS2
AB96

E T I

2§

OSEM

0OS x

OS «x

QD
QD

none

GlobalToLocal,Control if journaling

CmdString,

GetResource,NewControl,ReleaseResource
GetResource,NewDialog
GetMenuBar,ClearMenuBar,GetResource,InsertMenu,GetMenuBar,
ReleaseMenu,SetMenuBar,DisposeHandle

GetResource NewWindow,ReleaseResource

If Event in queue then OSEventAvail (if window activated or
deactivated),GetOSEvent,SystemEvent, If no Event then GetOSEvent,
CheckUpdate,GetMouse

CountResources,GetIndResources

OSEventAvail,Dequeue

GetResource

none

none

GetResource

HideCursor,ShowCursor

none

none

none

none

none

Read,NewHandle,RsrvMem,AllocHandle, if no hand & no load
NewHandle,EmptyHandle

Read,BlockMove,SetHandleSize

none

GetResource

none

ReadDateTime,Secs2Date

none

none

none

GetVolInfo

GetVol

none

none

none

none

none

none

none

none
SetClip,ClipAbove,GetPenState,PenNormal,PenMode,PenPat,OffsetRect,
LoadResource,DeltaPoint,GetMouse,PInRect, WaitMouseUp,SetPenState,
SetPort

none

none

GetHandleSize,SetHandleSize,BlockMove

none
GetHandleSize,NewHandle,BlockMove,SetHandleSize,BlockMove,
NewHandle,BlockMove

GetPort,SetPort,NewR gn,GetPort,SetPort, LoadResource,SetPort,
EraseRgn,InvalRgn,DisposeRgn,SetPort

none

none
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HideWindow
HiliteControl

HiliteMenu
HiliteWindow
HiWord
HLock
HNoPurge
HomeResFile
HPurge
HUnlock
InfoScrap

InitAllPacks(InitMath)

InitApplZone
InitCursor
InitDialogs
InitFonts
InitGraf
InitMenus

InitPack
InitPort
InitQueue

InitResources

InitUt]
InitWindows

InitZone
InsertMenu
InsertResMenu

InsetRect
InsetRgn

InvalRect
InvalRgn
InvertArc
InvertOval
InvertPoly
InvertRect
InvertRgn
InvertRoundRect
ISATPOpen
IsDialogEvent
IsMPPOpen
TUCompString
IUDatePString
IUDateString
TUEqualString
IUGetIntl
TUMagIDString
[UMagString
IUMetric

Trap List

A916

A9SD

A938
A91C
AB6A
A029
AM4A
A9A4
A049
AO2A
A9F9
ASE6
A02C
A850
A97B
ABFE
AB6E
A930

A9ES
AB6D
AO16
A995

AO3F
A912

A019
A935
A951

ABA9S
AB8E1

A928
A927
A8Cl1
ABBA
A8C9
A8A4
A8DS
A8B3

A97F

QD
QD

QD
QD
QD
QD
QD
QD
AT
DL
AT
PK
PK
PK
PK
PK
PK
PK
PK

I T T B B R ]

PO e o

FrontWindow,ShowHide,FrontWindow, SelectWindow on the front windov

if there is one.

GetPort,SetPort,LoadResource if control def proc needs loading,

calls def proc for each control,SetPort

ClipRect,InvertRect, InvertRect,SetPort

SetPort,SetClip,ClipAbove,SetPort

none

none

none

none

none

none

none

InitPack

FlushVol,RsrcZoneInit,InitZone,InitMath

none, falls into ShowCursor

none

BlockMove,GetResource

none

NewHandle,ClearMenu,DrawMenuBar,SetRecRgn,EraseRoundRect,

MoveTo,LineTo,ClipRect,SetPort

SetResLoad,GetResource,SetResLoad

RectRgn,CopyRgn

none

NewHandle,OpenRF,GetEOF,SetHandleSize,Close & DisposeHandle if

failed Read

none

GetPattern,NewPtr,OpenPort,PaintRect,FillRoundRect,DrawMBar,

NewRgn,HidePen,OpenRgn,FrameRoundRect,CloseRgn,ShowPen,

DiffRgn,SetClip,ShowCursor,NewRgn

MoreMasters

TextFont, TextFace,StringWidth,SetPort
SetResLoad,CountResources,GetIndResource,GetResInfo,

CalcMenuSize,AppendMenu,Munger

none

InsetRect if rectangular, else NewHandle,DisposeHandle,
SetHandleSize

NewRgn,RectRgn,DisposeRgn
OffsetRgn,UnionRgn,DiffRgn,OffsetRgn

StdArc

StdOval

StdPoly

StdRect

StdRgn

StdRRect

CountResources,GetIndResources

FrontWindow,FindWindow

CountResources,GetIndResources

Pack 6

Pack 6

Pack 6

Pack 6

Pack 6

Pack 6

Pack 6

Pack 6
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IUSetIntl PK x Packé6

ITUTimePString PK x Packé6

IUTimeString PK x Pack6

KillControls A956 CM x DisposeControl for each control in the list

KilllO DM Killlo

KillPicture A8F5 QD x DisposeHandle

KillPoly AS8CD QD x DisposeHandle

LAPCloseProtocol AT x  CountResources,GetIndResources,DisposeHandle,Control

LAPOpenProtocol AT x  CountResources,GetIndResources,DisposeHandle,Control

LAPRdCancel AT x  CountResources,GetIndResources,DisposeHandle, HUnlock,
HUnlock,DisposeHandle

LAPRead AT x  CountResources,GetIndResources,DisposeHandle,HLock,
NewHandle,HLock,HUnlock,HUnlock

LAPWrite AT x  CountResources,GetIndResources,DisposeHandle, HLock,
NewHandle,HLock,PostEvent,HLock,
HUnlock,Control,Control

Launch ASF2 SL  x BlockMove,if current app then CloseResFile,BlockMove,InitApplZone,
NewHandle,BlockMove,RDrvrlnstall, then OpenResFile,
SysError if bad open,GetResource,BlockMove,ReleaseResource,

Line A892 QD x LineTo

LineTo A891 QD x StdLine

LoadResource A9A2 RM x GetNamedResource(if the resource name is given),GetResource(if you
only have ID),if loading Read,RsrvMem,ReallocHandle,NewHandle(if
there isn't already one),Read, if no hand & no load NewHandle,
EmptyHandle

LoadScrap A9FB SM x NewHandleRead

LoadSeg A9F0 SL  x GetResource, SysError if error (locks segment as loaded, launches
if necessary)

LocalToGlobal A870 QD none

LongMul A867 TU none

LoWord A86B TU none

MapPoly A8FC QD MapRect,MapPt

MapPt A8F9 QD none

MapRect AS8FA QD MapPt

MapRgn ASFB QD x MapRectNewHandle,MapPt,SetHandleSize,DisposeHandle

MaxApplZone MM none

MaxMem A0OID MM x none

MemError MM none

MenuKey A93E MN x HiliteMenu,SystemMenu(if desk Acc.),BlockMove

MenuSelect A93D MN x HiliteMenu,WaitMouseUp,GetPort,SetPort,ClipRect,GetMouse,ClipRect

ModalDialog A991 DL x SystemTask,GetNextEvent,FrontWindow, calls filter proc,
IsDialogEvent,DialogSelect

MoreMasters A036 MM x BlockMove if needed

Move A894 QD none

MoveControl A959 CM x HideControl,OffsetRect,ShowControl

MoveHHi MM x CompactMem,BlockMove,EmptyHandle

MovePortTo A877 QD none

MoveTo AB93 QD none

MoveWindow A91B WM x SetClip,ClipAbove,NewRgn,SectRgn,HandToHand,DeltaPoint,OfsetRgn,
OfsetRect,SetClip if bringing to front,CopyBits,DiffRgn,
PaintBehind FrontWindow,HiliteWindow,PaintOne,UnionRgn,
CalcVBehind,DisposeRgn,SetPort

MPPClose AT x  CountResources,GetIndResources,Close

MPPOpen AT x  CountResources,GetIndResources,Open

Munger A9E0 TU x GetHandleSize, for insert SetHandleSize,BlockMove, For delete &

finding substrings BlockMove,SetHandleSize
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NBPConfirm

NBPExtract
NBPLoad
NBPLookup

NBPRegister

NBPRemove
NBPUnload
NewControl

NewDialog

NewHandle

NewMenu
NewPur
NewRgn
NewString
NewWindow

NoteAlert

NumToString
ObscureCursor
OffsetPoly
OffsetRect
OffsetRgn
OpenDeskAcc
OpenDriver
OpenPicture
OpenPoly
OpenPort
OpenResFile

OpenRgn
OSEventAvail

PackO (not used)

Pack1 (not used)
Pack2

Pack3 (std file)

Pack4 (floating pt)
PackS5 (transcendentals)
Pack6 (Int'l)

Trap List

A954

A022

A931
AOIE
ABDS8
A906
A913

A987

AB56
A8CE
ABAS
ABE(
A9B6

ABF3
ABCB
ABGF
A997

A8SDA
A030
ASE7
A9E8
A9E9
ASEA
ASEB
ASEC
ASED

AT X
AT X
AT x
AT X
AT X
AT x
AT x
CM x
DL X
MM x
MN x
MM x
QD x
‘"TU x
WM x
DL «x
PK p 4
QD
QD
QD
QD
DS X
DM
QD «x
QD «x
QD «x
RM x
QD «x
OSEM
PK X
PK X
PK b {
PK X
PK X
PK x
PK X

CountResources,GetIndResources,DisposeHandle,DisposeHandle,
Control,Hlock,NewHandle,HLock,NewHandle,HLock, Control,
Control, HUnlock,HUnlock,PostEvent,

HUnlock

CountResources,GetIndR esources,DisposeHandle
CountResources,GetIndResources,DisposeHandle,Control
CountResources,GetIndResources,DisposeHandle,DisposeHandle,
Control,Hlock,NewHandle,HL ock,NewHandle,HIock,Control,
Control,HUnlock,HUnlock,PostEvent,

HUnlock
CountResources,GetIndResources,DisposeHandle,DisposeHandle,
Control,Hlock,NewHandle,HL.ock,NewHandle,HLock,Control,
Control,HUnlock,HUnlock,PostEvent, HUnlock
CountResources,GetIndResources,DisposeHandle,Control
CountResources,GetIndResources,DisposeHandle,Control
NewHandle,SetCTitle,GetResource,GetPort,LoadResource,locks handle
to proc,SetPort,calls def proc to draw control,unlocks handle,

then SetPort

NewPtr if no wstorage given, BlockMove, NewWindow,GetPort,SetPort,
TENew,DisposeHandle,SetPort,GetPort,SetPort,LoadResource,
TECalText,PrToHand(if text),GetResource(if pic or icon),
GetNewControl,MoveControl,(if control), ValidRect(if control),
RsrvMem(to alloc as low as possible),SysError if failed, BlockMove
if needed

NewHandle,GetResource

SysError if failed, BlockMove if needed, none otherwise
NewHandle

PuToHand

OpenPort,MovePort,PortSize,SetPort NewRgn,GetResource,
NewString,StringWidth, windowdefproc called twice,
FrontWindow,PaintOne,CalcVBehind,SetPort.
GetResource,FlushEvents, NewDialog,GetPort,SetPort,GetIcon,
PlotIcon,GetDItem,PenSize,InsetRect,FrameRoundRect, InsetRect,
ModalDialog,SetPort,DisposeDialog

Pack 7

none, falls into HideCursor

none

none

none

Open,SelectWindow,ShowWindow

none

HidePen,NewHandle,NewRgn,StdPutPic

HidePen NewHandle

NewHandle (2 for the clip & vis rgns)
NewHandle,OpenRF,GetEOF,Close & DisposHandle if failed, Read,
SetHandleSize,Read,SetHandleSize,load preload resources,
GetResource,GetNamedResource,NewHandle,ReAllocHandle,RsrvMem,
NewHandle,HidePen

PostEvent

LoadResource, SysError if no pack

LoadResource, SysError if no pack

LoadResource, SysError if no pack

LoadResource, SysError if no pack

LoadResource, SysError if no pack

LoadResource, SysError if no pack

LoadResource, SysError if no pack
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Pack?7 (conversions) AS9EE
PackBits ABCF
PaintArc A8BF
PaintBehind A90D
PaintOne A90C
PaintOval A8BS8
PaintPoly A8C7
PaintRect A8A2
PaintRgn A8D3
PaintRoundRect A8B1
ParamText A98B
PBAllocate (_Allocate) A010
PBClose (_Close) A001
PBControl (_Control) A004
PBCreate (_Create) AQ08
PBDelete (_Delete) AQ009
PBEject (_Eject) A017
PBFishFile ( FlushFile) A045
PBFishVol ( FlushVol) A013
PBGetEOF (_GetEOF) AO011
PBGetFInfo (_GetFileInfo) AOOC
PBGetFPos (_GetFPos) AO018

PBGetVInfo ( GetVollnfo) AQ07
PBGetVol ( GetVol) A014
PBKIilIO (_KillIO) A006
PBMountVol( MountVol) AOOF

PBOffLine (_Offline) A035
PBOpen (_Open) A000
PBOpenRF (_OpenRF)  AOOA
PBRead (_Read) A002
PBRename (_Rename) AOOB

PBRstFLock(_RstFilLock) A042
PBSetEOF ( SetEOF) A012
PBSetFInfo ( SetFilinfo) AO00OD
PBSetFLock( SetFilLock) A041
PBSetFPos ( SetFilPos) A044
PBSetFVers ( SetFilType) A043
PBSetVol (_SetVol) A015
PBStatus (_ Status) AQ005
PBUnmountVol ( UnmountVol)

AQOE
PBWrite ( Write) A003
PenMode AB9C
PenNormal A89E
PenPat A89D
PenSize AB9B
PicComment A8F2
PinRect A94E
Ploticon A94B
PortSize AB76
PostEvent AO2F
PrCfgDialog

Trap List

PK

QD

foyore
FTLLT-F:
P o D4 e M M

dEppaddandadd

)
<

AEgEgamgd @ d@d &

o]
g6686eH E

ek

o]
o

OSEM
PR

E ]

LoadResource, SysError if no pack

none

StdArc
CopyRgn,NewRgn,ClipAbove,CopyRgn,DiffRgn,ClipRect,EraseRgn,
DisposeRgn

SectRgn,EmptyRgn,NewRgn,DisposeRgn, and if updating UnionRgn.
StdOval

StdPoly

StdRect

StdRgn

StdRRect

NewString,DisposeHandle

Enqueue

Enqueue,Read,Write

LoadResource if driver was purged, SysError if error
Enqueue,CmpString, Write,Read

Enqueue

FlushVol,DisposePtr,Control

Enqueue,Read,Write

Enqueue, Write,DisposePtr,Dequeue

SysError if error, none otherwise

Enqueue,CmpString, Write,Read

falls through SetFPos

Enqueue,CmpString

Enqueue

SysError if error, none otherwise
Enqueue,NewPtr,Write,Read,NewPtr,Status,DisposePtr,SysError if
error, Offline if not enough room & a vol has to go
FlushVol,Enqueue,DisposePtr,Dequeue,Enqueue,Control
Enqueue,GetNamedResource,CmpString(if in ROM),GetResInfo,
Drvrinstall(if not installed),LoadResource,CompactMem
Enqueue,GetNamedResource,CmpString(if in ROM),GetResInfo,
Drvrlnstall(if not installed),L.oadResource,CompactMem
Enqueue,Write,Read,SysError if error
Enqueue,CmpString,Write,Read

Enqueue,CmpString, Write,Read

Enqueue

Enqueue,CmpString, Write,Read

Enqueue,CmpString,Write,Read

Falls through Read

Enqueue,CmpString, Write,Read

Enqueue,CmpString

LoadResource if driver was purged, SysError if error

Enqueue,falls through FlushVol
Enqueue,Write,BlockMove,SysError if error
none

none

none

none

StdComment

none

CopyBits

none

none

GetResource
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PrClose
PrCloseDoc
PrClosePage
PrCtiCall
PrDigMain
PiDrvrClose
PrDrviDCE
PrDrvrOpen
PrDrvrVers
PrError
PrHack
PrintDefault
PrJobDialog
Pr]oblnit
PrJobMerge
PiNoPurge
PrOpen
PrOpenDoc
PrOpenPage
PrPicFile
PrPurge
PrSetError
PrStlDialog
PrStilnit
PrValidate
Pt2Rect
PtInRect
PtInRgn
PtrAndHand
PuToHand
PuToXHand
PuZone
PtToAngle
PurgeMem
PutScrap
RamSDClose
RamSDOpen
Random
RDrvrlnstall
ReadDateTime
ReadParam
RealFont
ReallocHandle
RecoverHandle
RectInRgn
RectRgn
ReleaseResource
Rename
ResError
ResetAlrtStage
ResrvMem
Restart
RestoreAS
RmveReference
RmveResource
RsrcZonelnit

Trap List

ABAC
A8AD
ABES8
A9EF
AOE3
ASE2
A048
A8C3
A04D
ASFE

AB61
AO4F
A039

A902
A027
A028
A8E9
A8DF
A9A3

A040

ASAE
ASAD
A996

RM

P

L

MO D B M e R M

L ]

b

e

GetResource,OpenResFile(to get refnum),CloseResFile
GetResource

GetResource

Control

GetResource

Close

Status

Open

PiDrviDCE

none

GetResource

GetResource

GetResource

GetResource

GetResource

GetResource
PrDrvrOpen,GetResource,OpenResFile
GetResource

GetResource

GetResource

GetResource

none

GetResource

GetResource

GetResource

none

none

none
GetHandleSize,SetHandleSize,BlockMove
NewHandle,BlockMove
SetHandleSize,NewHandle,BlockMove,NewHandle
none

FixRatio,FixMul, AngleFromSlope

none

PwrAndHand, Write
BlockMove,DisposeHandle,Close
GetResource,locks handle,BlockMove,Open
none

none

none

none

GetResource

none

none

none

SetRectRgn

DisposeHandle

Rename

none

none

BlockMove if needed, none otherwise
none

none

BlockMove,SetHandleSize,SetEOF (repeated)
BlockMove,SetHandleSize,SetEOF (repeated)
CloseResFile
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RstFLock
SaveOld
ScalePt
ScreenRes
ScrollRect

Secs2Date
SectRect
SectRgn

SelectWindow
SellText

SendBehind
SerClrBrk
SerGetBrk
SerHShake
SerReset
SerSetBrk
SerSetBuf
SerStatus
SetApplBase
SetApplLimit
SetClip
SetClikLoop
SetCRefCon
SetCTitle
SetCtlAction
SetCtiMax

SetCtiMin
SetCtlValue

SetCursor
SetDAFont
SetDateTime
SetDItem
SetEmptyRgn
SetEventMask
SetFInfo
SetFLock
SetFontLock
SetFType
SetGrowZone
SetHandleSize
Setltem
SetltemlIcon
SetltemMark
SetltemStyle
SetlText

SetMenuBar
SetMenuFlash
SetOrigin

Trap List

A90E
ABF8

ABEF

A9C6
ABAA
ABEA

A91F
A97E

A921

ABS7
A02D
A879

A95B
A9SF
A96B
A965

A964
A963
A851

AO3A
A98E
A8DD

AS03

A04B
A024
A%947
A940
A944
A942
A98F

A93C
A%4A
AB78

WM
QD

QD

oS
QD

QD

»

PP P4 D D4 RO XM

Mo o K

RstFilLock

NewRgn(2),CopyRgn(2)

none

none

If pnloc<0 or updatergn is empty then SetEmptyRgn, else NewRgn,
RectRgn,SectRgn,CopyRgn,OfsetRgn,DiffRgn,ShieldCursor,ShowCursor,
DisposeRgn,SetEmptyRgn

none

none
EqualRgn,CopyRgn,SetEmptyRgn,RectRgn,NewHandle,SetHandleSize,
DisposeHandle

FrontWindow,SetPort,HiliteWindow
GetPort,SetPort,LLoadResource, TECal Text(if text),LoadResource,
TEDeactivate, TECalText, TEActivate,SetPort
FrontWindow,SelectWindow,CalcVBehind,PaintBehind,SetPort
Control

Status

Control

Control

Control

Control

Status

InitApplZone,SysError if failed

none

CopyRgn

none

none

HideControl,SetHandleSize,BlockMove,ShowControl(if visible)
none

GetPort,SetPort,LoadResource if control def proc needs loading,
calls def proc for each control,SetPort
GetPort,SetPort,LoadResource if control def proc needs loading,
calls def proc for each control,SetPort
GetPort,SetPort,LoadResource if control def proc needs loading,
calls def proc for each control,SetPort

HideCursor & ShowCursor if changed, none otherwise

none

none

GetPort,SetPort,LoadResource, TECal Text(if text),SetPort
SetRectRgn

none

GetFileIlnfo,BlockMove,SetFileInfo

SetFilLock

LoadResource if locking,ReleaseResource if not

SetFilType

none

SysError if failed, BlockMove if needed, none otherwise
Munger,CalcMenuSize

CalcMenuSize

CalcMenuSize

CalcMenuSize
PuToHand,GetPort,SetPort,LoadResource, TECalText(if text),SetPort,
TECalText,EraseRect, ValidRect,SetPort

BlockMove

none

OffsetRgn
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SetPenState
SetPort
SetPortBits
SetPt
SetPtrSize
SetRect
SetRectRgn
SetResAttrs
SetResFileAttrs
SetResInfo
SetResLoad
SetResPurge
SetSoundVol
SetStdProcs
SetString
SetTagBuffer
SetTime
SetTrapAddress
SetupAS
SetVol
SetWindowPic
SetWordBreak
SetWRefCon
SetWTitle

SetZone
SFGetFile
SFPGetFile
SFPPutFile
SFPutFile
ShieldCursor
ShowControl
ShowCursor
ShowHide

ShowPen
ShowWindow
SizeControl
SizeResource
SizeWindow
SlopeFromAngle
SoundDone
SpaceExtra
StartSound
Status
StdArc
StdBits
StdComment
StdGetPic
StdLine
StdOval
StdPoly
StdPutPic
StdRect
StdRgn
StdRRect

Trap List

AB99
AB73
A875
AB80
A020
A8A7
A8DE
ASA7
AS9F7
A9A9
A99B
A993

ABEA
A907

A047

A92E

A918
A91A

AO1B

ABS5
A957
A853
A908

A897
A915
A95C
AQAS
A91D
ABBC

AS8SE

A8BD
ASEB
AS8F1

ABEE
AB90

A8B6
ABCS
A8FO0

ABAQ
A8D1
A8AF

Lo I

Mo e R e

Mo o4 M M

none

none

none

none

SysError if failed, BlockMove if needed, none otherwise
none

SetHandleSize

none

none
GetHandleSize,SetHandleSize,GetEOF,SetEOF,BlockMove
none

none

none

none

PtrToXHand

Control
Date2Secs,SetDateTime
none

none

SetVol

none

none

none

HandToHand,SetString,Stringwidth, window def proc (2), UnionRgn,

DiffRgn,PaintBehind,CalcVBehind,DisposeRgn, SetPort
none

Pack 3

Pack 3

Pack 3

Pack 3

HideCursor if cursor intersects shield rect, none otherwise
GetPort,SetPort,LoadResource,SetPort

none

SaveOld, if making visible it calls the window def proc, DrawNew,

SetPort

none

SelectWindow,ShowHide
HideControl,ShowControl

GetHandleSize,Read
SaveOld,SetClip,ClipAbove,DrawNew,SetPort
none

none

none
NewHandle,GetHandleSize,SetHandleSize,BlockMove, Write
Status,BlockMove

If recording a picture or region it does StdPutPic
If recording a picture or region it does StdPutPic
StdPutPic,HLock,StdPutPic,HUnlock

none

If recording a picture, region, or polygon it does StdPutPic
If recording a picture or region it does StdPutPic
If recording a picture or region it does StdPutPic
SetHandleSize

If recording a picture or region it does StdPutPic
If recording a picture or region it does StdPutPic
If recording a picture or region it does StdPutPic
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StdText
StdTxMeas
StiliDown
StopAlert

StopSound
StringToNum
StringWidth
StuffHex
SubPt

SysBeep
SysError

SystemClick

SystemEdit
SystemEvent
SystemMenu
SystemTask
SystemZone
TEActivate

TECalText

TEClick
TECopy
TECut

TEDeactivate

TEDelete

TEDispose
TEFromScrap
TEGetScrapLen
TEGetText
TEIdle

TElInit
TElInsert

TEKey

Trap List

A882
ABED
A973
A986

AB8BC
AB66
ABTF
A9C8
ASC9

A9B3

A9B2
A9BS
A9B4
A9D8

A9DO

ASD4

A9DS

A9D6

A9D9

A9D7

A9CB
A9DA
A9CC
A9DE

A9DC

QD
QD

DL

SD
PK
QD
QD
QD
Os
Oos

DS

H HEREEY

H HHd H H &H H # H

H

L I ]

L]

If recording a picture or region it does StdPutPic
FMSwapFont,FixRatio,FixMul

Button,EventAvail
GetResource,FlushEvents,NewDialog,GetPort,SetPort,Getlcon,
PlotIcon,GetDItem,PenSize,InsetRect,FrameRoundRect, InsetRect,
ModalDialog,SetPort,DisposeDialog

KilllO,DisposeHandle

Pack 7

TextWidth

none

none

FlashMenuBar,Delay,FlashMenuBar

InitGraf, InitPort,EraseRect,FrameRect,PenSize,MoveTo,LineTo,
LineTo,PenNormal,DrawText,Plotlcon

LoadResource(wind defproc),GetPort,if no windows in list
SetPort,SetClip,ClipAbove,otherwise LoadResource and lock,

if in drag DragWindow,,if goaway then TrackGoAway,CloseDeskAcc(if
actually closing), else it calls FrontWindow,SelectWindow(if not
in front),send the event, then call Control
GetPort,SetPort,Control,SetPort

GetPort,SetPort

sends message to driver and calls Control
GetPort,FrontWindow,SetPort

none
GetPort,SetPort,NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize, TextWidth,SetClip,DisposeRgn,SetPort
GetPort,SetPort,NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize, TextWidth,GetHandleSize,SetHandleSize,HLock,
GetHandleSize,SetClip,DisposeRgn,SetPort
GetPort,SetPort,NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize,...,TickCount,
GetPort,SetPort NewR gn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize, PrToXHand,SetClip,DisposeRgn,SetPort
GetPort,SetPort, NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize, TECopy,TEDelete,SetClip,DisposeRgn,SetPort
GetPort,SetPort NewRgn,GetClip,ClipRect,SectRgn, HLock,
GetHandleSize, TextWidth,InvertRect, TextWidth,SetClip,
DisposeRgn,SetPort
GetPort,SetPort, NewR gn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize, HUnlock,Munger, TextWidth,GetHandleSize,
EraseRect, TextWidth,DrawText, TextWidth,InvertRect,
SetClip,DisposeRgn,SetPort

DisposeHandle

GetScrap

none
GetPort,SetPort,NewRgn,GetClip,ClipRect,SectRgn, HL ock,
GetHandleSize,SetClip,DisposeRgn,SetPort
GetPort,SetPort,NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize, TickCount, TextWidth,InvertRect,SetClip,
DisposeRgn,SetPort

NewHandle

GetPort,SetPort, NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize,InsetRect, TextWidth,EraseRect,DrawText,PinRect,
GetPort,SetPort, NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize,ObscureCursor, TextWidth, HUnlock Munger,HLock,
GetHandleSize EraseRect, TextWidth,EraseRect, DrawText, TextWidth,
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TENew
TEPaste

TEScrapHandle
TEScroll

TESetJust

TESetScrapLen
TESetSelect

TESetText

TEToScrap
TestControl

TEUpdate
TextBox

TextFace
TextFont
TextMode
TextSize
TextWidth
TickCount
TopMem
TrackControl
TrackGoAway
UnionRect
UnionRgn

UniquelD
UnloadScrap
UnloadSeg
UnmountVol
UnpackBits
UpdateResFile
UprString
UseResFile
ValidRect
ValidRgn
ViInstall
VRemove
WaitMouseUp
WriteParam
WriteResource
XOrRgn

ZeroScrap

Trap List

A9D2
A9DB

ASDD

A9DF

A9D1

A9CF

A966
A9D3

A9CE

ABS88
AB87
A889
ABBA
AB86
A975

A968
AS1E
ABAB
ABES

ASC1
A9FA
A9F1

ABDO
A999
AB54
A998
A92A
A929
A033
A034
A977
A038
A9BO
ABE7

A9FC

M

H

H HH H

InverRect,SetClip,DisposeRgn,SetPort
NewHandle(2),GetFontInfo

GetPort,SetPort NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize, TextWidth,Hunlock,Munger,HLock, TextWidth,
GetHandleSize,EraseRect,DrawText, TextWidth,InvertRect,
SetClip,DisposeRgn,SetPort

none

GetPort,SetPort,NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize,OffsetRect,NewRgn,ScrollRect,SetClip, TextWidth,
EraseRect,DrawText,DisposeRgn,SetClip,DisposeRgn,SetPort
GetPort,SetPort, NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize,SetClip,DisposeRgn,SetPort

none

GetPort,SetPort, NewRgn,GetClip,EraseRect,SectRgn,HLock,
GetHandleSize,EraseRect,DrawText,PtInRect
GetPort,SetPort,NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize, Pt ToXHand, TECalText,SetClip,DisposeRgn,SetPort
HLock,PutScrap,HUnlock

GetPort,SetPort,LoadResource,SetPort
GetPort,SetPort,NewRgn,GetClip,ClipRect,SectRgn,HLock,
GetHandleSize, TextWidth,InvertRect,SetClip,DisposeRgn,SetPort
EraseRect, TENew, TEDispose,then TESetText,TEUpdate if there is
something in it

none

none

none

none

StdTxMeas

none, Control if journaling

none
GetPort,SetPort, HiliteControl, GetMouse, WaitMouseUp, SetPort
SetClip,ClipAbove,LoadResource,GetMouse, WaitMouse,SetPort
none
EqualRgn,CopyRgn,SetEmptyRgn,RectRgn,NewHandle,SetHandleSize,
DisposeHandle

Random

Open,Create,Write,DisposeHandle

GetResource

UnMountVol

none

SetEOF, Write,BlockMove, Write,BlockMove,SetEOF

none

none

NewRgn,RectRgn,DisposeRgn
OffsetRgn,UnionRgn,DiffRgn,OffsetRgn

Enqueue

Dequeue

StillDown,GetNextEvent

none

GetHandleSize,Write, BlockMove, Write,BlockMove
EqualRgn,CopyRgn,SetEmptyRgn,RectRgn,NewHandle,SetHandleSize,
DisposeHandle

SetEOF,SetHandleSize NewHandle
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The following is a complete list of the traps called by DrawPicture.

DrawPicture:

Verbs:

Nouns:

ResetClipRgn

ForeColor
BackColor
BkPat
TxFont
TxFace
TxMode
TxSize
SpaceExtra
PnSize
TxRatio
Version
PnMode
PnPat
FillPat
OvalSize

Resetting Origin
Rectangles
Round Rect
Oval

Arc

Polygon

Region

PicComment

Bit Operation

Text
Line

NewRgn (2 for clip rgns); StdGetPic (to get the type of item in the picture - noun
or verb); Depending on the type returned it does the following:

StdGetPic,NewHandle,HLock,StdGetPic,HUnlock,CopyRgn,
MapRgn,SectRgn,DisposeHandle
StdGetPic

StdGetPic

StdGetPic

StdGetPic

StdGetPic

StdGetPic

StdGetPic

StdGetPic

StdGetPic,ScalePt
StdGetPic(2),ScalePt

StdGetPic

StdGetPic

StdGetPic

StdGetPic

StdGetPic,ScalePt

StdGetPic,NewRgn,CopyRgn,MapRgn,SectRgn,
DisposeHandle

StdGetPic,MapRect,StdRect

StdGetPic,MapRect,StdRRect

StdGetPic,MapRect,StdOval
StdGetPic,MapRect,StdGetPic,StdArc
StdGetPic,NewHandle, HLock,StdGetPic,HUnlock,MapPoly,
StdPoly,DisposeHandle
StdGetPic,NewHandle,HLock,StdGetPic,HUnlock,MapRgn,
StdRgn,DisposeHandle
StdGetPic,NewHandle,HLock,StdGetPic,HUnlock,
StdComment

StdGetPic,MapRect,StdGetPic, if there's a mask then
StdGetPic, NewHandle, HLock,StdGetPic, if packed then
UnpackBits, then StdBits,HUnlock,DisposeHandle

StdGetPic (if not starting at current pnloc),MapPt,StdGetPic
(to get endpt),MapPt,StdLine

After drawing each item in the picture it does 2 DisposeRgn's to get rid of the cliprgns

Trap List
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Apmio
Usass®
Group™

P.O. Box 520
Bethpage, NY 11714

MAUG iz a trademark of the Hicronetworked Computer Uszsers, Inc.

Welcome To MAUG ¢

In conjunction with Apple Computer, MAUG"" (which is the Micronetworked Apple Users
Group) is helping to provide developers with updates to Macintosh development software. These
updates will be delivered electronically through telecommunications.

To Start

If you are a developer you will want to avail yourself of a modem (to hook your Macintosh to the
telephone line) and a terminal program (the program FreeTerm and its documentation is included
with this Supplement). You will also want a Compuserve Information Services (CIS) account
number and password. This last is packaged free with most major brands of modems, including
Apple's, or is available in an inexpensive package called a "Compuserve Starter Kit" from any
computer store. Apple Certified Developers who did not receive a Compuserve subscription with
their modems can obtain a free Compuserve User ID and password by writing to MAUG"™ at the
address above.

Both starter kits and packaged accounts will have a list of phone numbers that may be called to
connect with the CIS network. Find the phone nunber which is nearest to your location. In most
cases this will be just a local phone call.

Connect your modem to your Macintosh as the modem's instructions detail. Be certain that you use
a modem cable and not an Imagewriter cable. This is the most common error when setting up a new
Macintosh-and-modem system. Read over the FreeTerm documentation which explains how to use
this simple but powerful terminal program and how to dial the number via your modem.

Welcome to MAUG™ Page 1



Entering Compuserve

Once you have dialed the number and connected to the network you will want to sign in or "log
on". The documentation which contained the phone number will detail exactly which log-on
procedure to use with the number you are calling. But all procedures will end with asking for the
two most important pieces of information -- your User ID and your password.

Your User ID is your account number (often in the form 70000,000) and that should be entered
when the remote Compuserve computer issues its "User ID:" prompt. Following that the remote
computer will output its "Password:" prompt. Keep in mind that entering your User ID is similar to
printing your name on a check, but giving the password is like signing the check. Never give
anyone your password!

The Road To MAUG™

Once you have logged onto Compuserve you will want to make your way to MAUG " and to the
Macintosh Developers' Forum.

From the main menu take the "Personal Computing Services" choice and then follow the "groups"
choice to MAUG" . Or, you can enter the direct command GO PCS-7 (or GO MACDEV) at any
of Compuserve's exclamation point (!) prompts. This will take you to the Macintosh Developers'
Forum. MAUG " would also like to invite to visit the Macintosh Users' Forum on PCS-51 and
the Apple II and III Users' Forum on PCS-14.

Using The Forum

A Forum is a complicated but easily-learned area to use, and the sysops (system operators) are
always standing by to help out and explain. There are also numerous online help facilities as well as
help available by voice-phone, regular mail and electronic mail. Here's how to quickly "come up to
speed.”

Read over the Membership Information bulletin by choosing "bulletins" from the Forum's main
menu. The Membership Information bulletin will detail how to obtain and read the help files which
pertain to reading and leaving messages, to uploading (transmitting) files and programs and, of
course, to downloading (receiving) files and programs.

If you need additional help just leave a message addressed to "Sysop." Either Dennis Brothers (the

head sysop of the Developers' Forum) or one of the other sysop staff will answer your message.
Or, feel free to address a message to "All" and many other developer-members will help out.
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The Easyplex™ electronic mail system may also be used if you wish to leave a message privately.
Address such correspondence to MAUG" s Chief Sysop Neil Shapiro at 76703,401.

MAUG " also may be reached via the U.S. Mail at the above address. And, you can call the
MAUG™ Help Line (voice) at (516)/735-6960 any time from 7pm to 10pm Eastern time.

Since 1978 MAUG " has been introducing Apple users to telecommunications. We are very much
looking forward to helping Apple keep you, the Macintosh Development Team, informed and as
up-to-date as possible. See you on the Forum!

Neil Shapiro
MAUG ™ Chief Sysop
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FreeTerm

What FreeTerm Does

FreeTerm is a simple 24 line by 80 character TTY (dumb) terminal emulator. It supports sending
and receiving ASCII files, copy and paste, and all ASCII characters from the keyboard.

FreeTerm can also send and receive files using the Xmodem error- correcting protocol (sometimes
known as the Christensen or Modem?7 protocol) which is compatible with most telecommuncations
systems. In addition, Free Term allows you to send and receive Macintosh applications and
documents using the MacBinary format.

FreeTerm will work with all types of modems that support asynchronous communications at 300,
1200, or 2400 baud. If you have a null modem cable, it may also be used to communicate between
two computers.

FreeTerm 1.6

FreeTerm version 1.6 is included in the Tools folder of the 5/85 MacStuff 1 disk. It works
correctly on a 128K or 512K Macintosh but does not always work on a Macintosh XL running the
final release of MacWorksXL included in the May Supplement (it does work with the 12/84
pre-release of MacWorks). A later version of FreeTerm which works correctly on all versions of
MacWorks will be available via MAUG on Compuserve (described in separarate document).

Starting FreeTerm

The FreeTerm application on the desktop shows an icon with a phone handset sending and

receiving data. This application may be opened throught the Finder's File menu or it may be
double-clicked.

Using FreeTerm

When you first open an unused copy of FreeTerm it will display a dialog asking which port your
modem is connected to; you may choose the modem port (port A) or the printer port (port B). If
FreeTerm can identify that a port is in use (e.g. AppleTalk is connected) the name of that port will
be dimmed and may not be selected (if both port names are dimmed the only option will be Exit
Program). After completing the initial dialog FreeTerm will open the selected port for
communication; because FreeTerm can not always tell if a port is in use, the user must be careful
not to select a port that is being used by another device (e.g. a hard disk).

After selecting a port, the user may choose Make Default, No Default, or Exit Program. Make
Default will effect future invocations of FreeTerm, causing the initial dialog to be skipped and the
selected port to be opened automatically. Both Make Default and No Default will cause the
terminal window to be displayed. Exit Program exits FreeTerm without opening any port.

While the FreeTerm terminal window is active, any key typed will be sent to the modem. If you
open or select a desk accessory window, typing on the keyboard will not affect the terminal.
However, any text received by from the modem port will be displayed in the window until it is
closed.

The FreeTerm window may be resized by selecting the size box in the window. The window
cannot be sized smaller than 4 lines by 15 characters, or larger than 24 by 80. The terminal always
remembers the last 24 lines by 80 characters. You may also double-click the title bar to return the
window to it's full 24 by 80 size.
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ASCI Characters

FreeTerm allows you to transmit all 128 ASCII characters from the Macintosh keyboard. Typing

the 8 (command) key plus an alpha key (A-Z) sends a control character to the host. The following
keys send special characters to the host:

Key Character ASCII CODE

Enter Hardware Break None

82 Null 0

(BAto Z) Other Control Characters 1-26

8 [ Escape 27

% Escape 27

8\ FS 28

%80 FS 28

8 ] GS 29

%89 GS 29

%86 RS 30

8 - US 31

(Space to ~) Normal Characters 32-126

3 Backspace Delete 127
Apple Menu

About Free Term — Selecting "About FreeTerm" opens a window to display version information,
the copyright notice, and other information regarding FreeTerm. To continue, click inside the
window.

Desk Accessories — All desk accessories are available to you while you are using FreeTerm. Until
it is closed, a desk accessory will remain on the desktop - even if it is hidden behind the terminal
window. You can close each desk accessory individually by using it's close box, or if it is a menu
desk accessory, selecting Quit from the desk accessory's menu.

File Menu

ASCTI Capture — The terminal session or a portion of it may be recorded to a MacWrite text-only
file. When you select ASCII Capture you will be asked for a file to download the terminal session
to. The default name for the session is "Log File". ASCII Capture can be stopped by selecting
Stop Capture on the FreeTerm menu.

ASCII Send — Asks for a text-only file to be sent to the host. The upload supports x-on/x-off
protocol. Sending may be aborted by selecting Stop Sending option from the FreeTerm menu or
hitting any key on the keyboard.

Xmodem Receive — Selecting this option will start the Xmodem receive file process. You will be
asked for a file name to download to. The default name is "Rcv File".

Once the Xmodem protocol starts, FreeTerm will display a dialogue showing the current volume
and file name being transferred, the number of blocks received (1 block = 128 bytes), and the error
status.
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If the file you are downloading is a MacBinary file, FreeTerm will ignore the file name you
selected. Instead, it will download to the name found in the first block of MacBinary file.

While FreeTerm is receiving a file, you will not be able to use a desk accessory until the file
transfer is finished, or until you have cancelled the transfer.

You may stop the Xmodem Receive process at any time by typing any key.

Xmodem Send — Selecting this option will start the Xmodem send file process. You will be asked
to select a file to upload. If the file is an Macintosh application or document, FreeTerm will upload
the document as a MacBinary file.

However, if the file you are uploading is a text-only file, FreeTerm will give you the option of
sending the document as a Text File. If you choose to send it as Text, FreeTerm will convert the
file into a standard ASCII file readable by most computer systems.

While FreeTerm is sending a file, you will not be able to use any other application or desk
accessory until the file transfer is finished, or until you have cancelled the transfer.

You may stop the send file process at any time by typing any key.

Settings — This menu option allows you to set the configuration of FreeTerm for the system that
you are connecting to. You may set the speed, data size, parity, duplex, and the port for the
terminal. In addition, you may select LF after CR ,Vax Mode, and the default configuration.

» Speed can be set for 300, 1200, and 2400 baud (bits per second).

» The number of data bits (word size) can be 8 (for most BBSs) or 7 (for most
mainframes).

* Parity can be none (for most BBSs), even, or odd (there is no support for mark
and space parity).

« The duplex mode can be set to be full (for most systems) or half.

* You may choose to attach your modem to your Modem or Printer port. If
FreeTerm can identify that a port is in use (e.g. AppleTalk is connected) the name
of that port will be dimmed and may not be selected; because FreeTerm can not
always tell if a port is in use, the user must be careful not to select a port that is
being used by another device (e.g. a hard disk).

« "Prompt for port at startup” will effect future invocations of FreeTerm.
Choosing it and subsequently pressing Make Default will cause the initial port
selection dialog to be displayed at startup (like the first time FreeTerm was
opened); otherwise the initial dialog will be skipped and the selected port will be
opened automatically.

« "LF after CR" is for use with systems that do not send, or do not reliably send, a
line feed after a carriage return (symptom: all text is received on a single line).

« "Vax Mode" makes the backspace key send the ASCII delete character, and 88
backspace sends a normal backspace. In addition, if FreeTerm receives a delete
character from the host, it will treat it as an backspace.

» Make Default will make your current configuration the default for the next time
you run FreeTerm. Then it will return to the FreeTerm terminal window.

» OK will return to the FreeTerm terminal window without changing the default
configuration for the next time you run FreeTerm.
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Clear Screen — The Clear Screen menu option will erase the contents of the terminal window, but
will not send any characters to the modem.

Ouit — The Quit menu option exits to the Macintosh Finder. If you are capturing your session,
FreeTerm will automatically save your file before returning to the Finder.

In addition, FreeTerm stores your current settings. Provided you do not reboot your Macintosh,

when you re-open FreeTerm, you will be set up using the same configuration that you last used.
After you reboot it will return to the settings last saved using Make Default.

Edit Menu
Undo - This menu option is for use only by desk accessories.
Cut - This menu option is for use only by desk accessories.

Copy - FreeTerm allows you to copy any portion of the terminal window to the clipboard
(replacing anything that is there) without removing it from window.

Paste - The Paste command is equivalent to uploading the Clipboard using the ASCII Send menu
option. The contents of the Clipboard (whatever was last cut or copied) will be uploaded.

Xmodem Error Messages

FreeTerm is able to recover from a considerable number of modem transmission errors when
uploading or downloading files using the the Xmodem protocol. However, under some conditions
it will not be able to recover and will abort.

If an error occurs during the file transfer, FreeTerm will display the error it encountered in the
status dialogue. If more than 10 errors occur in a row, FreeTerm will abort the file transfer, and
display the last type of error.

Some common Xmodem error messages:

Timeout Error — If FreeTerm does not receive acknowledging blocks or characters from the host
within 60 seconds, you will have a timeout error.

Checksum Error — FreeTerm received a block with bad characters in it.

Duplicate Block — FreeTerm received two blocks with the same block number.
Synchronization Error — FreeTerm received a valid block number that it did not expect.
Block Number Error — FreeTerm received a bad block number.

Block Not Acknowledged — FreeTerm sent a block that was not received properly.

EOF Not Acknowleged — FreeTerm sent an end-of-file block that was not received properly.
User Abort — You typed a key to abort the file transfer.

File Corrupted - The wrong number of blocks was received in a MacBinary transfer.
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Using FreeTerm With Other Communication Software

FreeTerm will transfer text files with any other terminal program that supports ASCII or Xmodem
protocols. Macintosh files can be transfered with any other program that uses the MacBinary
format. In addition, FreeTerm may be used in conjunction with desk accessories that use the the
Phoenix Block (such as tl.e Q&D Dialer and Kermit Protocol desk accessories).

MacBinary Format

The MacBinary format is based on the data transfer format implemented in Apple's MacTerminal
program, by Mike Boich and Martin Haeberli. Documentation of the format and its initial proposal
as a standard was done by Dennis Brothers. An informal working group, consisting of Macintosh
terminal program developers and others with interests or expertise in the field of computer
communications, was formed during April, 1985 to discuss and refine this proposal. The group
met in the MAUG™ Special Interest Group on the CompuServe Information Service. The present
form of the MacBinary format standard represents a consensus of this group as a whole, but may
not reflect the opinion of a given individual member of the group.

Participants in the group included:

Christopher Allen Ed Edell
William Bond Duane Harris
Steve Brecher Yves Lempereur
Dennis Brothers Neil Shapiro
Ward Christensen Dan Smith

Dan Cochran Bill Steinberg
Mike Cohen Scott Watson
Bill Cook

The most current version of the MacBinary format proposal is available in the MAUG™
Telecommunications database, under the name MACBIN.STD.

Please address comments or questions on the MacBinary format to:
Dennis F. Brothers
197 O1d Connecticut Path
Wayland, MA 01778
CompuServe:  70065,172
Delphi: DBROTHERS
MCI Mail: DBROTHERS

MAUG™

MAUG™, the Micronetworked Apple User's Group, is an on-line group of over

20,000 owners and users of Apple computers. Membership is free, and

participation is through telecommunication on the Compuserve Information Services Network.
MAUG™ makes available the latest in public-domain Apple software, hints, techniques, help, and
camaraderie. In addition, MAUG™ is a prime source of information and updates from Apple for
Macintosh software developers.

For information on joining MAUG™, write or call:
P.O. Box 520
Bethpage, NY 11714
516-735-6960 (voice, 6pm to 10pm Eastern)
(MAUG is a trademark of Micronetworked Computer Users Inc.)
- Neil Shapiro, MAUG™ Chief Sysop
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Credits

FreeTerm was written by William Bond, author of many programs for Dreams of the Phoenix, Inc.
This documentation was written by Christopher Allen, President of Dreams of the Phoenix, Inc.

Copies of FreeTerm may be freely distributed (but not sold) as long as the credit notice from the
"About Free Term..." menu remains intact.

For more information concerning submitting freelance programs to DOTP, or the Phoenix Block,
send a self-addressed, stamped envelope to Dreams of the Phoenix, Inc., P.O. Box 10273,
Jacksonville, Florida 32247, or call (904) 396-6952.

FreeTerm is functionally equivalent to desk accessories from Quick & Dirty Utilities Volume One
published by Dreams of the Phoenix, Inc. DOTP also sells Mouse Exchange BBS and Mouse
Exchange Terminal — both support the MacBinary format.
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ResEdit:
A Macintosh Resource Editor

About ResEdit

ResEdit is a graphically based tool for use by developers in creating the various resources
needed to produce a Macintosh application. It allows you to create, edit, copy, and paste
resources, and includes individual resource editors for specific types of resources.

ResEdit may be used to change existing resource files; for example, you can translate the
message in an alert box into another language without recompiling the program. Or it can
be used to do a quick prototype of user interfaces and to try out many different formats and
presentations of resources to find the one that's best suited for a given application.

ResEdit is still in development. When completed, it will allow you to create and edit all
resource types except CODE, and to copy and paste all resource types (including CODE).
It will also include the option of producing an output file from which the Resource
Compiler RMaker can create a resource file.

A key feature of ResEdit is its extensibility. You can create new editors to manipulate new
resource types and then add them to ResEdit. The simplest type of editor, a template
editor, can even be created with ResEdit itself.

Working with Files in ResEdit

To begin using ResEdit, select its icon and choose Open from the File menu, or double-
click the icon. ResEdit displays a window for each disk volume currently mounted. Each
window shows a complete list of files on that volume.

To examine the resources for a given file, select it from the list by clicking its name or by
typing the first character of the name (in which case it will be scrolled into view if it's not
visible). Then open the file by choosing Open from the File menu. You can also double-
click the file name to open the file.

If you choose Close or click the close box for a disk window, the volume will be
unmounted. If it's a 3 1/2-inch disk, the disk will be ejected. ResEdit will recognize a new
disk when it's inserted and also handles more than one drive. Be careful not to click the
close box for a disk window that represents a hard disk, since it will unmount the hard
disk.

The New command lets you create a new file.
Note: You can edit any file shown in the window, including the System file
and ResEdit itself. However, it's dangerous to edit a file that's currently

running. Edit a copy of the file instead (for example, the System file on a
non-boot volume). Note that you cannot use ResEdit to copy or delete files.
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Working within a File

Opening a file creates a window displaying a list of all the resource types in that file. When
a file window is the active window, a new resource may be created, existing resources may
be copied or deleted, and resources may be pasted in from other files. The File menu
commands have the following effects:

» New creates a new resource in the open file.

* Open opens a window displaying all resources of the resource type selected;
select the resource type by clicking it or by typing its first character. You can also
double-click the resource type to open. The resources are displayed by a
"resource selector’”. There's a general resource selector that displays the
resources by type, name, and ID number, and for some resource types there's a
special resource selector for that type (for example, the ICON resource selector
displays the icons graphically). If you hold down the Option key while opening,
the resource window will open with the general resource selector; do this if, for
example, you want to see icons listed by type, name, and ID.

* Close closes the file window and asks if you want to save the changes you
made. Never reboot before closing! Rebooting before closing all file
windows can leave the resource files in an inconsistent state if you have made any
changes.

*» Revert changes the resource file back to the state it was in when it was last saved
to disk.

* Quit returns to the Finder.

When a file window is the active window, the Edit menu commands have the following
effects:

» Cut removes all resources of the resource types selected, placing them in the
ResEdit scrap.

« Copy copies all resources of the resource types selected into the ResEdit scrap.

* Paste copies the resources from the ResEdit scrap into the file window's
resource type list.

 Clear removes all resources of the resource type selected, without placing them
in the ResEdit scrap.

The Duplicate command is currently dimmed; in the final release of ResEdit, this

command will create duplicates of all resources of the resource types selected, and assign a
unique resource ID number to each new resource.

Working within a Resource Type

Opening a resource type creates a window with a list of all the specific resources of that
type in the file. This list can take many forms, depending on the underlying resource
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selector that's invoked. If the Option key is held down during the open, the general
resource selector is invoked.

When a resource type window is the active window, the File menu commands have the
following effects:

* New creates a new resource and opens its editor. A selection window is
presented to allow you to select the resource type to create.

» Open opens the appropriate editor for the resource you selected.
* Close closes the resource type window.

» Revert changes the entire file back to what it was before opening the resource
type window.

¢ Quit returns to the Finder.
The Edit menu commands have the following effects:
» Undo may or may not be selectable, depending on the specific editor in use.
+ Cut removes the resources that are selected, placing them in the ResEdit scrap.
 Copy copies all the resources that are selected into the ResEdit scrap.

+ Paste copies the resources from ResEdit scrap into the resource type window's
resource list.

* Clear removes the resources that are selected, without placing them in the
ResEdit scrap.

 Duplicate creates a duplicate of the resources that are selected and assigns a
unique resource ID number to each new resource.

Editing Individual Resources

To open an editor for a particular resource, either double-click the resource or select it and
choose Open from the File menu. All the editors use File and Edit menus similar to those
described above, but operating on individual resources or individual elements of a
resource. If you hold down the Option key when opening a resource, the general Data
editor is invoked. The Data editor allows you to edit the resource as hexadecimal data. If
both the Shift and Option keys are held down during opening, ResEdit shows you a list of
editors available for the resource. Some editors, such as the DITL editor, allow you to
open additional editors for the elements within the resource.

One or more auxiliary menus may appear, depending on the type of resource being edited.

The menus for some of the editors are discussed below. The use of the remaining editors
should be apparent from their presentation when running.
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Note: ResEdit will not edit resources larger than 16K bytes in length;
however, resources larger than this may be moved by using the Cut, Copy,
Paste, and Clear commands as described above.

Editing CURS Resources

For CURS resources the editor displays three images of the cursor. All three images may
be manipulated with the mouse.

The left image shows how the cursor will appear. The middle image is the mask for the
cursor, which affects how the cursor appears on various backgrounds. The right image
shows a gray picture of the cursor with a single point in black. This point is the hot spot
for the cursor.

The Cursor menu contains the following commands:

» Try Cursor allows you to try out the cursor by having it become the cursor in
use.

* Restore Arrow makes the cursor the standard arrow cursor.

» Data->Mask copies the cursor data to the mask image.

Editing DITL Resources

For DITL resources, the editor displays an image of the item list as your program would
display it in a dialog or alert box. When an item is selected, a size box appears in the
bottom right corner of its enclosing rectangle, allowing you to change the size of the
rectangle. The item may be moved by dragging it with the mouse. When you open an item
from the File menu or by double-clicking, the editor associated with the item is invoked; for
an ICON item, for example, the icon editor is invoked. If you hold down the Shift and
Option keys while opening, the DITM editor is invoked instead; this is a special-purpose
editor for editing items in an item list. If you hold down just the Option key while opening,
the general Data editor is invoked.

The DITL menu contains the following commands:

« Bring to Front allows you to change the order of items in the item list. Bring
to Front causes the selected item to become the last (highest numbered) item in the
list. The actual number of the item is shown by the DITM editor.

+ Send to Back is similar to Bring to Front, except that it makes the selected item
the first item in the list—that is, item #1.

+ Grid aligns the item on an invisible 8 pixel by 8 pixel grid. If you change the
item location while Grid is on, the location will be adjusted such that the top left
corner lies on the nearest grid point above and to the left of that comer. If you
change the size, it will be made a multiple of 8 pixels in both dimensions.
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* Use RSRC rect restores the enclosing rectangle to the rectangle size stored in
the underlying resource. Note that this works on ICON, PICT, and CNTL items
only; the other items have no underlying resources.

* Resize window adjusts the window size so that all items in the item list are
visible in the window.

Editing Font Resources

For FONT resources, the editor window is divided into three panes: the text pane, the
character selection pane, and the character editing pane.

The text pane appears in the upper right of the window. It displays sample text in the font
being edited. The text may be edited using normal Macintosh editing techniques (in case
you want a sample of other characters in the font).

The character selection pane appears below the text pane. You can select a character you
want to edit by clicking on it in the row of three characters shown. The character you select
is boxed in the center of the row with its ASCII value shown below it. If the character you
want is not displayed, click on the right character in the row to move upward through the
ASCII range, or click on the left character to move downward.

You can also select a character for editing by typing it. When the insertion point is not in
the text pane, any character you type (using the Shift and Option keys if necessary) is
selected.

The character editing pane on the left side of the window contains an enlargement of the
selected character. The enlargement is similar to FatBits in MacPaint, and is edited by
clicking bits on and off. The black triangles at the bottom of the character editing pane set
the left and right bounds—that is, the character width—of the character in the font.

Any changes you make in the character editing pane are reflected in the text pane and the
character selection pane. Remember that you cannot save the changes until you quit.

The Height menu contains the following commands:
» More Ascent adds one bit to the length of the font ascent each time it's chosen.

» More Descent adds one bit to the length of the font descent each time it's
chosen.

* Less Ascent subtracts one bit from the length of the font ascent each time it's
chosen.

* Less Descent subtracts one bit from the length of the font descent each time it's
chosen.

You can also change the name of a font. The name of the font is stored as the name of the
resource of that font family with size 0. This resource does not show up in the normal
display of all fonts in a file (in the FONT window). To get it to be displayed, hold down
the Option key when you open FONT from the file window. This will bring up the generic
list of fonts. Select the font with the name you wish to change and choose Get Info.
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Changing the name for this one resource will change the name for all the fonts in this
family.

Editing ICN# Resources

For ICN# resources, the editor displays two panes in the window. The lower pane shows,
from left to right, what the icon will look like unselected and selected on a white
background, and unselected and selected on a gray background. The upper pane is used to
edit the icon. It contains an enlargement of the icon on the left and an enlargement of the
icon's mask on the right.

The Icn# menu contains the following command:
 Data->Mask copies the icon image to the mask editing area.

To install a new icon for your application when you already have an old one in the Finder's
desktop: Open the file called DeskTop. Open type BNDL and find the bundle that is your
application's. (This is the one that has your owner name in it.) Look through the bundle
and mark down the type and resource ID of all resources bundled together by the bundle
(i.e., the ICN#'s and FREF's). Go back to the DeskTop window and remove these
resources along with your BNDL and signature resource (the resource with type name =
your creator type). Now close the DeskTop window, save changes, and quit ResEdit.
Your new icon will be installed.

Extensibility

Since it can't anticipate the format of all the different types of resources that application
developers will use, ResEdit has been designed so it can be taught to recognize and parse
new resource types. There are two ways that ResEdit can be extended to know about new
types. One way involves programming and the other does not.

You can extend ResEdit by programming your own special-purpose resource selector
and/or editor. The selector is the code that displays all the resources of one type in the
resource type window. The editor is the code that displays and allows you to edit a
particular resource. These pieces of code are separate from the main code of ResEdit.
Information on writing custom selectors and editors will be provided in the future.

Another way to extend ResEdit is by creating a template for your resource type. The
generic way of editing a resource is to fill in the fields of a dialog box. This is the way you
currently edit MENUs, DLOGs, DITLs, STR#s, STR s, INTLs, FREFs, BNDLSs, etc.
using ResEdit. The layout of these dialog boxes is determined from a template in ResEdit's
resource file. You can find these templates by opening the ResEdit file and then opening
the type window for TMPLs. The template specifies the format of the resource and also
specifies what labels should be put beside the editText items in the dialog box that's used
for editing the resource. For example, if you open the template for WIND resources (this
is the TMPL with name "WIND"), you see that they consist of the following, in the order
listed:

* 4 words (a RECT) specifying the boundary of the window
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» a word that is the procID for the window (DWRD tells ResEdit to display the
word in decimal as opposed to hex)

+ a Boolean inidicating whether or not the window is visible (BOOL is 2 bytes in
the resource but is displayed as a radio button in the dialog window used for
editing)

+ another Boolean indicating whether or not the window has a close box

* along that is the refCon for the window (DLNG indicates that it should be
displayed in the editor as a decimal number)

* a Pascal string; the title of the window (PSTR)
You can look through the other templates and compare them with the structure of those
resources to get a feeling for how you might define your own resource template. The
template mechanism is flexible enough to describe a repeating sequence of items within a
resource as in STR#'s, DITLs, and MENUs. You can also have repeating sequences
within repeating sequences as in BNDLs. The different ways of terminating a repeating
sequence, and the codes to put in the template to distinguish them, are as follows:

* LSTZ-LSTE - terminated by a O byte (as in MENUs)

* ZCNT/LSTC-LSTE - terminated by a zero-based count that starts the sequence
(as in DITLs)

» OCNT/LSTC-LSTE - terminated by a one-based count that starts the sequence (as
in STR#s)

» LSTB-LSTE - ends at the end of the resource (no example exists in the given
templates)

The types you have to choose from for your editable data fields are:
* DBYT, DWRD, DLNG - decimal byte, word, long
* HBYT, HWRD, HLNG - hex byte, word, long
* HEXD - hex dump of remaining bytes in resource
» PSTR - a Pascal string (length byte followed by the characters)
* LSTR - long string (Iength long followed by the characters)
* ESTR, OSTR - Pascal string padded to even or odd length (needed for DITLs)
» CSTR - a C string
* BOOL - Boolean
* BBIT - binary bit
*« TNAM - type name (like OSType and ResType, i.e., 4 characters)
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» CHAR - a single character

ResEdit will do the appropriate type checking for you when you put the editing dialog
window away.

To create your own template:

1. Open the ResEdit file window.

2. Open the TMPL type window.

3. Choose New from the File menu.

4. Select the ***** ]ist separator.

5. Choose New from the File menu. You may now begin entering the label,type
pairs that define the template. Before closing the template editing window,
choose Get Info from the File menu and set the name of the template to the name
of your resource type.

6. Close the ResEdit file window and save changes.

The next time you try to edit or create a resource of this new type, you should get the dialog
box in the format you have specified.
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AppleTalk Information

Included in this Software Supplement is the latest release of the AppleTalk drivers and utilities.
These files are all the software you need to begin developing Macintosh programs which use
AppleTalk. However, Apple is planning to make available a newer version of the
AppleTalk drivers (as included in the AppleTalk Install utility) that fix certain known

bugs. Make sure you have are using the new drivers in any product that you ship. This updated
Install utility will be available through MAUG™ (on Compuserve) and will be sent to developers
who have ordered Inside AppleTalk or have licensed the AppleTalk drivers.

The AppleTalk Install utility lets you install the AppleTalk drivers in the System file of any
diskette. The current version is experimental software; make a backup copy of the System before
running Install on it. There is a known bug in that it does not work properly with systems
connected to hard disks; copy your hard disk System file to a diskette, disconnect the hard disk,
run Install from diskette, then copy the updatedSystem file back (note that if you have a hard disk
startup diskette, you may have to install the drivers there, too). Install requires a Macintosh with at
least 512K of RAM.

Peek is a utility to allow you to examine and record traffic over the network. It works only on
128K and 512K Macintoshes. Poke is a tool which lets you edit and send arbitrary packets on the
network. It works on all Macintoshes. Poke Packets is a file of sample packets. Documentation
for Peek and Poke is included in this package.

Last February, we included a draft copy of the AppleTalk Manager Programmer's Guide in the
Software Supplement (this guide is also included in the promotional ('phone book™) edition of
Inside Macintosh, and in the current version of Inside AppleTalk). It contains information on
calling the drivers from Pascal and assembly language. Some of the example code fragments
included in that manual contain errors; updated fragments are provided on the Examples 2 disk.

Routines are included on the Workshop Supplement 1 disk to make it easier to use AppleTalk from
Lisa Pascal; these routines are slightly different than the old Pascal interfaces in that they exist
within resources in the system file. A document is included which explains the changes to this
version of the interfaces.

If you're developing in assembly language or using a high-level language, you can write programs
which use AppleTalk by calling the AppleTalk drivers from assembly language. Lisa Workshop
users will find all the necessary equates and constants in TLAsm/ATalkEqu.Text on the Workshop
Supplement 2 disk. Macintosh 68000 Development System users will find the equates and
constants defined in the file ATalkEqu.Txt on the MacStuff 4 disk.

If you're currently developing AppleTalk-based software, we'd like you to take a moment to
answer and return the enclosed questionnaire. It will help us to create better tools and examples for
your development of AppleTalk software.

If you're serious about developing for AppleTalk you might want to order Inside AppleTalk. This
binder discusses the lowest-level details of AppleTalk, and is vital if you will be implementing the
AppleTalk protocols on standalone hardware (i.e., a file server, etc.). An update to this book is in
the works; you will receive it automatically if you order (or already have ordered) the existing
version. Inside AppleTalk can be obtained by sending $75 (California residents, please add sales
tax) to

Apple Computer Mailing Facility

467 Saratoga Avenue, Suite 621

San Jose, CA 95129

Note that you must license the AppleTalk drivers from Apple (in addition to the basic System

Folder) before shipping them as part of a product. AppleTalk Licenses are available for $50 a year.
Contact Apple's Software Licensing Department at (408) 973-4667 for more information.
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AppleTalk Pascal Interface, Version 3.2
Implementation Notes

ABPasIntf Version 3.2 consists of a set of files that allow Macintosh applications to access the
AppleTalk drivers (MPP and .ATP) from Pascal. Currently only the Lisa Workshop fully
supports ABPasIntf. For more information on these routines, please consult the Pascal section in
the AppleTalk Manager chapter of Inside AppleTalk. IMPORTANT: These files have undergone
extensive changes from previous versions. If you currently have earlier versions of ABPasIntf
(e.g. Versions 1.0, 1.1, 3.0 or 3.1), they should replaced by these newer interface files.

To use ABPasIntf in an application you may use the following files: obj/ABPasIntf.obj,
intrfc/ ABPasIntf.text, and obj/ABPasCalls.obj, all on the 5/85 Worshop Supplement 1 disk, and
ATalk/ABPackage.obj and ATalk/ABPackageR.text on the 5/85 Worshop Supplement 2 disk (or

alternately the resource file ATalk/ABPackage in the Resource Files folder of the 5/85 MacStuff 4
disk). These files are described below:

obj/ABPasIntf.obj : This file contains the compiled Pascal Unit that the application USES.
intrfc/ABPasIntf.text: The human-readable interface corresponding to obj/ABPasIntf.obj.

obj/ABPasCalls.obj: This is the Pascal "glue" that makes calls to the main part of the
ABPasIntf code. It is very small (around 270 bytes) and should be linked in with your
application's code during the Link stage of your build.

ABPackage: This file holds the actual code that implements the ABPasIntf routines. You
will use one of two files depending on how you build your application:
ATalk/ABPackage.obj (a standard Workshop object file) or ABPackage (a standard
Macintosh resource file of Type atpl; ID = 0).

To use ABPasIntf, follow these instructions:

1) Add to your application's source file the following statement under the USES section along with
any other compiled Units (e.g. Quickdraw, Toollntf, etc):

USES
{$U obj/ABPasIntf } ABPasIntf;

2) Link the file obj/ABPasCalls.obj with your application.
3) Install the ABPackage routines. There are two ways of doing this:

a) In your application's resource definition file (in the Workshop), add the following (this
text can be found in the resource definition file ATalk/ABPackageR.text):

TYPE atpl = DRVR
ATalk/ABPackage!,0 (16)

This will insert the resource atpl directly into your applications resource fork. This method is
recommended since you will not have to worry about having the resource file on your
Macintosh disk if you copy it.

b) Use a resource moving utility on the Macintosh (e.g. ResEdit) to copy the resource (Type
atpl; ID=0) from the file ABPackage into your application or the System file of the disk the
application is on. If you put the resource in the System file note that you must copy it
whenever you transfer your application onto another disk.

Note that case is significant in resource type names; the type "atpl" must be in lowercase letters.
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AppleTalk Developer's Questionnaire

If you're currently using AppleTalk, please take a moment to fill out and return this questionnaire.
It will help us to better support you. Feel free to use additional sheets if necessary!

1. Are you currently developing an AppleTalk product? Or are you currently experimenting with
AppleTalk, with the future possibility of developing a product which uses it?

2. What level of the AppleTalk protocols are you using? Are you implementing special protocols
yourself?

3. Do you currently use the Pascal Interfaces? Have you created interfaces of your own? What
new features would you like to see in the higher-level interfaces to AppleTalk?

4. At what level of the Macintosh System does your software fit (i.e., is it an application, a desk

accessory, or a driver)?

Company Name:

Your Name:
Address:

Zip:

City: State:
Phone: ( )

Return to:
Macintosh Developer Support: AppleTalk

Apple Computer, Inc.
20525 Mariani Avenue, MS 4-T
Cupertino, CA 95014

Thank you!
Macintosh Developer Support Group
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AppleTalk Peek

Version 2.0

Richard F. Andrews and Gursharan S. Sidhu
Network Systems Development
© 1984, 1985 - Apple Computer Inc.

The AppleTalk Peek program is a network tool used to monitor packet traffic on a single
AppleTalk network. Peek runs on a 128K or 512K Macintosh (with AppleTalk connected via the
Printer port), and can record all packets seen on the bus. In addition, it can detect certain errors,
measure packet arrival times, and display packet data in hexadecimal and ASCII format.

Peck has enough queue space to hold a large number of packets. This queue is used in a circular

fashion, so that Peek can continue to monitor packets even after the queue has been filled. Older
packets are discarded to make room for newer ones.

The Window

When Peek is started, the program's window is drawn. It contains the control buttons, menus,
and information display areas described below.

:

START
STOP

Peek is always in one of two states: recording or displaying packets. When the program is first

started, it is in the record state. The START and STOP buttons are used to initiate and terminate
a recording session. during which Peek listens on the bus and records traffic.

When the START button is pressed, packet recording is enabled. The button becomes gray to
indicate that Peek is recording (see Figure 1). Peek's internal buffers are cleared, and packets

from a previous session are lost. The STOP button halts recording and causes packets to be
displayed, if any were recorded during the session (see Figure 2).

Pkts in Q
[_0_

When the STOP button is pressed, the Pkts in Q box shows the number of packets in
Peek's queue. This box is not dynamically updated during a recording session, since queue

wraparound makes this determination difficult. The word "Sampling" appears here while
recording, as an indication that Peek is monitoring the bus.

The size of the queue is determined by the amount of free memory, so that Peek running on a

512K Macintosh will be able to record more packets than a 128K Macintosh. Part of the queue
memory is devoted to "bookkeeping" information.
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The total number of packets seen by Peck since the start of the recording session appears in this
box. This count is updated dynamically, and hence provides a rudimentary visual indication of
bus traffic. Since Peek's queue can wrap around and "forget" old packets, this count may be
greater than the number of packets stored in the queue at that time.

During a particularly long recording session, this count may itself wrap around (when it reaches
32,767) and become invalid.

CRC errors: 0
Overruns: 0]
Time Outs: 0

This box displays the tally of errors during a recording session. Peek can detect three types of
EITorsS:

CRC errors are noted when the 16-bit Frame Check Sequence (FCS) at the end of the ALAP
frame does not match the calculated FCS. This indicates a possible error in transmission (due to
noise on the bus, collisions, etc.).

Overrun errors occur when the receiver reads bytes too slowly from the Macintosh's Serial
Communications Controller (SCC), and this chip's three-byte FIFO buffer overflows. Note that
if the node running Peek detects an overrun error, it does not necessarily mean that this will be
the case for other nodes. This error is sometimes detected as a

by-product of collisions on the bus.

Timeout errors are flagged when a byte is expected on the bus (the end of the packet has not
been seen, yet a byte does not appear on the bus within about 400 microseconds of the previous
byte). Every byte received thus far will be stored and displayed as "the packet", even though the
true packet end was not detected. This usually indicates a problem in the packet sender's
hardware, but it may also be a by-product of collisions on the bus.

The error fields are updated "on the fly" as packets are recorded, and are a measure of the total
number of errors seen by Peek. Therefore, in a long recording session, it is possible, due to
queue wraparound, for a packet to be received in error and not appear in the packet display,
although the error is noted in the box.

Go-Away box

When you wish to terminate the Peek program, click in the small box in the uppcr left-hand
corner of the window.

Display box
This box is used to view packets which were saved during the recording session. Each packet is
preceded by a banner line (see Figure 2) in boldface which includes, from left to right:

« a set of square brackets which may contain blanks or one of the following characters: B
if the packet was a broadcast, C, O, or T if a CRC, overrun, or timeout error,
respectively, was detected for that packet;

« the source S and destination D node IDs of the packet, in decimal format;
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« the packet's arrival time T in milliseconds (measured relative to the first packet stored in
the queue);

« the time since the previous packet's arrival (delta time or AT);

» the packet's sequence number in parentheses (in the order in which they were received,
starting with zero for the oldest packet in the queue);

« the calculated length L of the packet (number of bytes in decimal, not including the
FCS).

Following this banner line are two displays of the packet's contents, in hexadecimal on the left
and the corresponding ASCII (if printable) on the

right. A period is substituted for any unprintable character. Note that the FCS is not shown.

On the right side of the display box is a scroll bar which is enabled whenever there is more to be
displayed than will fit in the box. The user can scroll through the display of packets by using the
scroll bar's up and down arrows, or by dragging the thumb. Clicking in the gray area above or
below the thumb shifts the display backwards or forwards one complete packet at a time. This is
useful for scrolling past large packets.

Menus

[IEH Control_Edit _search

fAibout the Peek Program...

Scrapbook
Alarm Clock
Note Pad
Calculator
Key Caps
Control Panel
Puzzle

The Apple menu, as usual, is used to invoke a variety of desk accessories. Choosing About

the Peek Program will cause Peek to display some descriptive information, including the
version number and the size of the queue in bytes.

| &« Edit Search

Short Format

Receive LAP Control Pkts
Write Packets to File

Print Packets on ImagellUriter

The second menu is the Control menu, as seen above. When Short Format is selected, a
check mark appears next to the menu item and packets are displayed in a more compact form.
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Only the banner line and the first line (up to the first 16 bytes) of each packet will be shown. The
display can be scrolled as before. Choosing the menu item again will change the display back to
long format. This item is inactivated during a recording session.

When Receive LAP Control Pkts is selected, all LAP control packets seen on the bus will

be recorded. These are defined as any packets whose LAP type field is $80 through $FF hex
(most significant bit set). Such packets will be recorded only when this option is selected. If
their reception is enabled in the middle of a recording session, any LAP control packets already
seen on the bus will not have been saved. Changing this option while viewing the display of a
previous session will have no effect on the display, but will affect the next recording session.

Selecting Write Packets to File will cause Peek to save away a copy of the display into a
file on disk. If there are disks in the internal and external drives, Peek will attempt to write to
whichever one has more free space. The name of the file will be "Peek Buffer 0", unless a file
by that name already exists; in which case Peek will try "Peek Buffer 1" through "Peek Buffer
9". If those ten files already exist, Peek will give up and display an error message.

If there is not enough room on the disk to save all the packets, Peek will write as many as will fit,
and notify the user that a "Write Error: -34" occurred. This means that the disk is full; you may
wish to put an empty disk in the drive and try again. The file containing saved packets will be of
type "TEXT" and creator "EDIT".

As an alternative, you may choose Print Packets on imagewriter. Connect an
Imagewriter to the modem port (not the printer port) before selecting this item, and Peek will
print the entire display on the printer. (This could be a time-consuming process if there are many

packets to print). Note that the Short Format option (described below) has no effect on
packets written to a file or to the printer - long format is always used.

| & Control Search
Cut 8H
Copy &C
Paste U

The Edit menu is used only in conjunction with the Find Pattern feature, described below.
It allows you to use the standard text edit commands to create a string for which to search.
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| & Control Edit

Find Pattern &F
Find Same %S

Find Overrun
Find CRC Error
Find Timeout

Search is Not Case Sensitive

The Search menu is used to look for a particular hexadecimal or ASCII string within the
recorded packets. Selecting Find Pattern (or the equivalent command key-F combination)
will cause the Find window to appear, as in Figure 3. Select Heradecimal or Ascii, and

type in the string for which to search. The standard text editing features available in the Edit
menu may be used. Hex strings must be a sequence of bytes, each specified as a dollar sign ($)
followed by a two-digit hex number. In either format, a wild-card may be specified by the

command key-equals sign combination. This will appear in the Find window as "Q", and will
match one or more characters of any value.

When the string has been entered, hit Return or the Find Next button. Peek will begin
searching from the first packet appearing in the display box. The display will be scrolled down
to the packet containing the string, if found, and the string will be highlighted. Otherwise, Peek

will inform you that the string was not found. Selecting Find Same (or the equivalent

command key-$ combination) will cause Peek to look for the next occurrence of the same string,
starting from the current packet.

Find Overrun, Find CRC Error, and Find Timeout work in a similar fashion.

Selecting one causes Peek to search, starting from the first packet in the display box, for a packet
exhibiting the particular error. If found, the display is scrolled to bring that packet to the top of
the box (unless it is too close to the last packet to scroll up to the top). Since the error counts are

cumulative from the time the START button was pressed, packets with errors may not always
appear in the queue (if they were discarded to make room for newer packets).

The search can be made case-sensitive or not case-sensitive by selecting the item Search is
Not Case Sensitive. The menu item will display the current state of this option.
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Notes

Pt

. The newer versions of Macsbug (1/1/85 or later, with symbols) tend to slow Peek enough
that it will frequently overrun. Use older debuggers on your Peek disk or none at all.

N

. A node running Peek is in listen-only mode on an AppleTalk network. Such a node does not
participate in the ALAP protocol and does not even consume a node ID. In fact, it is
"invisible" to other nodes.

w

. Peek does not use any of the standard AppleTalk drivers (e.g. the Macintosh Protocol
Package), but assumes direct control of the Macintosh's AppleTalk port. However, the port
is reset when Peek terminates, so it is possible to then run other AppleTalk software without
powering down the Macintosh and powering it up again. (Note that this is not true for
versions of Peek older than V2.0).

4. Peek will not run on a Macintosh XL under MacWorks.

9.}

. If a packet that is longer than 4095 bytes is received by Peek, its subsequent behavior
becomes unpredictable. If Peek terminates abnormally during a recording session, there is a
strong probability that a node on the network has sent a packet of illegal size (e.g. a node is
stuck in its transmit loop).

Acknowledgements

This program borrows ideas from a former Lisa WorkShop application developed by Jim
Nichols and Steve Butterfield; in particular, the circular use of a buffer. AppleTalk Peek is a
completely new program designed to exploit the Macintosh user interface. Thanks to Mark
Neubieser and Paul Williams for implementing new features.
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& Control Edit Search
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Figure /. Peek Window (Recording State)
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[ & Control Edit Search

|STHHT| Pkts in Q4 ~Pkts Rcvd4 |CRC errors: 3
[ﬁj [ 2526 ] |- 2597 ] Overruns: 3
20 61 FF 73 64 66 6A 39 38 20 61 39 64 20 20 61 a.sdfj98 a9d a ég
73 70 99 3D 61 30 66 2D 3D 3B 6C 61 73 64 20 61 sp.=a0f-=;lasd a |
73 27 14 66 3B 6F 61 64 70 72 30 33 33 6C 34 2C s'.f;oadpr03314,
20 20 27 61 73 66 70 OF 6F 61 5B 20 6F 61 30 64 'asfp.oal oa0d
20 73 s
[B1S 10 D: 255 T: 25885 AT: 32 <1550> L: 3
FF OA 84
[B1S 10 D: 255 T: 25885 AT: D C1551> L: 130
FF OA 01 00 7F 00 00 03 3B 6C 64 73 66 6E 65 6B  ........ ; ldsfnek
7R 78 63 69 6A 20 61 06 73 64 6A 66 20 69 64 6B zxcij a.sdjf idk
20 61 64 6B 6A 66 11 6E 20 61 6B 6A 6B 6E 6D 69 adkj f.n akjknmi
39 38 38 39 34 35 1B 35 6A 20 61 65 39 75 76 20 988945.5j aeSuv
20 61 FF 73 64 66 6A 39 38 20 61 39 64 20 20 61 a.sdfj98 a9d a
73 70 99 3D 61 30 66 2D 3D 3B 6C 61 73 64 20 61 sp.=a0f-=;lasd @ |
73 27 14 66 3B 6F 61 64 70 72 30 33 33 6C 34 2C s'.f;oadpr03314, [+
20 20 27 61 73 66 70 OF 6F 61 5B 20 6F 61 30 64 'asfp.oal oa0d |{¥]

Figure 2. Peek Window (Display State)
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& Control Edit Search
Target? [$0B$00$1280D
T [ Find Next l ®) Hexadecimal QO Ascii
sp.=a0f-=; lasd a
73 27 14 66 3B 6F 61 64 70 72 30 33 33 6C 34 2C s'.f;oadpr03314,
20 20 27 61 73 66 70 OF 6F 61 5B 20 6F 61 30 64 'asfp.oal oaOd
20 73 s
S: 10 D: 255 T: 25885 AT: 32 C1550> L: 3
FF OA 84
S: 10 D: 255 T: 25885 AT: O C1551) L: 130
FF OA 01 00 7F 00 00 03 3B 6C 64 73 66 6E 65 6B ........ ; Idsfnek
7R 78 63 69 6A 20 61 06 73 64 6A 66 20 69 64 6B zxcij a.sdjf idk
20 61 64 6B 6A 66 11 6E 20 61 6B 6A 6B 6E 6D 69 adkjf.n akjknmi
39 38 38 39 34 35 1B 35 6A 20 61 65 39 75 76 20 988945.5j aeSuv
20 61 FF 73 64 66 6A 39 38 20 61 39 64 20 20 61 a.sdfj98 a9%d a
73 70 99 3D 61 30 66 2D 3D 3B 6C 61 73 64 20 61 sp.=a0f-=; lasd a
73 27 14 66 3B 6F 61 64 70 72 30 33 33 6C 34 2C s'.f;oadpr033!4,
20 20 27 61 73 66 70 OF 6F 61 5B 20 6F 61 30 64 'asfp.oal oald

Figure 3. Find Window
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AppleTalk Poke

Version 3.1

Gene Tyacke
Network Systems Development
© 1984,1985 - Apple Computer Inc.

AppleTalk Poke is a Macintosh application designed for use by AppleTalk developers. It
allows the user to edit/create packets and to send them out on AppleTalk. Developers are
expected to use Poke to test their protocol software/hardware implementations for AppleTalk
products. Poke uses the Macintosh Protocol Package (MPP) for AppleTalk access (details of
MPP are discussed elsewhere). This means that the system file of the boot disk must have
AppleTalk Installed (e.g. with the Install tool). This has been done to the disk Poke is on.

This document describes the features and use of Poke. It is not intended to instruct the user on
the capabilities, features, or specifications of MPP or of the various AppleTalk protocols, nor
does it discuss the normal use of the Macintosh's standard editing abilities. (For information on
AppleTalk protocols, see the corresponding specification/description document.)

Startup

After starting Poke, the MPP driver is loaded in (if it isn't currently in memory) and the main
window is brought up (figure 1). This window displays the Poke station's AppleTalk node ID
and packet information. At this stage, the packet information indicates that no packets have been
loaded into Poke (packet names are all set to empty). Next to each packet name, there is a pair of

buttons labeled EBIT and SEND. Initially, all SEND buttons are dimmed (inactive) because no
packets have been loaded. The main window includes an area for displaying any appropriate
error or status messages.

The program operates in two different states. When started up, it is in the send state with the

main window displayed. When any EBIT button is pressed, it goes into an edit state and the
packet editing window is displayed (figure 2). In this state, the selected packet can be edited.

Clicking the edit window's 0K button will return you back to the main window and the send
state.
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Menus and Commands:

Poke's menu bar contains four menus. These are:

| & File Edit Tools

Each menu and its associated commands is displayed and described below:

®
Menu:

P rile Edit Tools

All About Poke...
teuary 1%, 184%

Scrapbook
Alarm Clock
Note Pad
Calculator
Key Caps
Control Panel
Puzzle

The "Apple" menu allows you to run an available desk accessory or to examine Poke's version

information ("All About Poke..."). Selecting the "All About Poke..." command brings
up an information window. Clicking the mouse or pressing a key causes this window to
disappear and Poke returns to its original state.
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File
Menu:

& Edit Tools
Load
Save

Quit 360

The File menu allows the user to load from (or save to) a file of 10 prepared or canned packets.

The Load and Save operations follow the standard conventions for file loading and saving.
Note: Older versions of Poke utilize a different file format. You cannot load in packets created
by those versions.

Edit
Menu:

| & File Tools

Cut 31
Copy 8C
Paste D

The Edit menu is used only while editing a packet. Please note the keyboard's optional
command keys that can be used to invoke this menu's commands.

Tools
Menu:

| & File Edit

Clone Packet

Show Packet Length 3L
Helpful Hints ®H
Set Repeat Factor %S
Abort Send If Error Occurs

Calculate CheckSum
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"Clone Packet" can only be selected from the main window. When selected, a dialog box
appears which asks you for the name of the packet you wish to copy (the source). It also asks
for the name of the packet which it is to be copied to (the destination). The names are searched in
a top to bottom fashion starting at the top left corner of the main window (figure 1). The first
packet whose name matches the one you entered will be chosen. If both source and destination
names are found, then the source packet will be copied verbatim to the destination. Otherwise,
an error message is displayed.

The "Show Packet Length" command can only be used while editing a packet. It returns

the number of bytes in the packet's data field. This count does not include the packet's header,
so the actual packet size will

be larger. (See the AppleTalk protocol documentation for information on the size of the different
headers.) If an error is detected while computing the length, an alert box will be displayed
indicating the exact location of the error. Note: If you have entered more data into a packet than
is allowed by the corresponding protocol (LAP,DDP,ATP) then Poke will truncate the data (at
the end) to the maximum allowed value.

The "Helpful Hints" command allows you to obtain a quick summary of editing instructions.
Clicking the mouse or pressing any key will return you to the currently active Poke window.

Packets can be transmitted repeatedly at user specified intervals. The number of times a packet is
transmitted and the time interval between transmissions are set by the user by selecting the "Set
Repeat Factor"' command. This command will allow you to change transmission

information used by the SEND command (discussed later).

The delay time interval between transmissions is given in ticks (1 tick = 1/60 of a second). If
you enter a number of transmissions value equal to zero, then Poke will keep sending packets

out in a closed loop (i.e, indefinitely). When Poke is in such a loop, you can stop the SEND
operation by either clicking the mouse button or by pressing a key. If you wish to send packets
out at the fastest rate possible, enter a zero for the time interval. If this is done, packet statistics
will not be displayed in the messages box.

Note: The user specified time interval is achieved only approximately. Network loading and
ALAP overhead plus packet transmit time add to this interval.

The "Abort Send If Error Occurs” command is used in conjunction with the SEND
operation. If selected, a checkmark will appear on the left side of the command informing the

user that this feature is active. Now, if an error occurs while sending a packet, the SEND
operation will abort. To deactivate this feature, select the command again and the checkmark will
be removed. This command is especially useful when large numbers of packets are being sent
out.

The last command, "Calculate Checksum", may be used in the edit window to replace the
existing DDP checksum field with an updated checksum. This command is only valid with
packets utilizing the DDP long format (LAP Type field $2).

AppleTalk Poke Version 3.1 Page 4 February 15, 1985



Preparing a Packet

When you press the edit button for a particular packet in the main window, the edit window of
figure 2 will appear and you will be shown the information of that packet. This window is
divided into two main sections: the header and the data, with 18 editing fields. Only one editing
field is active at a time. This is indicated by highlighting that field's rectangular box. There are

several circular buttons, check boxes and command buttons (0K, CANCEL and CLERR) used
in preparing the packet. The standard Macintosh editing features apply to most of these controls.
Some, however, need further clarification. These are:

o Pressing the TAB key causes Poke to verify the information in the current field
before activating the next field. The same is true if you press the RETURN key
(except within the packet's data field). If an error is detected while verifying a
field, a beep will sound and Poke will return you back to the error's location.
(Possible errors are described at the end of this section.)

o Clicking the mouse on a different editing field will verify the information in the
currently active field. If there are no errors, Poke moves to the field clicked on.

o You may type data beyond that visible in the field. Leading blanks are
automatically removed in the packet header fields.

Entering the Packet's Name

The packet's name is used only to visually distinguish the various packets from others in the
main window. It may contain any sequence of printable characters, but it is suggested that you
limit the number of characters to 16.

Entering Information in the Header Fields

Information in the packet header fields can be entered in any one of three ways:

Decimal : Type in the digits (e.g. 128). This is the default entry type.

Hexadecimal : All hexadecimal (hex) numbers are preceeded by a dollar sign (e.g.,
$80 = 128).

Binary: Binary numbers are preceeded by a percent sign (e.g., %1111 = $0F
= 15).

Leading zeros are ignored. When a field has been verified, the number entered is automatically
converted to hex format.

Possible Error Conditions:

o Value in field is out of range. (see AppleTalk Protocol documents for the
permissible ranges of the various fields)

o Unknown character in field. Valid digits for decimal format are [0..9] (where
this represents a range from zero to nine); valid digits for hex format is [0..9,
a..f, A..F], and valid digits for binary numbers are [0,1].
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Entering Packet Data Information
The following format must be followed when entering information into the packet data:

Data bytes can be entered into the packet in two ways: by typing in the ASCII character
corresponding to the byte's value or by entering the byte's value in its hex form.

To enter the hex form, type a "$" followed by the two digit hex number (e.g. $84,$01). Note
that "$1" is invalid, you must enter "$01". Byte's whose value corresponds in the ASCII code to
a graphic character can be entered by just typing in that character. Example: to enter a byte with
the value "$62", type "b"; for "$42" type "B"; for "$31" type "1". Other examples can be found
in figures 2 and 3. Note: Since the dollar sign ($) is a special character, you can only enter it in
its hex form "$24".

Poke will detect errors from the end of the data back to its beginning.

Editing Buttons

Various buttons in the edit window control the information that constitutes the packet. Each set
of buttons is described below:

Packet Type: OQLAP QO DDP (o) ATP
The Packet Type buttons are used to choose the header type as described in the protocols
document. After clicking on a button, only the fields appropriate for that protocol type will be
shown. The default is ATP. Only one button may be selected at a time.

QOReq @ Rsp O Rel

These three buttons are only used for an ATP packet. They are used to format an ATP request,
response or release packet. The default is Req. As above, only one button may be chosen at a

time.
[JKo [JEOM []STS

Each of these check boxes represents the corresponding bit in the ATP control field. If checked,
the corresponding ATP control field bit will be set; otherwise the bit is cleared.

- Packet Data Display
QO Hex @ ASCII

The Packet Data Display buttons allow the user to select the type of display for the packet's data:
hex strings or mixed ASCII and hex. [Note: This operation may take up to 10 seconds for large
packets.] If an error occurs during the format conversion, an error message is displayed and the
conversion will abort. You may enter data in either format at any time. The above buttons are
used only when the display is updated or when you wish to convert data to the format
immediately.
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[ 0K | [CANCEL| [ CLEAR |

The 0K button should be pressed when you are through editing the packet. All fields are
verified for correctness and the packet length is displayed before returning to the main window.
You will also have the option, at this time, to calculate a checksum for the packet. If any errors
are detected, you will be returned to the edit window.

The CANCEL button terminates the editing session without saving any changes to the packet.
The packet is returned to the original form that it had prior to this editing attempt. Poke returns
you to the send window.

The CLERAR button clears gll editing fields and inserts the default information into them.
Sending Packets

To send packets, Poke must be in the send state (i.e., displaying the main window). Any one of

the ten packets may be sent by clicking on its active SEND button. The number of times the
packet will be sent and the delay between each of these transmissions is shown at the top right
corner of the main window in the short form:

Rpt Factor = nx : d ticks

where: n = number of transmissions
d = time interval between transmissions (in ticks)

If a SEND button is inactive, you must first edit the packet. The result of the SEND operation is
displayed in the message area at the bottom of the main window.

Possible Error Conditions:

o No error; packet was sent to destination node (or broadcast)
o -95; Packet was unable to be sent because either the destination node did not
respond or the line was sensed "in use" 32 times.

Startup Notes:

When Poke starts up, the MPP driver is opened and initialized. If the open call fails and you are
returned a -35 error, you will be forced to exit the program. Most likely the cause of this error
will be that the MPP driver is not installed in the System resource file. In addition, if the system
heap is fragmented such that the MPP driver cannot get enough memory to load, the same error
will be returned.

If the serial port configuration byte (SPConfig) is not set correctly, you will get a -98 error when
Poke starts. See the AppleTalk Manager manual for additional information on location and
contents of this byte.
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Caveats:

o Editing of the packet's data field will slow down appreciably as its size increases.
Whenever possible, display it under the ASCII mode to minimize the number of
screen characters.

While in the ASCII display, all characters in the printable ASCII range ($20-$7E)
and RETURN ($0D) will be displayed in their ASCII form, even if they were
entered as hex strings.

o The packet data field is limited to 55 lines. Even short packets (e.g., entering
more than 55 carriage returns in the packet's data field in ASCII mode) can go
out of the scrolling range.

o Numbers cannot be entered into the packet's data field in decimal or binary
format.

o In no case can the size of the packet be greater than 603 bytes, including ALAP
header.

o If an error occurs while verifying or converting the packet's data field, the
information at the error location may change, as Poke tries to back out of the
error gracefully.

o If you have chosen DDP or ATP packet types from the edit window, DDP long
format will always be displayed, even if the ALAP type of $01 (short format)
was entered.

o If you enter more than 600 bytes of packet data, the checksum calculation may not
work correctly until you have exited and reentered the editing window. (This
will truncate off all excess data from the end of the packet).

o
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&€ File Edit Tools

AppleTalk Poke 3.1
AppleTalk station ID = 98 Rpt Factor = 1x: 2 ticks
(SEND] | | | <empty> | | | l

| DDP long header | )| ] | <empty> | | l
| <empty> ()1 )| <empty I N

<empty> [ ] | ] | ] [ l

cempty> ()1 )| <empty (|

- Messages

Packet # 1 Pkt Length= 125 Error response = -95

Figure 1. Main Window
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& File Edit Tools

| Packet Name: |ATP DDP long Packet Type: OQLAP QO DDP (@ ATP
“ - Header Data
| (LAP
Dest Node Addr: {$45 | LAP Type: 1$2 |
DDP
Hop Count: [$0 I Dest Skt #: |§gﬂ Src Skt #: |§B
DDP Type: Dest Node Addr: [$FF | Src Node Addr: [$17
1‘ Checksum: !$1202 I Dest Net #: [$1 I Src Net #: |§2
| |ATP -
‘j ®Req ORsp QORel Trans ID: [§FFF__ | [XKIHO [JEOM []STS
” BitMap: |$0 { U1: [$1 Tu2: [$2 fus: [$3 |u4: [84 |
‘ — Packet Data
This is ASCII| data. I|f | wish t\‘.!'enter unprintabte characters, | enter —
characters |like: $00,$01.
‘ H
<
3 Packet Data Display —
{ OHer @ ASCII | oK | | CANCEL | | CLEAR |

Figure 2. Edit Window (ASCII Display)
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&€ File Edit Tools

Packet Name:

- Header Data

LAP

DDP long header

Packet Type: O LAP (@) DDP O ATP

DDP

Dest Node Addr: [§1

LAP Tupe: [$2

ATP

Hop Count [$0
DDP Type: [$5

Checksum: [$CBF2 |

Dest Skt #: isa |
Dest Node Addr: I|$FF |

Dest Net #: [$1 |

Src Skt ®: i$B |
Src Node Addr:
Src Net #: [$2

— Packet Data

$54$68$69$73$20$69$73$2084 1$53$43$49$49$20$64$6 187486 1$2E$20$20$49$66$20$49¢ él
20$77$69$73$68$20874$6F $20$65$6E$74$65$72$2087S$6ES70$72$69$6E$74$6 1$62$6C$6
5$20$63$68%$6 197286 1$63$74$65$72$73$2C$20$49$20$65$6E$74$65$72$20$63$68$6 1872
$61$63$74$65$72$73$20$6C$69$6B$65$3A$20$00$2CH0 1$2C$24$20$5B$64$6F $6CH6CE6 1$
72$20$73$69$67$6E$SDS2E

O

Packet Data
@®) HeH

Display
O ASCl!

| 0K

[mEELJ | CLEAR |
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MACINTALK 1.1

INTRODUCTION:

The Macintosh speech synthesizer (MACINTALK) is a software driver which runs under the
MACINTOSH operating system. Running in real time, MACINTALK converts an ASCII string
of phonetic codes to high quality synthetic speech utilizing a male, non-regional, standard
American dialect. The MACINTALK driver also provides for user control of the speaking rate
and pitch. Another program, READER, converts unrestricted English text into phonetic codes
directly usable as input to MACINTALK.

Also provided are an application, SpeechLab, for experimenting with the system, and
ExceptionEdit, an exceptions editor for creating custom rule sets for READER.

The MACINTALK driver consists of the following procedures and functions:

FUNCTION SpeechOn(ExceptionsFile: Str255; VAR theSpeech: SpeechHandle): SpeechErr;

SpeechOn initializes the Macintalk speech driver and takes the following actions depending on the
setting of "ExceptionsFile".

ExceptionsFile null ==> Bring in READER using only the default rules.
ExceptionsFile := 'noReader’ ==> Do not use READER package (phonetic input only).
ExceptionsFile := Filename' ==> Bring in READER with 'Filename' exceptions file.

SpeechOn allocates a handle to the required static buffers and sets default speaking rate, baseline
pitch, pitch mode, and speaker sex. This function should be called exactly once, before any other
speech routine. The default parameter values set by SpeechOn are:

Speaking Rate: 150 words/minute
Baseline Pitch: 110Hz

Pitch Mode: Natural

Speaker Sex: Male

SpeechOn returns a handle to the driver's internal parm block in the variable "theSpeech". This
parm block should not be modified by the user, but must be passed to each MacinTalk routine.

SpeechOn return code:

noErr - driver open was successful

memFullErr - the required buffers cannot be allocated

resFNotFound - the specified exceptions file can't be found

resNotFound - one of the required resources
DRVR, TALK, or RULZ can't be found
(these resources are found in the MacinTalk file, which
must be on the same disk as the application)

fullUnitT - the driver unit table is full
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PROCEDURE SpeechOff(theSpeech: SpeechHandle);

SpeechOff closes the speech driver and cleans up. The driver is removed from the unit table, any
still existing buffers are released, and all resource files are closed.

PROCEDURE SpeechRate(theSpeech: SpeechHandle; theRate: INTEGER);

SpeechRate sets the speaking rate, in words per minute. The rate is constrained to lie between 85
and 425 words per minute.

PROCEDURE SpeechPitch(theSpeech: SpeechHandle;
thePitch: INTEGER; theMode: FOMode);

SpeechPitch sets the MACINTALK'S baseline pitch in Hertz, and it's pitch mode (either Natural or
Robotic).

In the "Natural" mode, a sentence's pitch follows a complex, generally declining, contour of rises
and falls, approximating the natural intonations of human speech. In this mode, thePitch is the
frequency around which the sentence's pitch gestures are made. In the "Robotic" mode, the pitch
is held constant throughout the sentence, giving the speech a mechanical or robot-like quality and is
primarily for use in games where such perversions are commonplace.

If the specified mode is "NoChange", the mode will not be changed. This allows the user to
change the baseline pitch withou<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>